MedLook 4 for Medical Billing
MedLook 4.0 Made Easy

By Fagerman Technologies Staff, 2013.

Copyright © 2013, Fagerman Technologies, Inc.  All rights reserved.
Cheat Sheet

Tools Toolbar

Navigation Toolbar

Appointment Toolbars

Patient Toolbar

Be sure to subscribe for the weekly eTips at info@remsys.com.
Contents

Introduction ........................................................................................................................................ 9
How This Book Is Organized ........................................................................................................ 9
Section 1 – The Basics .................................................................................................................... 11
  Chapter 1 – Windows .................................................................................................................. 12
  Chapter 2 – MedLook ............................................................................................................... 17
  An Overview ............................................................................................................................. 17
  The Menu and Toolbars ............................................................................................................ 18
  The Menu ................................................................................................................................... 19
  The Tools Toolbar .................................................................................................................... 27
  The Navigator Toolbar ............................................................................................................. 28
  The Reports Toolbar ................................................................................................................ 28
Everything Below the Toolbars .................................................................................................... 29
  Button Bar .................................................................................................................................. 29
  Folder List .................................................................................................................................. 29
  Folder Title .................................................................................................................................. 30
  Look For (or Find…or maybe Search?) .................................................................................... 30
  Using The Grids .......................................................................................................................... 31
  Group By Box .............................................................................................................................. 32
  Status Bar ...................................................................................................................................... 33
How To Do The Simple Things ...................................................................................................... 33
Section 2 – Setting up the Essentials ........................................................................................... 34
  Chapter 3 – Doctors, Hospitals, and Referrals ......................................................................... 35
  Adding New Doctors ............................................................................................................... 35
  Adding Hospitals ..................................................................................................................... 36
  Adding Referrals ..................................................................................................................... 38
  Adding Procedure Codes ......................................................................................................... 39
  Adding Diagnosis Codes ........................................................................................................... 40
  Chapter 5 – Fee Schedules ...................................................................................................... 41
  Chapter 6 – POS, TOS, and Modifiers .................................................................................... 42
  Adding Place of Service ............................................................................................................. 42
  Adding Type of Service ............................................................................................................. 42
  Adding Modifiers ...................................................................................................................... 42
Chapter 7 – Insurance Carriers .................................................................................................. 43
  Demographics ............................................................................................................................ 43
  Carrier Mnemonic ..................................................................................................................... 44
  Claim Submission Mode .......................................................................................................... 44
  Insurance Type .......................................................................................................................... 44
  Facility Numbers ....................................................................................................................... 45
Section 3 - Patient Account ........................................................................................................... 49
  Chapter 8 – Using the Patient Toolbar .................................................................................... 49
  Chapter 9 – Adding and Editing Patients ............................................................................... 51
  Let’s Edit! .................................................................................................................................... 51
  An Example – Adding A Patient ............................................................................................... 56
Chapter 10 – Understanding the Summary .......................................................... 58
Chapter 11 – Entering Charges ............................................................................. 60
  Entering A Charge ............................................................................................. 62
  Editing A Charge .............................................................................................. 68
Chapter 12 – Making Payments .......................................................................... 69
Chapter 13 – Individual Billing ........................................................................... 74
  Patient Billing .................................................................................................... 74
  Insurance Billing ............................................................................................... 80
Chapter 14 – Notes ............................................................................................... 83
Chapter 15 – Transactions .................................................................................. 85
  The Transaction Display .................................................................................. 85
  Editing Transactions ........................................................................................ 87
  A Patient Transaction Report ........................................................................... 89
Section 4 – Batch Billing ..................................................................................... 90
Chapter 16 – Insurance Billing ........................................................................... 90
Chapter 17 – Patient Billing ............................................................................... 94
Section 5 – Reports ............................................................................................. 100
Chapter 18 – Office Analysis ............................................................................. 102
  Percent Each Doctor ....................................................................................... 102
  Billing Versus Payment .................................................................................. 103
  ICD9 – Diagnosis Report ............................................................................... 104
  CPT – Procedural Report ............................................................................... 105
  Referral Sources .............................................................................................. 106
  User Activity .................................................................................................... 107
  Patient Statistics .............................................................................................. 108
  Daily Ledger ..................................................................................................... 109
Chapter 19 – Insurance Analysis ....................................................................... 112
  Insurance Reimbursement .............................................................................. 112
  Patients With Insurance ................................................................................. 114
Chapter 20 – Patient Analysis ........................................................................... 115
  Patient Data Sheet ........................................................................................... 115
  Aging Balance .................................................................................................. 117
  Patients In Hospital ........................................................................................ 119
Chapter 21 – Custom Reports ........................................................................... 120
  Using The Custom Reports ............................................................................ 120
  Designing Custom Reports ............................................................................. 122
Section 6 – Labels ............................................................................................... 126
Chapter 22 – The Labels Folder ......................................................................... 126
  Common Features ............................................................................................ 126
  Custom Labels .................................................................................................. 127
  Patient Labels .................................................................................................. 129
  Birthday and Recall Labels ........................................................................... 130
  Insurance Carrier Labels ............................................................................... 131
  Referral Source Labels .................................................................................... 132
Section 7 – Filters ............................................................................................... 136
Chapter 23 – Using The Filters .......................................................................... 136
<table>
<thead>
<tr>
<th>Chapter 32 – The View Menu</th>
<th>191</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Type</td>
<td>192</td>
</tr>
<tr>
<td>Table View</td>
<td>192</td>
</tr>
<tr>
<td>Card View</td>
<td>193</td>
</tr>
<tr>
<td>View Formatting</td>
<td>194</td>
</tr>
<tr>
<td>Show Fields</td>
<td>194</td>
</tr>
<tr>
<td>Sort</td>
<td>195</td>
</tr>
<tr>
<td>Group By</td>
<td>196</td>
</tr>
<tr>
<td>Format View</td>
<td>198</td>
</tr>
<tr>
<td>View Summary</td>
<td>199</td>
</tr>
<tr>
<td>Defaults</td>
<td>200</td>
</tr>
<tr>
<td>View Navigation</td>
<td>200</td>
</tr>
<tr>
<td>Chapter 33 – Program Options</td>
<td>201</td>
</tr>
<tr>
<td>Preferred Locale</td>
<td>201</td>
</tr>
<tr>
<td>Misc. Options</td>
<td>201</td>
</tr>
<tr>
<td>Patient Account Defaults</td>
<td>203</td>
</tr>
<tr>
<td>Electronic Claims</td>
<td>206</td>
</tr>
<tr>
<td>Interest</td>
<td>206</td>
</tr>
<tr>
<td>HIPAA Compliance</td>
<td>206</td>
</tr>
<tr>
<td>Passwords</td>
<td>207</td>
</tr>
<tr>
<td>Chapter 34 – Billing Messages (by Age)</td>
<td>209</td>
</tr>
<tr>
<td>Chapter 35 – Data Maintenance and Activity Scheduling</td>
<td>212</td>
</tr>
<tr>
<td>Scheduled Backups</td>
<td>212</td>
</tr>
<tr>
<td>Scheduled Database Packs</td>
<td>215</td>
</tr>
<tr>
<td>Scheduling Other Tasks</td>
<td>215</td>
</tr>
<tr>
<td>Adjusting and Reviewing Scheduled Tasks</td>
<td>216</td>
</tr>
<tr>
<td>Enabling Your System Scheduler</td>
<td>216</td>
</tr>
<tr>
<td>Chapter 36 – Archiving, Recalling, and Un-deleting Patient Accounts</td>
<td>219</td>
</tr>
<tr>
<td>Chapter 37 – Importing Codes, Patients, and Insurance</td>
<td>225</td>
</tr>
<tr>
<td>Chapter 38 – Searching All Patients Notes</td>
<td>233</td>
</tr>
<tr>
<td>Chapter 39 – Adding External Programs</td>
<td>234</td>
</tr>
<tr>
<td>Chapter 40 – Utilities</td>
<td>236</td>
</tr>
<tr>
<td>Section 12 – What To Do When Something Goes Wrong</td>
<td>248</td>
</tr>
<tr>
<td>Chapter 41 – Using the Diagnostic Tools</td>
<td>249</td>
</tr>
<tr>
<td>Section 12 – Everything Else</td>
<td><strong>Error! Bookmark not defined.</strong></td>
</tr>
<tr>
<td>Chapter 42 – Where are We Headed?</td>
<td><strong>Error! Bookmark not defined.</strong></td>
</tr>
<tr>
<td>Appendix</td>
<td>260</td>
</tr>
<tr>
<td>Registration</td>
<td>260</td>
</tr>
<tr>
<td>Custom Dictionary</td>
<td>261</td>
</tr>
<tr>
<td>The MedLook System Menu</td>
<td>268</td>
</tr>
<tr>
<td>Keyboard Navigation</td>
<td>274</td>
</tr>
</tbody>
</table>
Introduction

This book has the sole purpose of providing you, the user, an up-to-date, printable, portable document that will help you better utilize and understand the tools within the MedLook product. Every effort has been made to make MedLook as easy to use and learn as possible; nevertheless the need remains for a printable manual as a handy reference. As you use MedLook and become more familiar with it the manual will take a back seat to your own intuition and experience.

MedLook is designed to organize and simplify the day-to-day activities of a medical office. It is very similar to Microsoft’s Outlook and specifically fashioned after the windows you use there. It will provide you a great way to make appointments, enter patient records, insurance records, and hospitals, print labels, create reports, and bill patients.

We recommend any of a number of the “…For Dummies” series of books for a more complete manual of information on using Windows, Office, or Outlook (and your computer in general). We will assume that you know how to turn on a computer and how to use a mouse and keyboard. Like everything else, the more you use a computer the easier it becomes to use.

How This Book Is Organized

This book is divided into sections to make it easier for you to find out how to do what you want to do. Each section is focused on a specific task within MedLook. The earlier sections in the book are more rudimentary with the more complicated or less used features appearing near the latter part of the book.

**Section 1 – The Basics** serves to introduce you to the elementary terms used by all Windows programs and then those specific to MedLook. The basic structure of MedLook is also presented.

**Section 2 – Setting up the Essentials** illustrates basic data that must be defined before you can really begin handling patients, charges, payments, and bills. This includes setting up codes, doctors, insurance carriers and more.

**Section 3 – The Patient Account** contains all of the information you will need to enter and edit patients, add a charge, make a payment, and print a bill.

**Section 4 – Batch Billing.** In this section we discover how to do insurance and patient billing on a regular basis (usually monthly).

**Section 5 – Reports.** Not all reports are created equal. You will find there is a lot of functionality in the MedLook reports that allow you to find information otherwise hidden, to drill into patient information, and more.
**Section 6 – Labels.** You may never use the labels options, but in the course that you do, you will find a full featured label generator with support for virtually every Avery label. It can really make you life easier for mailing notices.

**Section 7 – Appointments.** The scheduling component allows you to make individual and recurring appointments and even reserve time slots for special activities (such as physicals).

**Section 8 – Using MedLook.** There are at least three approaches to using MedLook, folder driven, patient driven and schedule driven. This section will help you determine which fits best for you.

**Section 9 – The CMS/HCFA 1500 Form.** How to modify the output of the 1500 form for electronic and paper claims.

**Section 10 – More Helpful Features.** Some of the less frequently used and some of the more advanced features of MedLook will be discussed in this section such as data maintenance (backups, packing).

**Section 11 – What To Do When Something Goes Wrong** covers just what you would expect. MedLook includes some tools for diagnosing problems when something goes wrong on your system and this section takes a look at these tools.

**Section 12 – Everything Else…** Want to know what features are planned for the upcoming releases of MedLook? Then this section is just for you.

Go ahead and give this a try. You can display the report without printing it.

To summarize, the Database Analyzer is a powerful tool that can help find, and even solve many of the problems that can occur with MedLook’s database. Under normal circumstances, the only reason you’ll need the Database Analyzer is to rebuild the indexes. But, on that Monday morning, when you see an error message as you start MedLook, and you can’t access your data, the Database Analyzer may save the day.
Section 1 – The Basics

This section covers exactly what it is titled: The Basics. We realize that not everyone is a Windows expert and they don’t have the intention of ever becoming one. However, there are many fundamental concepts that must be understood to fully exploit the power of any Windows based product such as MedLook. In this section, we will define and discuss the basic concepts that we believe you must understand to use the software and to more fully use your computer system.

This section is divided into two chapters: Windows and MedLook. The first chapter will teach you basic navigation skills and provide you with the vocabulary required to speak “Windows” talk. The second chapter will provide you with additional skills and vocabulary needed to work and communicate in MedLook.
Chapter 1 – Windows

We would like to assume you are already familiar with Window’s but this is not always the case. We are going to define some basic terminology that will be used throughout the rest of the manual. Let’s begin by looking at what’s on your screen.

Of course, your screen will look different than this but it has the same basic components. The Desktop is the entire background of the screen. EVERYTHING takes place on the desktop. The only time your desktop is hidden is when your monitor is off, a screen saver is running, or an application has it covered.

Before we discuss how to use the desktop we have to understand the mouse. Most of the time a mouse has two buttons: the left and right buttons. The left mouse button is almost always used to select something or to start a program. Usually you would depress it once, fairly quickly, to make a selection. Clicking it twice in a row rapidly is called a double click. We double click on something when we want it to “do something.” So a single click is usually for selecting an item and we normally just refer to clicking on an item with no reference to single or double or left or right. It is universally understood that clicking an item is a single left mouse button click. Likewise, it is universally understood that reference to a double click is a left mouse button double click, normally to initiate an action (like start a program).
The right button usually is used to display a popup menu. A popup menu is simply a vertically aligned menu that presents you with a list of options. Below is the menu that appears when you do a right click on a Windows 2000 system.

Rarely do we use a double right click button. Of course, the right click button can be remapped to something other than a popup menu. In fact, Windows is so flexible you can completely switch the left and right mouse button actions around (that will confuse just about any user, even left-handed ones!). You can also control the sensitivity of the double click. If you want to know more about this take an adventure and investigate your system control panel, buy a book, take a class, or ask a friend to show you.

Let’s return to the desktop. The items specified by the Applications and Shortcuts are usually shortcuts to installed programs and files. Normally you would double click on these items to start the program you intend to use or the file you want to edit. You can see the MedLook icon in the second column, third icon down, shown as a big blue “M” in white.

The Taskbar is the area shown at the bottom containing the Start Menu, Taskbar Shortcuts, Running Applications, and System Tray. It can appear elsewhere but by default appears at the bottom. It can also automatically hide itself when the cursor leaves its area and stays away for enough time (it will reappear when the cursor moves back to its area). The taskbar is essentially a “command center.”

The Start Menu allows access to many more applications than currently appear on your desktop. Furthermore, you can access options from within each program with the Start Menu that do not appear by simply clicking on the product on the desktop. For instance, you can use the Start Menu to navigate to (All) Programs and then MedLook. At this point you can activate the MedLook Help system by selecting MedLook Help (without ever starting the program – cool!).

The Taskbar Shortcuts are user configurable and may not even appear on systems (particularly old systems). This is just one more way to start or launch a program. This is useful as the desktop is often completely covered by an application making it inconvenient to access the application icons on the desktop. The taskbar shortcuts are almost always visible. You just click the application icon you want to run from this area.
The **Running Applications** are little windows that simply convey to you what programs are running and what dialogs are displayed. You can click on them to activate and display them or to hide them (although not all programs behave the same in this sense, for the most part this holds true).

The **System Tray** shows some of the programs (but not all) that are currently running or are on standby on your system waiting for you to activate them. Often times these programs have left and right click menus associated with them. For instance, a left click on the MedLook icon in the system tray brings up the following menu:

```
New Database
Open Record
New Patients
New Referral Sources
New Providers
New Facilities
New Fee Schedules
New Procedure Codes
New Place of Service
New Insurance Carriers
New Diagnosis Codes
New Modifiers
New Type of Service
Show
Exit
```

A right click on the same icon brings up this menu:

```
Open
Quick Edit
Add Service
New
Delete
Set Default
Show Fields...
Sort...
Group By...
Format View...
Expand/Collapse Groups
Restore Default Layout
Print T-Notes
Show Filters
Waiting List
Appointments
```
Let’s move along to some basics on a dialog. Most dialogs will have three icons in the upper right corner like these:

These are the Control buttons: minimize, maximize, and close (from left to right, respectively). If you minimize the window it normally will appear in the taskbar, but not necessarily, it depends upon the application. The maximize icon enlarges the dialog to fill the entire screen (and you can’t move the dialog then – it’s fixed in place). When the application is maximized the Control buttons change as shown here:

The maximize button has been changed to a restore button. This button will simply return the dialog to its prior size and location. The last icon, close, does exactly what its name says: it closes the dialog and possibly the application.

Some of these same functions can be accessed by clicking on the icon in the upper left corner of the application or dialog. By doing so the following menu will appear.

Note that Alt+F is used as a shortcut for Close. This shortcut is almost universally used to close any application.

The entire area in which the Control buttons appear is called the Title bar. Usually the title bar contains the dialog title or name. You can use the title bar to move almost any dialog by clicking on the title bar and dragging the dialog to a new position. A friendly program like MedLook will remember this dialog location the next time you access it – minutes, hours, or days later.

You can also resize most windows. Simply move the mouse to the edge of the dialog and see if the cursor changes shape. If it does then you can click it and resize it by dragging the window to the shape you want.

Let’s discuss some other odds and ends you’ll need to know.

One of the first things you may notice about menus is that the first letter of each item is usually underlined. When an item is underlined that usually means you can select it directly using the Alt+<Key> sequence. Most menus have a File item that can be selected using Alt+F.
Ctrl+A is select all. You can usually use this to select all items in a multi-select list. For instance, if you use Explorer and select a single file and then use Ctrl+A all files in the folder (including other folders) will be selected. It doesn’t do anything other than select the items.

Ctrl+C is copy. If you want to copy some text, or a file, select it and then use Ctrl+C. Nothing will appear to happen but it has notified Windows to place the item in the system clipboard. The clipboard is a reserved Windows area for us to copy data to and then take it back when we need it, possibly in another application.

Ctrl+V is paste. Once something has been copied to the clipboard we can paste it somewhere else. If you select a file, then use Ctrl+C and Ctrl+V you will have an extra copy of the file in the same folder (possibly as “Copy of yourFile”).

Ctrl+X is cut. If you want to move or remove something, use Ctrl+X. You can always use Ctrl+V to paste it back.

The TAB key is used to navigate through dialog fields. Using SHIFT+TAB will navigate in reverse direction.

ALT+TAB allows you to navigate between dialogs within an application as well as between applications.

Alt+Spacebar displays a program’s or window’s system menu (same as selecting the icon in the upper left most corner of the dialog).

Alt+Enter displays the properties for the selected item.

The ESC key will dismiss most dialogs. Sometimes it will also terminate an ongoing process.

The Windows key in the lower left of your keyboard between the Ctrl and Alt keys is a special key. If you want to quickly activate Windows Explorer use Windows Key-E. There are other keys that work with this as well.

The F#-keys at the top of your keyboard (F1 through F12) are special keys that can be mapped by each application to mean something different. F1 is almost universally mapped to activate the Help system for the particular part of the application you are currently viewing. MedLook uses these keys within the patient account as you will see later.

Often in Windows we make reference to using drag and drop. Dragging means you click on an item and then hold the mouse button down while you move the mouse. Dropping means you simply let go of the mouse.
Before you can even begin to use MedLook you must understand the information in this chapter. This is by no means an exhaustive exploration of Windows but does get you started.

Chapter 2 – MedLook

An Overview

For years medical offices have kept all of their records, financial and otherwise, in folders and cabinets. MedLook is a software representation of this same organization. It is data driven with the data being logically presented and contained within folders (just like Explorer and Outlook). So keep in mind that the entire program revolves around the concept of data in folders. MedLook consists of the following folders: patients, referral sources, doctors, hospitals, fee schedules, procedure codes, place of service codes, insurance carriers, diagnosis codes, modifiers, type of service codes, office reports, office labels, billing, helpers, and appointments. Most of these are obvious and others will require a little investigation. Let’s move on.

Below you can see the basic presentation of the program.
far left is the **Button Bar** with the **Folder List** to its left. The **Button Bar** and **Folder List** provide additional means of navigation throughout MedLook. To the right of the **Button Bar** and just under the toolbars is the **Folder Title**. Below the **Folder Title** is the **Look For** toolbar that provides you a convenient means of searching for information. Below the **Folder Title** is the **Group By** header where you can drag column headers to cause data grouping (more on this later). Finally, you have the **Folder area**. Every **Folder** will present its data somewhat differently. Often times the data is a simple list (or grid) as it appears in this example. Other times it may be a calendar or options for reporting. On the bottom is the **Status Bar** that contains date and time information and usually some useful tip or description. If the data is in a grid there will often times be a **Record Navigator** as there is here. In the lower right corner you can see a little resize widget. This is a visual cue that the form is resizable. Lastly, there are the separators. You can move your cursor over these areas and it will change shape allowing you to drag and drop the separator bar to resize the display area. Resizing is key to a successful deployment of MedLook as it runs on any size screen and even on a TabletPC.

### The Menu and Toolbars

In the view below you will see **Toolbar Handle Widgets** that were not quite as clear in the earlier picture.

![Toolbar Handle Widgets](image)

These little widgets can be grabbed (again, holding the left mouse button down) and then, by moving the mouse, the toolbars and menu can be rearranged. The default is to have four rows with the menu on top and the toolbars underneath. However, you can reorganize their arrangement using these widgets. You can move them left to right and up and down. You can join two or more toolbars together on the same line. If you get lost or accidentally lose a toolbar or the menu, just right click on any of them and the following menu will appear.

![Menu](image)

From this menu you can select **Reset to Default** and your arrangement will be back as it was when you started. As you can probably guess from the menu above, you can also show or hide individual toolbars. The menu, however, will always remain displayed (although you could slip it out of view to the far right if you’re not careful). We already mentioned there are three toolbars (**tools**, **navigator**, and **reports**) and you can plainly see
this from the above menu. Let’s turn our attention to better understanding each of these items.

*The Menu*

Let’s look at each menu pull down from the MedLook menu shown above.

The *File* menu:

You have probably noticed the Ctrl+N to the far right of *New Patient* in the menu above. This means that the Ctrl+N key sequence is the shortcut key for this operation. So if the dialog has the focus (i.e. it’s the application you are currently working in) and you select Ctrl+N you will be doing the same thing as if you selected *File* -> *New Patient*. You should pay attention to the shortcut keys as they can save you considerable time as you continue to gain experience.

Selecting the *New Patient* menu item will invoke the Patient Account dialog allowing you to create and manage patient information. If you are viewing a folder other than the patient’s folder, like the doctor’s folder, then this option will read *New Doctor*. 
New Database will invoke the following dialog:

You use this when you want to create a new database. Normally you would do this when you’re done practicing and ready to go to work. A billing service would probably do this once for each client. Simply enter path to the new folder in the Database Folder field and press OK. You can optionally use the New Folder...dialog or select an existing, but empty, folder. DO NOT USE A DIRECTORY/FOLDER THAT ALREADY CONTAINS A MEDLOOK DATABASE – USE AN EMPTY FOLDER!

Open Patient will open the selected patient’s account. Like New Patient, if you are viewing a different folder, like doctors, then this option will read New Doctor.

Open Database will bring up the standard open file dialog allowing you to browse for and select another database. You probably will never have to do this unless you are working for a billing service with a lot of clients in separate databases.
The file you are eventually looking for is MedLook.dbc. The first thing you need to do is find the proper folder you need. Use Look In to browse your system or network for the folder you need. If you are unfamiliar with this dialog you should get a *Windows For Dummies* book, or something equivalent, to help you learn more about basic Windows dialogs, folders, networks, and so on.

Selecting *Copy To* is very much like using *Save As* in any other Windows application EXCEPT the output file does not become the active document (or database).
Obviously this command will not produce anything if you are not currently in a database. Use the *Save In* field to browse for the directory you want to save the database to.

*Backup Data* will create a compressed file containing your entire database. Invoking this will bring up a yellow informational box while the files are being compressed and brings up a Save dialog when complete. Simply select the output folder and enter a new file name (if you want) and select *Save*. You should backup your data at least weekly. Database maintenance is covered in more detail in a later chapter.

The *Print* options are all identical to other Windows applications. If you are viewing a folder with a grid display, you can optionally select individual records to print.

The *Sample Database* will revert your database back to the sample database in the \c:\MedLook_30\ folder. It will prompt you to override and destroy what is currently in the folder or to use what’s already there. You would override if you wanted to “start over” with the factory sample. Because it is so easy to restore the default it is NOT advised to store your actual working database in this folder.

Everything below the *Databases* line is a list of the “most recently used” databases. The first one is the one you are currently in. Select *Open Database* to open the particular database of interest. Select *Remove Entry* to remove the database from the “most recently used” list (it does NOT remove the database from the system).
The *View* menu:

This menu is covered in its own chapter later in this book.

The *Folders* menu:

This option is the only navigation method that is ALWAYS available. Note that each folder is listed along with its shortcut keys. The last several folders have sub-folders as indicated by the triangular widgets to the far right of each item. Selecting an item from this menu will invoke the particular folder causing the *Folder* area to update as appropriate.
The shortcut keys will navigate you directly to the folder. Instead of using the Alt key, you can use the Ctrl key with the same sequence to directly enter a *New Record* for the associated folder (for folders that support new items). So Ctrl+Shift+P launches the patient account on the *Edit* tab ready to enter new patient data.

The *Tools* menu:

<table>
<thead>
<tr>
<th>Daily Ledger Report</th>
<th>Options...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bill Messages...</td>
<td>Search Notes</td>
</tr>
<tr>
<td>ClockIn/Out</td>
<td>Print Employee Hours</td>
</tr>
</tbody>
</table>

This menu provides tools that are convenient and necessary. The *Refresh Data* option causes the display to be updated with any new information posted by any other user. If you are working in a multi-user environment (several computers running MedLook at once), you will probably want to periodically update your information using this command.

The *Pack Database* command is provided here for database maintenance but really should be used from this menu only under technical supervision. If you do use it from this menu, select a report without a grid display (like Billing Versus Payment), exit MedLook, restart MedLook, and then select this command. You should be the only user accessing the database at the time. The better way to maintain your database is through the start menu, scheduled activities, or the auto-pack from within the options. This is discussed in much greater depth later in the book.
The remaining items are discussed in greater detail later in this book.

The *Programs* menu:

Add-In Manager…
Explorer Commands:
Network Neighborhood
Control Panel
Printers
My Computer
System Tools
Calculator
Explorer
Notepad
WordPad
MSWord
MSExcel
Custom Programs
NOTES EDITOR
AppTemplate
Ren Sys

This menu is covered in its own chapter later in this book.

The *Windows* menu:

<table>
<thead>
<tr>
<th>Windows</th>
<th>Help</th>
<th>Home</th>
<th>Lists</th>
</tr>
</thead>
<tbody>
<tr>
<td>#10003  -  Snyder, William, h: (205)350-3848, 1:Blue Cross/Blue Shield</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>#10006  -  White, Sue, h: (205)334-0187</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This menu keeps a list of all open windows for quick and easy selection. In the case shown above there are two open Patient windows.

The *Help* menu:

About
Contents
Registration…
Network Registration…
License Agreement…
Tip Archive (Local)
Tip Archive (Web)
Tip of the Day…
Manual
Contact Us
Check Updates
This menu gives you direct access to the Help subsystem as its primary purpose. As part of this you are also provided with information about the product and Fagerman Technologies via the About box.

The Contents selection will launch the Help system for MedLook.

Registration and Network Registration provide you means of registering your product for full use (not just evaluation mode).

The Tip Archive (Local/Web) will open up the MedLook eTips Archive either on the local computer from the last MedLook installation or from the web if connected to the internet. The Web selection will always have the most recent eTips.

The Tip of the Day is an optional display dialog that provides you a new tip each time you start MedLook.

The Manual will open up the MedLook manual with whatever PDF reader is associated with the PDF file extensions. Usually this is Adobe Reader but could be any number of other PDF file readers. The MedLook installation CD contains a file called foxitreader_setup.exe which is a small, fast, very handy PDF file reader.

Contact Us will connect you to Fagerman Technologies via the internet at www.remsys.com.

Check Updates will use the internet to see if there are any updates to MedLook available for downloading and lead you through the download process.

Here’s a little more about Help in general.

When you are within a topic you can access the help file corresponding to that topic by pressing the F1 key. For example: You want help understanding the Patients Account Summary. Simply hit the F1 key while you are looking at that dialog and the help file will pop up to that topic.

If you cannot get the Help system to activate (this does happen sometimes in Windows), you can always start it using the Start menu as: Start->Programs->MedLook->MedLook Help.

Very often you may want to search for a topic. To do this just click the Index tab in the Help window. Type in the topic you’re looking for in the Type in the keyword to find field. Press Enter on the keyboard or use the mouse to click the Display button at the bottom to locate all the topics that contain the words you typed. Another way is to double click on a topic in the list to bring up all the related topics. Click on the topic you are looking for then click display.
Home and Lists are command buttons conveniently placed on the main menu to facilitate rapidly switching between navigation modes in MedLook. Lists will toggle the display of the Folder Lists while Home always returns to no folder list display.

The Tools Toolbar

The Tools Toolbar contains options for New (records), Open (i.e. edit a record), Print Preview, Print, Look For (or search), Appointments, the Daily Ledger, and Refresh. Details for each command are as follows:

1. **New** - Clicking on the button will create a new item for the current folder. Clicking the drop down list allows you to create a new item for any folder. Here’s the drop down list:

```
- Patients
- Referral Sources
- Providers
- Facilities
- Fee Schedules
- Procedure Codes
- Place Of Service
- Insurance Carriers
- Diagnosis Codes
- Modifiers
```

2. **Open** - Opens the currently selected item.
3. **Print Preview** - Preview the currently selected grid.
4. **Print** - Prints the currently selected items or grid.
5. **Find** - Toggles the Find function, or Look For, display. By default the Find box is always on. You can toggle this function using Ctrl+F as well.
6. **Filters** – Show the filters for the current folder.

```
<table>
<thead>
<tr>
<th>Look for:</th>
<th>in Name</th>
<th>Find Now</th>
<th>Filters</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient Number</td>
<td>Color</td>
<td>Last Name</td>
<td>First Name</td>
<td>MI</td>
</tr>
<tr>
<td>10001</td>
<td>Stacey</td>
<td>A</td>
<td>Mr.</td>
<td>5/1/01</td>
</tr>
<tr>
<td>10002</td>
<td>Osagbe</td>
<td>K</td>
<td>Mr.</td>
<td>11/2/02</td>
</tr>
<tr>
<td>10003</td>
<td>Snyder</td>
<td>B</td>
<td>Mr.</td>
<td>12/3/03</td>
</tr>
</tbody>
</table>
```

7. **Appointments** - Navigates to the Appointment Scheduler
8. **Ledger** - Navigates to the Daily Ledger report.
9. **Refresh** - Refreshes the connection to the database and repaints any grid displayed. You can activate Refresh using Ctrl+R.
The Navigator Toolbar

The Navigation Toolbar gives you another method of program navigation in addition to the Folder List, Button Bar, and Folders menu.

1. Patient - Navigates to the patient list.
2. Referral Sources - Navigates to the referral list.
3. Doctors - Navigates to the doctor list.
4. Hospitals - Navigates to the hospital/facility list.
5. Fee Schedules - Navigates to the fee schedule list.
6. Procedure Codes - Navigates to the CPT code list.
7. Place of Service - Navigates to the place of service list.
8. Insurance Carriers - Navigates to the insurance carrier list.
9. Diagnosis Codes - Navigates to the ICD9 list.
10. Modifiers - Navigates to the modifiers list.
11. Reports - Navigates to the reports section.
12. Labels - Navigates to the office labels section.
13. Billing - Navigates to the batch billing section.
14. Helpers - Navigates to the helpers (zip codes, cases, comments, etc.) section.
15. Appointments - Navigates to the appointment scheduler.

Each button with a drop down allows you to select a folder, create a new item or edit an existing item.

The Reports Toolbar

The Reports Toolbar provides you instant navigation to each MedLook report.

1. Patient - Patient Data Sheet
2. %Dr - Percent Each Doctor report
3. Bill/Pmt - Billing vs. Payment report
4. ICD9 - ICD9 Report
5. Refs - Referral Source report
6. W/Ins - Patients With Insurance report
7. CPT - Cpt Code report
8. Percent Each Doctor - Insurance Reimbursement report
9. In Hosp - Patients in Hospital report
10. Aging Bal - Aging Balances report
12. Ledger - Daily Ledger (Posting) report
13. User Activity - User Activity report

The reports are covered in much greater detail later in this book.

Everything Below the Toolbars

Button Bar

The Button Bar is very similar to the Outlook Bar in Microsoft Outlook. This panel, if displayed, will be immediately to the left of the Folder List and usually in the left-most display area of the application. It functions very much like the Folder List. The difference between the two is almost purely visual. Again, it is a matter of preference. The Button Bar presents the data in groups: Lists, Reports & Billing, Appointments, and Helpers. Each group presents the necessary options to navigate in a certain number of folders. Just click on the folder you want displayed.

You can hide or show the Button Bar simply by using the Ctrl+B key sequence or checking or un-checking the option on the View menu.

Folder List

This is a list of all the available folders in MedLook. The Folder List displays vertically on the left side of the application. It is very similar to the Folders list in Windows Explorer (My Computer). The +/- sign to the left of the folder items indicates if there is a sub-folder or not (if not there will be no +/- sign) and if the folder is opened (-) or closed (+). Selecting an item in the Folder List causes that folder to display its contents to the right of the Folder List. Some folders display a grid of data and others display grids and options to further generate reports, bills, labels, etc.

You can hide or show the Folder List simply by using the Ctrl+T key sequence or checking or un-checking the option on the View menu.

The Button Bar and the Folder List provide means of folder navigation just like the Folders menu and Navigation Toolbar.

Sub Folders

As mentioned above, the Folder List contains items with a small box with a “+” in it to the left. You can open these folders to access their sub-folders by clicking the “+” image. The sub-folders contain preformatted and pre-grouped lists of data. The screenshot below shows the Pending Insurance sub-folder. This displays patient accounts with balances due from insurance.
Sub-folders can be used to more closely track your data, and to generate reports (select a sub-folder, click on File, and select Print Preview). You can even open patient accounts or other items in sub-folders by double clicking the item on the grid. And, if you would rather work from a sub-folder, MedLook will remember where you were when you closed the program. For example, if it’s your job to track down insurance payments, and you want to use the Pending Insurance sub-folder to do this, simply leave MedLook in that sub-folder when you close the program. The next time you start MedLook, it will open on the Pending Insurance sub-folder.

**Folder Title**

The Folder Title allows you to quickly see what folder you are currently working in. If there is a number to the right of the title this represents the current number of records contained within the folder. If the folder has a grid display and it has grouping enabled, double clicking in the Folder Title will toggle the grouping between collapsed and expanded.

**Look For (or Find...or maybe Search?)**

The Look For, or Find/Search, box is immediately beneath the Folder Title. By default this area is displayed but you can toggle it from visible to invisible using Ctrl+F or selecting it from the Tools menu or Tools Toolbar. It is very easy to use. You simply enter the text you want to search for in the Look For field, and in the Look in field you select what column you want to search, and then press Enter or Find Now. The search will cycle on matching items bringing each item it finds, as it finds it, into view (but not necessarily to the top). It does not filter the list to only matching items and it does not reorder the sorting of the grid. If you want to search a list for all “Jones” alphabetically then you should sort by last name and then first name. If you don’t sort like this, then the search works through the grid in the order it is currently sorted (after all, you define the sort order – but more on that later).

Some fields are numeric and others are text. Some fields look for an exact match, or a match in the pre-fix of the field being searched, while others search for the text anywhere
within the column being searched. Some searches can even be compounded. It is dependent upon the folder. Let’s look briefly at just a couple of searches in the patient folder using the patients we’ve already seen in earlier displays. These patients have patient account numbers ranging from 100009 to 1000013. If we search for “100” with the Look In set to Patient Number then it will find every patient. If we change the search to 10001” it will find all the patients EXCEPT 100009. It’s matching the prefixes.

If we change the Look In field to Name and leave the “100” in the Look For field, then nothing will be found (gee, nobody has a name like that). If we change the value to “Av” then it will find Avery, April. Searching by name can be interesting. The search for patient name uses the following logic:

1. If you provide a single name, it searches for a matching last name.
2. If you provide two names, it searches for “FirstName LastName”.
3. If you provide two names with a comma separator, it searches for “LastName, FirstName”.
4. If you provide a comma and then a name, it searches for a matching “FirstName” (e.g. “, Bil” will find the patients with the first name of “Bil” as their first three characters).

The Look For box appears within many folders. Many times there are input fields that have drop down boxes that will display a grid with a Look For section (we call these Find dialogs). Don’t waste time searching manually through a long list when you can let the program do this for you in an instant.

Using The Grids

To delete something, try the obvious – select the item and use the DELETE key. You can often times use the right click delete option as well, but the DELETE key is the simplest and most universal approach. If the grid you are on allows for editing of the columns then to delete the record you must select it on the far left-most widget, the Row Header, (not in any column) and then delete it; otherwise you are only deleting the contents of that particular cell (if it allows editing, some columns may allow editing while others do not within the same grid). In the display below the patient (100077, Jones) is selected for deletion. The circled button with the sideways triangle in it is called the Row Header. You use the Row Header to select an entire row regardless of its settings. If a grid does not have a Row Header, click on any field in the row to delete it (if it is permissible).
If a grid is in *Edit Mode* as in the following example, the cell being edited will receive the effects of any edit, including the DELETE key. In order to delete the record being edited, the *Row Header* must be clicked first. As shown the cursor is in the Amount field of 8.86. Using the DELETE key would simply begin deleting that amount.

<table>
<thead>
<tr>
<th>Trx Date</th>
<th>TR #</th>
<th>Date</th>
<th>Thru Date</th>
<th>Type</th>
<th>Amount</th>
<th>Applied</th>
</tr>
</thead>
<tbody>
<tr>
<td>03/04/2004</td>
<td>100600</td>
<td>03/04/2004</td>
<td>C</td>
<td>$100.00</td>
<td>$0.00</td>
<td></td>
</tr>
<tr>
<td>02/27/2004</td>
<td>100597</td>
<td>02/27/2004</td>
<td>P</td>
<td>$10.00</td>
<td>$0.00</td>
<td></td>
</tr>
<tr>
<td>02/20/2004</td>
<td>100583</td>
<td>02/20/2004</td>
<td>X</td>
<td>8.86</td>
<td>$0.00</td>
<td></td>
</tr>
<tr>
<td>02/19/2004</td>
<td>100580</td>
<td>02/19/2004</td>
<td>P</td>
<td>$100.00</td>
<td>$100.00</td>
<td></td>
</tr>
<tr>
<td>02/17/2004</td>
<td>100574</td>
<td>02/17/2004</td>
<td>C</td>
<td>$125.00</td>
<td>$0.00</td>
<td></td>
</tr>
</tbody>
</table>

In the display above the *Date* field is the only sorted column. The actual text *Date* is the *Column Header* for that column of data. Selecting a *Column Header* will set that column of data for sorting and toggle the sort order. (You can sort by up to four columns of data by we’ll get to that later in Formatting Views).

If you want to remove (not delete) an item from your list of selected items (deselect it, if that’s really a word – we use it all the time!), hold the *Ctrl* key and click the mouse on the item you want to deselect. To deselect many items in a row hold the *Ctrl* key and click on the item to deselect. While still holding the *Ctrl* key and the *Shift* key click on the last item you want to deselect.

If you would like to move a column of data, simply click on the *Column Header* and drag the column to the position you want it displayed. MedLook will remember this setting until you change it to something else.

*Group By Box*

Checking this option produces an area just above the grid that allows you to drag and drop column headers into it that will subsequently cause the grid to group items based upon your selection. Once columns appear in the header they can be dragged to rearrange the order of grouping. You can also achieve this same result using the View->*Group By* menu item. Double clicking in the *Group By Box* will cause the selected grid item to be opened for editing.

Here’s a simple example using the *Group By Box* with our grouping by patient sex.
Notice that the group header gives a record count.

*Status Bar*

The status bar is the area across the bottom of the dialog containing the date, time, keyboard status, and descriptive text defining many of the commands available as the mouse moves over each command button, menu item, etc. This option takes a little space and can be hidden if you are really tight for space as on a Tablet PC.

**How To Do The Simple Things**

Now let’s take a look at how to do the most common tasks such as open items, multi-select, create new records, delete items, move, and deselect items.

To open an item in MedLook, just double click on the item. For example, if you need to access the account of a patient double click that patient in the grid. One click will only select the item.

To select more than one item hold the Ctrl key and click the mouse on each item you want to select. *You cannot drag the mouse! You must click each item.* To select many consecutive items in a list, click on the first item you want and then hold the Shift key and click the last item needed on the list. To select additional items hold the Ctrl key and click on the items needed.

Right clicking on an item in the grids will give you options from which you can choose your preferences for viewing the grids such as style, fields, sorting, grouping, print previewing, etc...

You can access the New dialogs by using the shortcut keys Ctrl+N, selecting File->New <Item>, selecting New on the toolbar, selecting the folder from the pull-down alongside the New toolbar item, or single-clicking the MedLook icon in the System Tray and selecting the New <Item> (where 'item' can be any one of the folders such as doctors, hospitals, etc.)
Section 2 – Setting up the Essentials

Before you can begin entering patient information into the system there are some basic elements that should be entered first. Obviously you can’t bill a patient’s insurance company if you don’t have the insurance information. You can’t bill the insurance if you don’t have the procedure (CPT) and diagnosis (ICD9) codes. Of course, the insurance would also like to know who the doctor is performing the service. And the list goes on. So before you can expect to enter patient information you have to load some very basic information. This section will discuss each of these items. It is not complicated and will not take long to enter this information into the system. Some of the elements are loaded and then you never enter any more (like doctors, perhaps) while others may change with each patient (like insurance) and still others may change annually (like the codes).

As we discussed earlier, in any folder view (doctors, hospitals, etc.) the New Record dialog can be quickly accessed by several means:

- Selecting File->New <item> from the menu pull-down, where <item> is Patient, Doctor, etc.
- Using Ctrl+N,
- Selecting New on the toolbar,
- Selecting the folder from the pull-down alongside the New toolbar item,
- Using Ctrl+O for opening a patient, or
- Single-clicking the MedLook icon in the system tray and selecting the New Record (where ‘record’ can be any one of the folders as doctors, hospitals, etc.).

Use the following keyboard shortcuts to enter new items regardless of the current folder:

- Ctrl+Shift+P New Patient
- Ctrl+Shift+R New Referral Source
- Ctrl+Shift+D New Doctor
- Ctrl+Shift+H New Hospital
- Ctrl+Shift+F New Fee Schedule
- Ctrl+Shift+C New Procedure Code
- Ctrl+Shift+S New Place of Service
- Ctrl+Shift+I New Insurance Carrier
- Ctrl+Shift+9 New Diagnosis (ICD9) Code

These shortcuts will open the New dialog for each item ready for data entry.
Chapter 3 – Providers, Facilities, and Referrals

Adding New Doctors

With Facilities in the folder view, select New to add a new entry or press Ctrl+Shift+D. The red fields (Last Name and Code) in this dialog must be completed. Enter the Last Name in the Provider Data and the code. Enter their address, phone number and ID numbers such as Soc. Sec. # or Emp. ID, License # and UPIN in the spaces provided. Enter an SSN as 123-12-1234 and an EIN as 12-1234123.

To edit an existing record double click on the record in the grid.

Entering a group name is optional. If you enter a group name, it will print in box 33 of the HCFA-1500 form, and your name will print in box 31. If you do not enter a group name, your name will print in box 31 and in box 33.

You must enter an address for each doctor entered in the Doctor Information Window. You can enter a different group name and address for each doctor entered into the program. This feature allows you to bill for multiple locations.

You are given two address lines in addition to city, state, and zip code. Both of these address lines will print on individual patient bills and superbills. However, the (1990, red
ink) HCFA form only has room for one of these two address lines in box 33. If you use both address lines, only the second line will print in box 33. If you leave the second line blank, the first line will print. You should follow standard postal service regulations when you enter your address - use the first address line for more specific information, such as your suite number, and the second line for more general information, such as your street number. Enter your address as you want it to appear on bills and insurance forms (i.e., with proper capitalization and spelling).

The NPI field is used to enter an individual provider’s (i.e., doctor) NPI data. This data will print in Box 33 of the CMS 1500 form (if using an NPI enabled layout format) and in Box 24J on the new CMS 1500 form. If a Group NPI number is entered it will print in Box 33 instead of the individual NPI.

Click OK when finished.

Adding Facilities

Creating a List of Facilities and Outside Labs:

When you submit insurance forms for inpatient charges on the standard CMS insurance form you must include the name, address and PIN of the hospital or other facility in which the services were provided. The name, address and PIN number of outside labs must be included if you bill for outside lab charges. If you render services to patients in hospitals or other institutions, and if you plan to use MedLook to print insurance forms, you need to enter the names and addresses of the hospitals in which you provide in-patient care and outside labs you use.
The NPI field is now required (as of early 2007) for each facility as well. This number will print in Box 32 of the CMS 1500 form.

The Phone number is for handy reference but can also be printed on the CMS 1500 form, typically in Box 32. The Comment field can be used for anything such as the primary contact.

With Facilities in the folder view, select New to add a new entry or press Ctrl+Shift+H. The red fields in this dialog must be completed. Enter the name and address of the facility. Click OK to add it to the list. To edit an existing record double click on the record in the grid.

Tip: If an insurance carrier requires your office name and address in Box 32 on the HCFA 1500 form for office visits, enter your office information as above and select it when entering a charge just as you would a hospital. It will then print in Box 32 on the HCFA 1500 form.
Adding Referrals

With *Referrals* in the folder view, select *New* to add a new entry or press *Ctrl+Shift+R*. The red fields (*Last Name* and *ID Number*) in this dialog must be completed. Enter the name, address, and ID Number. Click *OK* to add it to the list. To edit an existing record double click on the record in the grid.

Selecting the *Physician or Agency* option enables this referral to print to Box 17 and Box 17A of the HCFA 1500 form. If it is not checked the Referral simply allows you to track financial data relative to the referral.

As of early 2007 the *NPI* is now required when submitting claims with referral information.
Chapter 4 – Procedure and Diagnosis Codes

Adding Procedure Codes

With Procedure Codes in folder view, select New from the tool bar to add a new procedure code or press Ctrl+Shift+C. The red fields (Code and Description) in this dialog must be completed. Enter the code and the descriptions in the boxes provided. Click OK to add the code to the list in the grid. To edit an existing record double click on the record in the grid. Enter the code and description under Procedure Qualifiers. A fee schedule can be selected by using the drop down list. Click Add to add the new code to the grid. Click OK to close the window.

If you are adding the same CPT code to different Fee Schedules, fill in the information and click the Add button. The new code is added and the Fee field is cleared. To add the code to a different Fee Schedule enter the fee for the new schedule, choose the new schedule from the drop down list, and click Add.

Linking codes: If you have several codes entered for certain situations, for example, a patient’s first visit, you can link those codes and enter them as one when entering charges in the patient’s account. To link the codes enter a name in the Link field for each code as you add or edit them. Remember you can always use linked codes individually by un-checking the Include All Links box when entering charges.

Specifying TOS and Modifier values with a CPT code will automatically fill this information in when entering a charge. When entering the charge you can also change these values for the specific charge.

The Valid Code check box is checked by default and means that the code entered will be used to officially bill insurance carriers. If unchecked, the CMS/HCFA 1500 Viewer will list the codes as invalid. You can use this feature to enter in-house codes that are informational to your office staff, but are not meant to be submitted to insurance carriers for payment.
Adding Diagnosis Codes

With Diagnosis Codes in the folder view, select New to add a new diagnosis or press Ctrl+Shift+G. The red fields (Code and Description) in this dialog must be completed. Enter the code and the descriptions in the boxes provided. Click OK to add the code to the list in the grid. A cross reference can also be entered. When you print insurance forms and bills it is the official code description that prints, not the cross-reference. We provide a place to enter cross-references to make it easier to look up codes alphabetically. For a cross reference, you can enter any description of a disease that you will find helpful. For example, you may want to cross-reference code 009.2, "Infectious diarrhea", under "Diarrhea" or code 482.8 "Bacterial pneumonia unspecified" under "pneumonia". MedLook assumes that the cross-reference will be the same as the code description, but you can overwrite the cross-reference to change it. To accept the code description as the cross-reference Click OK.

As with Procedure Codes, the Valid Code check box is checked by default and means that the code entered will be used to officially bill insurance carriers. If unchecked, the CMS/HCFA 1500 Viewer will list the codes as invalid. You can use this feature to enter in-house codes that are informational to your office staff, but are not meant to be submitted to insurance carriers for payment.

To edit an existing record double click on the diagnosis in the grid.
Chapter 5 – Fee Schedules

With *Fee Schedules* in folder view, select *New* to add a new entry or press *Ctrl+Shift+F*. The red fields (*Fee Schedule*) in this dialog must be completed. Enter the name in the *Fee Schedule* box. Use the pull down tab to select the doctor. Click *OK* to save it to the list. To edit an existing record double click on the record in the grid.

Create fee schedules if you plan to have more than one charge for a procedure. This is particularly handy if different insurance companies have different allowable charges for the same procedure. You can identify a fee schedule with a patient when editing the patient’s account such that only those procedures listed in the specified fee schedule will display when entering a charge.
Chapter 6 – POS and Modifiers

Adding Place of Service

With Place Of Service in folder view, select New to add a new entry or press Ctrl+Shift+S. The red fields (all except ETS) in this dialog must be completed. To edit an existing record double click on the record in the grid. Enter the Place of Service, and codes in the Medicare, Alpha and Numeric boxes. Click OK to save record.

All of the Place of Service values are provided with MedLook.

Adding Modifiers

Adding Modifiers works the same as adding a Type of Service. With Modifiers in the folder view, select New or press CTRL+N to open the New Modifier dialog. Fill in the fields and click OK. Double click an existing modifier to open it for editing. You can associate up to four modifiers with a CPT code so that they will automatically be included when making a charge to a patient’s account.
Chapter 7 – Insurance Carriers

With Insurance Carriers in the folder view, select New to add a new entry or press Ctrl+Shift+I. The red fields (Carrier Name, Code Id, Claim Submission Mode, and Insurance Type) in this dialog must be completed. Click OK to save it to the list.

Demographics

Fill in the information in the Demographics section as necessary.

Tip: The Serial # field is entered by MedLook and can’t be added or changed by the user. This number will be unique and can be used to find a patient’s insurance carrier if you have several carriers with the same name. In a patient’s account, click the Edit tab and note the Insurance Id Number. Then, on the Insurance grid, you can select Insurance Number from the drop down list in the Find function to ensure you are viewing the patient’s specific carrier.
**Carrier Mnemonic**

Enter a unique mnemonic code (up to four characters) in the Code Id box. For example, you might enter "BC1" for Blue Cross. Each carrier must be given a unique code.

**Claim Submission Mode**

In Claim Submission Mode select either Send to Printer or Send to File (Electronic) depending on how you want MedLook to process claims for this particular carrier. If you set Claim Submission Mode to None then the fact that a patient with this carrier has insurance will still be noted on the Summary and Edit tabs of patient accounts, but no HCFA 1500 forms can be printed for such patients.

**Insurance Type**

Select the Insurance Type from the drop down list. Medicare, Medicaid, Group Health, and Other are the most common types used and affect how MedLook will process fields on claims. For example setting the Insurance Type to Group Health will cause the upper right section of the HCFA 1500 form to print, while setting the type to Medicare causes only the Insured’s ID Number (Box 1a) to print in the upper right section of the form.

**ID Numbers**

As the blue text says on the dialog, it is actually easier to enter these PIN numbers on the Helpers dialogs. Additionally, these numbers should cease to have any use in the very near future as the NPI numbers begin to play a more important role in the health industry.

**Entering Doctor PINs:**

Enter a Group Number in the Group # field if one is required by the carrier. The Group Number will print in box 33 of the HCFA 1500 form.

Doctor PINs print in box 33. Enter PINs for each doctor in your system by selecting the doctor’s name from the drop down list and entering the PIN in the PIN # field. After entering the first number, select the next name from the drop down list and enter the PIN for that doctor. MedLook will remember all the PINs you enter and will save them to the database unless you press the Cancel button.
PIN in Box 24 of the HCFA form:

Use the Box 24K Option drop down list to select how this box will be treated by MedLook when printing your claims for this carrier.

In most cases if a number is required in Box 24k, it will be the same number that prints in the PIN # field in Box 33. In these cases you will select Doctor’s PIN # from the list. Occasionally an insurance carrier will require one number in Box 33, and a different number in Box 24k. Select Alt number for these carriers. Yet other carriers may require that Box 24k be left blank. Select Blank (the default for new carriers) for these carriers.

If you need alternative numbers in Box 24k for each doctor in your system, you can enter them in the 24K Alternative box as you enter each doctor’s PIN.

Facility Numbers

Id numbers for outside labs and facilities where treatment is rendered may be required by some carriers. They print in Box 32 of the HCFA 1500 form, along with the facility name and address. You enter Facility Numbers the same way you enter Doctor PINs. Select a facility from the drop down list and enter the number for it in the FAC # field.

Tip: If an insurance carrier requires your office name and address in Box 32 on the HCFA 1500 form for office visits (as many now do), enter your office information as above and select it when entering a charge just as you would a hospital. It will then print in Box 32 on the HCFA 1500 form.

Box 11d Option

Box 11d is the Other Health Plan box on the HCFA 1500 form. Select the option you wish to use for this carrier. Normally the first option is used.

Place of Service Codes

There are four options for printing POS codes in Box 24B on the HCFA 1500 form. Select the one you wish to use for this carrier. For example, the Medicare option for an office visit will print an “11” in Box 24B, whereas the Numeric option will print a “3” for an office visit.

Diagnosis Code Print Option

This option tells MedLook how to fill in Box 24e on the HCFA 1500 form. Select Code or Number for this one. If you select Code, then the primary ICD9 code as set in the Box 24e field of the patient charge will print. Selecting Number will print the number or numbers as you enter them in the Box 24e field.
Print to File Option:

When *Send to File (Electronic)* has been selected under *Type Settings/Claims Submission Mode* you will need to choose which file name to print to. You have the option of selecting *File1, File2, or File3*. The actual name of each file is set in the *HCFA Options* in patient accounts under the Insurance Billing dialog or on the *Batch Insurance Billing* dialog. The most common use for File2 and File3 is to separate claims such as Medicare and BCBS from the rest of the commercial claims. How to set the file folder and names will be discussed later.
Section 3 – The Patient Account

For most users, the patient account is the heart of the system. You will log into your system in the morning, start up MedLook, and probably stay somewhere within a patient’s account the entire day without ever venturing out to the appointment folder or some other folder. The patient’s account dialog provides you with everything you need to manage the patient’s information.

After completing this section you should be able to enter new patients and edit existing patients, make charges, enter payments, make notes, and produce a bill for the patient to take when they leave the office. You’ll also be able to create an insurance claim for the patient as well.

Let’s take a quick look at the patient dialog as it will appear when first opened.

The patient dialog always displays the patient name along with the home and work phone numbers. It may also display the insurance carrier name. The Patient Toolbar contains additional commands necessary to efficiently manage your patient data. The Patient Tab Strip contains distinct functional areas of the patient account. The patient account always
begins in the summary when selected from the main program grid. The working area, as noted on the above image, displays everything about the patient except their transactions. Those are on the Transaction tab. Note that while we call this the Working Area in the image, no actual data entry or editing is done here. You can, however, edit the layout for the Summary by pressing Ctrl-F5.

There are a several other things worth noting. First, you can have multiple dialogs open at once. This allows you to manage more than one patient’s account at a time. Second, and this is pretty handy, once you have the patient’s account dialog displayed, you can close the main MedLook dialog without actually quitting (removing unnecessary clutter). You can always return to the main program using the system tray’s Show command for MedLook. If you do this and then close the patient’s account, the program closes. Third, each tab is designed to give you the initial focus where you most likely expect it so you can begin entering data.
Chapter 8 – Using the Patient Toolbar

The *Patient Toolbar* is a powerful component that enables you to work with your accounts quickly and efficiently. Using the Patient Toolbar you can enter new patients, navigate between existing patients, enter or edit other items such as ICD9 and CPT codes, access MedLook’s Options dialog, and even delete the account you are viewing. The toolbar is shown below.

The first command is *New*. If you invoke *New Patient* from the main patient *Folder List* then you are already displaying the *New* tab which means you are ready to enter a new patient into the system. If you are in a patient’s account and want to create a new account, you have two options. When you move the mouse pointer over the *New* button you’ll notice a slight change. The button will be divided into two sections as shown below. Clicking the left part of the button will move you to the *Edit* tab and clear all the fields (except any default settings you’ve entered, such as *City*, *State*, *Zip code*). Clicking the right side of the button will drop down a menu as shown below. Here, you have the *New Patient (clear)* command which is the same as clicking the left side of the button, the *New Patient (copy/default)* command which will copy all of the current patient data to a new patient account (with a new account number). This enables you to very quickly enter patients with similar data, such as families. For a completely blank starting point use the *Clear Patient Fields* command, or *Ctrl-0* (zero), and every field on the *Edit* dialog will be cleared. The final two commands on the New menu allow you to collapse or expand all of the sections on the *Edit* dialog. The alternative is to click on individual section headings to collapse or expand only that section.

*Find (Look For, or Search)* – oh how many names we have! – allows you to switch quickly and easily between patients. The current account number is displayed in this box. Use the drop down list to activate the patient *Find* dialog. The current patient will automatically be selected and the *Look In* field set to *Patient Number*. You can select any patient you wish in the customary way. Using this command allows you to change between patients without having to leave the patient account – this is key to efficiency. You can also move to the first or last record or to the prior or next record using the navigation icons to either side of the *Find* field.
The *Refresh* command will update your current snapshot of the database. Use this command when other users are adding or editing the same patients you are working with.

*Save* is available only as appropriate. Obviously if you are viewing the patient’s summary there is nothing to save, so the command is disabled.

*Printer* is available only on those tabs where you can get a unique printout, such as the summary screen. The standard Windows Printer dialog will be presented to allow you to set your printer properties.

*Delete* allows you to delete the current patient. You cannot delete the patient unless you have password privileges, you agree to delete the associated transactions and appointments, and you confirm a second time that you wish to delete the patient (this is, after all, a dangerous and costly mistake if deleted accidentally).

The *Folders* menu item is very similar to the *Folders* menu on the main program menu. It contains *New* and *Edit* commands for each folder from *Referral Sources* through *Type of Service*. If you select the *Edit <Item>* then the corresponding *Find* dialog will display and you can locate the item you want and then edit it. The last item on the *Folders* menu is *Appointments*. Use this, or the keyboard shortcut of *Ctrl-A*, to open the Appointment Scheduler with the current patient’s information filled in.

The *Recent* button will show you a list of patient accounts you’ve opened in reverse order with the current account at the top. This allows you to quickly navigate between groups of accounts.

Clicking *Options* will open the MedLook *Options* dialog, just like clicking on the main program’s *Tools, Options* menu.

*Go Back* is just one more way to exit the dialog. You can also close the dialog using Alt+F4 or the close control button in the upper right corner of the dialog.
Chapter 9 – Adding and Editing Patients

One of the most time consuming areas in the electronic office is entering patient information. Each new patient requires entry of basic demographic information (name, address, phones, DOB), personal information (employment, marital, and student status, sex), referral and physician information, billing and insurance information, and other tidbits of data. Obviously streamlining this process is an important feature in the software. MedLook provides a flexible and efficient interface for entering all of this information. You literally start at the top and finish at the bottom. There are no cumbersome wizards. There isn’t one dialog after another. You don’t have to go through needless fields just because they’re there.

Let’s Edit!

Let’s take a look at the Edit dialog by category.

As you can see, the Edit dialog uses a standard properties presentation. Each of the sections has been collapsed (using the Collapse command on the New menu button as already discussed). You can click any category to make it expand or collapse. Additionally, you expand or collapse a category when it has the focus using the space bar.
Let’s take a look at the same dialog, stretched to be taller, with the categories opened.

You can navigate this entire dialog, including each individual tab, using the mouse, the keyboard, or in combination. Many users find it easier to learn the program using the mouse but that efficiency comes by using the keyboard-only interface. See the Keyboard Navigation section of the Appendix for an explanation and list of keyboard shortcuts.
While keyboard navigation and entry is the fastest there are times when a mouse is necessary (so don’t throw it to the cat just yet!).

Note: Many of the fields on this dialog are self-explanatory so we’ll look at those of interest and add some extras along the way.

To begin entering information, either select the field with the mouse or use the TAB key to navigate to the field you want. By default each tabbed dialog is designed to place your initial focus in the area most likely to be of interest to you. In the Edit tab, you begin in the Last Name field. MedLook, by default, will generate an account number for a new patient. You can edit/delete this number to enter one of your own. If you are editing an account, the Account Number field will be read-only (i.e. you cannot change it).

Notice the Copy Existing Patient drop down just above the Last Name field. This can be used to quickly enter a new patient where at least one family member is already listed as a patient. Use the drop down list and find the patient you already have, load them into your system, and most of the information will already be in place. The First Name, MI, Birth Date, Sex, and other attributes will stay the same, but attributes such as Address, City, State, Zip Code, Home Phone, etc., will change to the demographics of the patient selected from the Copy Existing Patient drop down. This is just another way of quickly entering patient data. If you have just entered a patient and are entering a sibling, parent, or child, you can use this method, or select New Patient (Copy/Default) from the New drop down button as described above to repeat the process. If you want to enter an entirely unrelated person use the New Patient (Clear) command, and if you want to completely clear all fields click New->Clear.

You can also set defaults for many of the data entry fields. For example, if you see mostly married patients you may want to set Married as the default for the Marital Status field. See Patient Account Defaults under Options for details and a list of items that can be set. These settings are on the Options dialog which is located on the Tools menu, and is also accessible by clicking the Options button in the Patient Account.

To continue with the New/Edit Patient dialog, after entering the patient’s last name, first name, and middle initial, you can select a Title or enter any four-letter prefix you prefer.

The city, state, zip code, and area code fields will default to those found in the Tools->Options->Preferred Locale settings. You should set these with the most commonly used values, or nothing at all.

The zip code field can be used to load itself as well as the city and state fields using the drop down list. You can predefine city, state, and zip code fields using the Helpers discussed later in this book. The Find dialog that appears is sorted by three methods to present the values most frequently used. As you enter more patients, the program keeps track of this information so you are always presented with your most frequently used choices at the top of the list. You can always choose to enter the city, state, and zip code.
directly by key-in. *Hint:* Use the *Helpers* to keep a nice clean list without any typo’s or spelling errors.

The *Patient Status* field contains the values *Active* and *Inactive* by default. You can add other values, (e.g. Collections), using the Options dialog, to describe the status of patients. If *Patient Status* is set to Inactive the patient will be ignored in most operations (e.g. in batch billing and reports). You will still be able to process individual insurance claims and patient bills in the Patient Account if necessary.
The *Custom Fields* command will display the following dialog:

![Custom Fields Dialog](image)

In this dialog you can create any number of custom fields. In the dialog above this includes *Hair Color, Height,* and *Weight.* Each field can contain up to 80 characters of information. As new fields are entered they will appear in the *Field Name* drop down list for subsequent patients.

At the moment the *Custom Fields* are only used in the *Insurance Reimbursement* reports where any single code can be included in the report generated. This was a direct result of a customer request.

The *Print on Insurance Form* field is in reference to the referral source. If you are entering a referral source that is not a physician or is not recognized by your insurance carrier then you would set this field to “no.” If the insurance carrier is expecting a referral then set it to “yes” or you may have trouble getting your insurance payment (and that’s hard enough already in most cases).

You can specify a certain *Fee Schedule* for each patient. This simply limits the CPT codes that will be listed on the *Charge* dialog to those defined for the fee schedule.

Normally you would include most patients in your *Automatic Billing*. There are always exceptions to this rule – perhaps family members, disadvantaged or pro-bonus work, or even employees. Those marked as “no” are simply skipped during batch billing. As you will see later, when batch billing, you can ignore this setting if you need to for some reason.

The *Send Bill to Resp. Party* (i.e. Responsible Party or Other in some cases) field is used to designate some other party who is part and party to this patient’s billing. This may be a parent, step-parent, sibling, grandparent, attorney, trust fund, school, or any one of many things.

For the *Managed Care* patients you can specify how many authorized visits there are and how many there are remaining. You must also specify a starting date. The ending date is optional. The *Authorization Code* is also mandatory.
The *Recall Date* is simply an indicator used for generating patient labels (see a later section). Setting a date allows the system to generate a label at the appropriate time. Usually you would do this to mail out an annual checkup notice prior to the recall date. You would probably generate these labels six weeks in advance so you can call or mail the patient.

MedLook will allow you to enter up to four insurance carriers for each patient. Each of the four possible insurance categories has identical fields. Select the order, (i.e. *Primary, Secondary, Tertiary, Quaternary*), from the *Insurance Order* drop down list. Select the carrier from the *Company Name* drop down list. If you want to remove the carrier from the patient then use the *Clear* command on the *Find* dialog that opens from this drop down. You can also simply click on the Remove Insurance command in the particular insurance section (the same for Referrals as well).

The *Insurance Id Number* is part of the carrier data, and is programmatically generated to give you a unique identifier for each insurance carrier. It is not printed for insurance purposes, but can be used to specifically identify a carrier. For example, if you have a dozen carriers with the name “Medicare,” each of them will have a unique *Insurance Id Number*.

If you select the *Relationship to Insured* field to be something other than *Self* then you must enter more address information (again, be smart and use the *Last Name* field wisely to pre-load information if a relative is already a patient).

The *Co-pay* can be done as a percentage or a flat rate by selecting the appropriate option in the *Co-pay Method*.

**An Example – Adding A Patient**

Let’s take a moment and demonstrate adding a patient without the mouse.

Once in the patient account, select F3 and Ctrl+N. Enter the last name Washington and first name George. Press Ctrl+S. That’s it! We have a new patient named George Washington. Simple enough.

Continue using the TAB key to advance through the fields. If you need to change the patient’s title, or perhaps state, select F4 when the field has the focus. You can then use the up/down arrows to highlight the item you want from the list and press ENTER to make the final selection.

When the zip code field has the focus, since it again has a drop down, use the F4 key. The *Find Zip Code* dialog appears. You can use this just like normal – enter part of the zip code and press ENTER. You can also use the TAB key to navigate to the grid and
then use the up/down keys to navigate on the grid highlighting the item you want. Finally press Ctrl+G to make your selection final.

On yes/no answer fields such as *Automatic Billing* and short list fields such as *Employment*, use the left/right arrows to navigate through the list to the item you want to select.

For dates you use the F4 key to bring up a calendar but then you’ll have to use the mouse to make your selection (not good). It’s easier to enter the date in free format such as Feb 14, 2004, or as 02/14/2004, or even 2 14 4 (several formats are accepted).

Again, use Ctrl+S to save your results. If you really messed something up and don’t want to save the results, use Ctrl+R to refresh back to the original information.
Chapter 10 – Understanding the Summary

The patient *Summary* is presented as a table of information. It is defined with a template delivered with MedLook as a Rich Text File (rtf). The summary can be printed or used for cut and paste operations. Its purpose is to provide some basic information regarding the patient that you can quickly review without having to edit their account, produce a bill, or generate an aging report of the account balance. When you select a patient account from the main program you are first presented with the patient’s summary. Below is a screen shot of the *Summary* dialog with the *Quicknotes* function enabled. *Quicknotes* is toggled by right clicking on the *Summary* and selecting *Quicknotes* on the context menu or by checking/unchecking it from the *Options* drop-down list.
Most of the summary is self-explanatory but some of the insurance information is not exactly obvious. Immediately below the Insurance field is a line containing the insurance mnemonic (nickname seen in MedLook), the Accept Assignment status, and the patient’s insurance ID number.

You can customize the Summary dialog by editing the PatientSummary.rtf file (or PatientSummary98.rtf if using Windows 98/ME) by using Ctrl+F5 in the patient account or by clicking the Edit Template menu item from the Options menu. See Custom Reports for more details on this.

The Quicknotes area allows you to enter just about anything you’d like, much like the Patient Notes – F9 dialog. Notice that Quicknotes has its own toolbar which is identical to the Patient Notes toolbar, and just like the Patient Notes, you can search, print, and format the data to your specifications.

The Quicknotes window can be resized by moving the mouse pointer over the bottom of the window (which is the top of the Summary window) until the pointer changes into a vertical double-ended arrow. When this happens, click and hold the left mouse button and drag the window up or down until it is the size you want. Note that it can only go so far in either direction. Data entered in the Quicknotes window is automatically saved. To close Quicknotes, right click on the Summary and click Quicknotes (which will be checked) on the pop-up menu. Repeat the process to once again display Quicknotes.

The only other option on the Summary’s right click, or context, menu is Copy. If you highlight part or all of the Summary, then right click, the Copy menu option will be enabled. Clicking Copy will place the highlighted data in the Windows Clipboard. You can then paste that data into the Quicknotes, Patient Notes, or into another program, such as a word processor.
Chapter 11 – Entering Charges

MedLook has all of the information necessary for entering a patient charge on one dialog. Navigation can be accomplished either with the mouse or the keyboard. In most cases, you should be able to complete entering a charge in only a few seconds. Below is the entire Charge dialog.

![Charge Dialog](image)

Any section you don’t need, e.g. Modifiers, can be closed to save space. Just click on the heading of the section to close it. If a section is already closed, clicking on the heading will open the section.

First on the Charge dialog is the Existing Charges section. Here you can edit an existing charge and fix any errors, or take an existing charge and copy it, creating a new charge with all of the existing charge’s settings. Once in either of these modes, you can clear the dialog and start from scratch by clicking Clear/Reset Charge. The Clear/Reset Charge option can be used at any time to reset the dialog.
The *Fee Schedules* drop down contains a list of fee schedules that can be used for the patient. Selecting a fee schedule will limit the CPT codes displayed to the codes included in the fee schedule.

You can quickly navigate through the dialog, using the mouse or keyboard, selecting your diagnosis codes, entering the date of service and outside lab fees, and finally saving the charge using Ctrl+S or the *Save* toolbar command.
**Entering A Charge**

Let’s take a detailed look at entering a charge. We’ll skip over the *Edit Charge* category and three check boxes. We’ll return to the *Edit Charge* category in just a bit. First, as fields change on the dialog, they turn to a blue color to signal that the field has been changed. This allows you to quickly see what fields are not defaulted, etc. Begin by selecting the procedure code from the CPT/HCPCS drop down list. The description will appear below the CPT/HCPCS list. You can include any linked procedures by checking the *Include Linked Procedures* box directly beneath the description.

Next, is the *General Information* section. This section contains various options regarding the charge amount and its breakdown between payers, and several other fields. Let’s take a look at them.

First in the *General Information* section is the *Apply Debit* check box. Checking this box will disable most of the other fields since they aren’t needed when entering debits. Only the *Amount*, *Comment*, and *Box 24A Service Date* fields are enabled. The last field, in spite of its title, has nothing to do with the HCFA form. It’s really nothing more than the date you want to record with the debit. Perhaps a better way of handling debits would be to create a procedure code called “debit”. This gives more flexibility in many of the reports.

Debits are generally used for error correction, balancing over-payments or refunds, or to bill the patient for procedures/services not billed to insurance. To enter a debit, check the *Apply Debit* box, enter the amount, and if necessary, enter a comment and change the *Box 24A Service Date* (this will default to the current date). Once the data is entered, click the *Save* button on the toolbar, or press Ctrl-S to save the debit. You can view the debit on the *Transaction* dialog (click the tab, or press F10).

The *Ignore Copay and Managed Care for ‘same date’ charges* check box does just what it says. If you are entering a second charge for this patient (without having dismissed this dialog or switched to another patient) on the same date, you should not be charging the patient co-pay again. So you should leave this box checked. It will stay to whatever value you set until you change it again, even in a later session. The same applies to the number of visits for Managed Care patients. You should only count their visit once per day.

On the other hand, if for some reason you don’t want the program to use the Co-pay or Deductible settings, you can check the *Ignore Copay/Deductible Completely* box and the full amount of the procedure will be placed in the *Primary Ins. Due* field.

The check box, *Leave Charge Off Form*, is used to flag the charge to be ignored during batch insurance claim processing. You would rarely do this, but if you do, you can still process the charge using the individual insurance claim option of the patient’s account.
Next in the charge process are the “Amount” fields. First is the Box 24F – Charge Amount. This field should contain the same value as your CPT Amount field listed in the pop-up grid you used to select the procedure code. Generally you would leave this as it is but it is possible to change it (e.g. for an uninsured patient, etc.).

The Deductible field shows whatever amount remains from the patient’s deductible. It will automatically be updated with the charge.

The Primary Ins Due field shows the amount expected from insurance for this charge. It usually is the difference between the co-pay and the procedure amount (unless a deductible is involved). You can change this amount if necessary. This field is only enabled if the patient has primary insurance.

The Patient Due field shows the amount expected from the patient, usually either the co-pay or the entire procedure amount.

The Secondary Ins Due field is identical to the Primary Ins Due field and is only enabled if the patient has secondary insurance.

The Resp. (Responsible) Party Due field shows the amount expected due from another party as noted in the patient account. Rarely would this field be modified during the initial entry of a charge. It would more likely be edited later. Ideally it would only be changed during a payment and never changed here.

The Primary Ins Due, Patient Due, Secondary Ins Due, and Other Due fields must add up to the Box 24F - Charge Amount. You cannot submit a charge without these fields being equal (we don’t allow for “bad math”).

The Prior Authorization field allows you to enter the Professional Review Organization (PRO) prior authorization number for those procedures requiring PRO prior approval. Enter the Investigational Device Exemption (IDE) number when an investigational device is used in an FDA-approved clinical trial. For physicians performing care plan oversight services, enter the 6-digit Medicare provider number of the home health agency (HHA) or hospice when CPT code 99375 or 99376 or HCPCS code G0064, G0065, or G0066 is billed. Enter the 10-digit Clinical Laboratory Improvement Act (CLIA) certification number for laboratory services billed by an entity performing CLIA covered procedures. (This information was taken directly from the HCFA 1500, Chapter II instructions. Basically, what you want in this field is whatever the insurance carrier requires.)

The Managed Care check box will be enabled if the patient is marked as being a managed care patient. It will show the number of visits used and allowed and the valid date ranges. You can also have the software notify you with a message when the number of visits remaining drops below a certain number. Use Tools->Options->Patient Account Defaults::Managed Care to select the level at which you want the warning to begin appearing (select 0 for never).
In the Comment field you can enter a new, individual comment or select a comment from the list of available Charge Comments found in the Helpers folder. If you continually re-use a certain comment you can save yourself time by adding the comment to the Charge Comments folder under Helpers.

The Box 21 – Diagnosis Codes category allows you to enter up to four ICD9 diagnosis codes as required on the HCFA 1500 form. The Case field allows you to build shortcuts for codes that you commonly group together. See the Helpers Case Codes folder later in this book for details describing how to build this list. You can select a case and the appropriate diagnosis codes (1, 2, 3, 4) will automatically be filled in. If you enter a Case that does not exist then it will be created with the selected codes when you save the charge. New cases created in this way are specific and unique to the patient (i.e. they are not visible to other patients). Cases created in the Case Codes folder can be generated for all patients or individual patients. It is not necessary to use the Case field at all.

If you don’t want to use Cases you can search for and select ICD9 codes from the drop down lists, or just key the codes in manually. If the values are keyed in they must already exist in the Diagnosis Codes folder otherwise the system will not let you save the charge (you will receive a warning to this affect).

IMPORTANT NOTE: When entering procedures that should print on the same claim form all four diagnosis code fields must be set and remain the same for each procedure. If the diagnosis codes are not EXACTLY the same for each procedure then the claims will be printed on separate forms. Also note that procedures are entered one at a time but will automatically be grouped to fit as many per page as possible.

The Related Item(s) from Box 21 field is used to specify which code or codes are to appear in Box 24E of the HCFA 1500 form. You can enter any combination of 1, 2, 3, or 4. The individual insurance carrier setting for the Diagnosis Code Print Option (Code or Number) specifies what will finally be used in the column, the code or the number. You can enter these values separated by commas or by spaces.

The Box 24D – Modifiers category contains four fields for entering or selecting modifier codes. The codes can be keyed in or selected from the drop down list. Unlike the diagnosis codes above, modifiers can be entered at any time; however, if new modifiers are entered in this way they will not be added to the Modifiers folder. Modifiers must be two characters in length. If you select a CPT procedure code that has modifiers defined with it they will, by default, be loaded into these fields.

The More 1500 Box Items category contains a number of other items required for the HCFA 1500 form. Each of these is discussed below.

Box 24A – Service Date is self-explanatory. If you change this field it will “stick” (i.e. remain as you just set it) for all subsequent charges until you either change it or restart MedLook. This facilitates entering back logged charges. Upon each new session of
MedLook it reverts to today’s date. As with other date fields, you can select the date from the drop down calendar or enter the date (usually as Feb 27, 2004, or 2/27/2004).

Box 24A – To Date goes hand in hand with the Service Date. There is an option in Tools>Options that allows you to specify that this field should be left blank for each new charge or, if blank, that it should default to match the Service Date. Of course if you are entering a procedure that spans a range of dates, you would enter the ending date here. When setting up a patient’s insurance carriers on the Edit dialog, there are two date fields, Effective Date and Termination Date, which can be used to indicate that the patient is still covered by insurance. If insurance coverage has expired the next field on the Charge dialog will indicate this in red. If coverage is within the set dates, or you aren’t using the Effective and Termination Dates, the field will read “Insurance coverage OK.”

Box 24B – POS is used to specify the place of service. The default is office; however, if you change it the new value becomes the default for all subsequent charges even between sessions.

Box 24C – TOS is used to specify the type of service. You can enter a value or select one from the drop down list. This box functions just like the Modifiers mentioned above. If you select a CPT procedure code that had a TOS defined with it then by default it will be loaded into this field. (As of early 2007, the new CMS 1500 form no longer requires or even has a place for the TOS field.)

Box 24G – Days/Units is used to denote how many services/days/units, minutes, fractions, miles were used. This value cannot be zero (0). The entire section we’re working in is shown below, with the Box 24G – Days/Units outlined in red. If you make a change here, you will notice that the Amount fields will change accordingly. By default the value will be one. Fractional values are supported. In any case there are only 3-digits available on the claims form so the limit for units is either 999 or 9.9. If it is desired NOT to multiply the procedure fee by the units then enter the value as a negative number. The negative value will suppress the multiplication BUT a positive number will print on the claims and statements.
Box 31 – Doctor identifies the physician performing the service for the procedure.

Box 20 – Outside Lab Fees allows you enter the amount that was charged by an outside lab (e.g. for x-rays, blood tests, etc.).

Box 32 – Facility allows you to select the facility “if the services were furnished in a hospital, clinic, laboratory, or facility other than the patient's home or physician's office.” Select the facility from the drop-down list. Click Folders-> Hospitals-> New Hospital to add new facilities to the list. Note: Some insurance carriers now require that your office/doctor name and address appear in Box 32 for office visits. If this is the case, simply add your office or doctor’s name and address to the Hospitals folder and select it from the Box 32 – Facility list when entering charges. The program will remember the last facility selected.

Box 24H – EPSDT/Family Plan allows you to select from a drop down list or enter any value that is appropriate for this field.

Box 17 – UPIN allows you to specify that the doctor’s UPIN should be entered into Box 17 of the HCFA 1500 form. An alternative method, and probably better, would be to enter the doctor as a referral and specify the doctor as the referring physician in the patient’s account. The Box 17 – UPIN setting, if checked, will override the referral source settings.

Box 23 – CLIA allows you specify that the CLIA number will be used for Box 23. See Prior Authorization above for more details. This number can be set in Options for quicker entry.

Box 24I – Emergency, if checked, will place a “Y” in the Box 24I column of the HCFA 1500 form for this charge; otherwise it is left blank. (As of early 2007 this field has been relocated to box 24C where TOS used to be located.)
After you have entered all of the data, press Ctrl+S or click the Save button and the charge will be added to the patient’s transactions.

Several of the parameters on the charge tab can be defaulted or controlled using the Tools- >Options dialog. This dialog and the options are discussed in detail elsewhere in this manual.

When using keyboard navigation use the F4 key to activate drop down lists. Use the ESC escape to cancel any displayed drop down list or the current dialog. When navigating on a grid you can use Ctrl+G to toggle the TAB key to navigate through the cells of the grid or to focus on the next dialog item. Ctrl+ENTER will select an item from a grid just like a double click. The Windows Context key (to the right of the spacebar, usually three keys, to the immediate left of the right Ctrl key) functions as the right click menu.
**Editing A Charge**

If you need to edit a charge then simply open the *Existing Charges* category and use the *Edit Charge* to select the charge you wish to edit. It will display the charge transaction number. Check the *Edit Selected Charge* field if you wish to edit the charge. If you intend to make a new charge using this charge as the template, leave the *Edit Selected Charge* field unchecked. After you select the charge you should first make sure that the CPT code is properly selected. Since the code can appear in the list multiple times the one you intend to use may not be the one selected. After you have done this, edit any of the charge fields as you need and use Ctrl+S to save or update the charge.

You may find when editing a charge that you get this dialog to pop up:

![Patient dialog]

The charge amounts do not equal the fee.

This is because your Charge Amount and estimated fees due do not add up correctly. Check these fields carefully to make sure your math is ok (it’s like balancing a checkbook).

Also in the *Existing Charges* section is the *Copy Charge* option. This allows you to select a charge from the *Copy Charge* drop down list and create a new charge using the same data. The new charge will have a new transaction number.
Chapter 12 – Making Payments

This has got to be the best part about business – getting paid! I think just about everybody would agree with that simple statement. Well, we certainly don’t want to make it a chore to enter payments. Below you see the Payment screen.

There are two basic sections to this dialog. The top grid is the payment grid. The first row of the top grid is the data entry area. The area of the top grid immediately below the data entry row contains any payments that haven’t been fully applied to charges or debits.

The bottom grid shows charges to which you can apply payments. Only open transactions are shown in this grid UNLESS the Include Closed Charges option is enabled. Checking the Include Closed Charges is handy when charges that have already been closed must be adjusted (almost always due to insurance changing their fees).

The payment grid always has the default focus set to the Amount field as shown above (it’s the white box on the first row). You can start typing the payment amount immediately. The fields to the left of the Amount field are the TR # and the Date. The TR # is the transaction number and it is automatically assigned by the program. The Date field by default starts on today’s date with each MedLook session. If you change the Date field it will stay at the value you set it until you change it again or restart MedLook. This allows you to enter a bunch of payments prior to today without having to continually change that field.
The next field is a narrow field with an icon in the column header. This field activates the X-Charge Credit Processing dialog. If X-Charge is not installed it will bring up a dialog telling you that it is not installed and how to hide the column (using the right click menu). If X-Charge is installed the credit card processing dialog will appear pre-filled with the patient information and the amount. Whether paying with a credit card to be swiped or by manually entering the credit card information this is a great option. See www.medlookx.com for more details regarding this service or give us a call.

Obviously the Applied amount only pertains to payments that have already been entered, so skip that field (use the TAB key) and move along to the Source of Payment. In this field you select the Payer. Here’s an example of what the drop down list looks like.

```
Source of Payment
1 Medicare
2 Blue Cross Blue Shield
Patient
Other
Write-off
Credit
```

The patient’s insurance carriers will be listed by name, primary first, then secondary, etc. A quick way to use this from the keyboard is by using the first letter (or number) of the payer you want to select. Selecting “P” would select Patient, selecting “O” would select Other, and so on.

The Method of Payment allows you to specify how you received payment whether it was check, cash, or credit card. There is a fourth option that appears called No Payment but you should not select it as it is required by the program only in peculiar circumstances such as entering a zero amount payment.

The Doctor defaults to the patient’s responsible physician but you can change it using the drop down. Again, you can open the drop down using F4, or select by the doctor’s first initial, etc.

The last field is the Comment field. You can enter any comment you want here (up to a certain length) or select one from the drop down list. The drop down list is created using the Payment Comments as found in the Helpers folders.

After you have entered all of your payment information you must press ENTER for the payment to be loaded into the system. The grid will be immediately updated and your focus will be returned to the Amount field allowing you to enter another payment. The payment you just entered will appear in the grid below as determined by the sort order you have defined for the grid. Normally you should sort by TR # so your new entry will appear at the top for visual confirmation.

At this point we have entered the payment into the patient’s account but we have not assigned it to any charge. This is something that should be done right away. It only takes
a few seconds. To make an assignment select the payment in the top grid and the charge you want to assign the payment to in the bottom grid. Notice the colored buttons on the charge grid.

These buttons are used to quickly apply payments to charges and, depending on which one is selected, deal with any remaining charge balance. Let’s look at each of these buttons in turn, but first, the gray button. The gray button is the Undo, (or Reset) button. Once you’ve begun entering data you can reset back to the starting point as long as you haven’t clicked the Save button. Once you’ve clicked the Save button the Reset button won’t work.

The Yellow Payment (P) Button applies the amount of the charge, or the part of the charge amount you enter in the Payment column, to the charge. The payment will be deducted first from the matching source of payment and then from whatever else is left having a balance. For instance, if the payment is from insurance then the amount is first deducted from Ins1 (i.e. primary insurance) and then, if the amount of the payment exceeds the expected insurance payment it will be deducted from one of the other expected payors as appropriate (not to exceed the total expected). Take a look at the following image of a grid row. Note that the numbers on the left side (Amount, Applied, and Balance) don’t change until you click the Save button.

Here, we’ve entered a $75.00 primary insurance payment and applied it to a $100.00 charge by clicking the Yellow Payment Button. Note the numbers outlined in red. The Payment column shows the amount of the payment, and the remaining balances in Ins1 ($5.00), and Patient ($20.00) remain. At this point we are ready to click the Save button and enter this payment’s application information into the system. Once finished, we could apply more payments (e.g. $20.00 from the patient), or enter write-offs to close the charge if necessary. Any write-offs would be entered using the same procedure as payments; only the Source of Payment will be Write-off (or Credit for error correction).

The Yellow Payment (P) Button is the simplest way to apply a payment. You would use this button if you know that you won’t be entering any write-offs or credits. When entering insurance payments it could be that you’ll regularly have to enter a write-off for the remaining balance of the insurance amount due (Ins1, or Ins2), and you may even have to write off the patient amount at the same time as well. MedLook provides an easy way to do both. Let’s look at another grid row.

On this charge, we’ve entered the $75.00 payment and applied it to the charge by clicking the Green Write-off (W) Button. In the Payment column we have our $75.00, but in Ins1,
Ins2, Patient, and Other everything is $0.00, which means that we don’t expect any more payments from these sources. Of course, we can’t just let the remaining $25.00 sit there. If things don’t balance MedLook won’t allow you to save the payment application. But, in this case, MedLook has taken care of it for us. The remaining $25.00 is in the Write-Off column. When you click the Save button a new write-off transaction will be created and automatically applied to the same charge to which you’ve just applied a payment.

Clicking the Blue Insurance (I) Button acts almost the same way as clicking the the Green Write-Off (W) Button, but only acts on the insurance sources when creating the write-off. In the following image the remaining $5.00 insurance amount has been written off, but the amount due from the patient is left untouched.

Clicking the Red Right Arrow Button moves the transaction balance from left to right through the payor list. In the grid above if this button were clicked (at the moment it’s hidden in the graphic) the $20 in the patient field and the $5 in the write-off field would be move $25 to Ins1, then continually to the right with each click and eventually back around to Ins1.

Clicking on the Yellow Yield Button unconditionally unassigns any and all payments from the charge. This is EXTREMELY helpful when adjusting claims where the patient has already paid and then insurance overpays. For instance, if a $100 procedure has a $30 patient co-pay at the time of the visit and a short time later insurance pays $85 (instead of the expected $70) then we need to unassign the patient payment. Simply click the Yellow Yield Button and the $30 is unassigned, the patient payment will reappear in the top grid with nothing applied, and the procedure will be listed as $100 with nothing applied. Next enter the $85 insurance payment, click on the P button to make the payment of $85, and Save the assignment. This leaves $15 due from the patient. Select the $30 co-pay on the top grid and click on the P in the bottom grid for the same $100 charge. $15 will be applied. Save the result. The procedure is now paid in full ($85 from insurance and $15 from the patient) and disappears from the lower grid. The top grid now shows the $30 patient co-pay with $15 applied and $15 remaining. At this point the patient can be refunded the $15 and the account debited to reflect the refund (BTW, the credit card processing works with refunds too!) or the $15 can remain in the account until the patient returns and the payment applied to the next visit.

Once you’ve entered the payment data and clicked one of the application buttons, the Applied and Balance columns will change to reflect the amount applied. The amounts in the columns reflecting amounts due will be locked in. The following image shows our charge after using the Blue Insurance (I) Button to apply the $75.00 payment. The Ins1 amount is now $0.00. A $5.00 write-off has been applied, and the $20.00 Patient amount remains due from the patient.
Here’s the charge as shown on the *Transaction Grid* with *Show Preview Lines* enabled.

<table>
<thead>
<tr>
<th>Date</th>
<th>Amount</th>
<th>Applied</th>
<th>Balance</th>
<th>Payment</th>
<th>Ins1</th>
<th>Ins2</th>
<th>Patient</th>
<th>Other</th>
<th>Write-Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>03/22/2005</td>
<td>$120.00</td>
<td>$100.00</td>
<td>$20.00</td>
<td>$80.00</td>
<td>$0.00</td>
<td>$0.00</td>
<td>$20.00</td>
<td>$0.00</td>
<td>$0.00</td>
</tr>
</tbody>
</table>

The charge amount is $100.00, with $80.00 applied, leaving $20.00 due from the patient. The $80.00 applied amount consists of a $75.00 insurance payment and a $5.00 write-off. We applied the payment and created the write-off in one step by clicking the *Blue Insurance (I)* Button.

After a payment has been assigned in full it will no longer appear in the payment grid. Only payments that have something yet to be applied will appear in this grid. The charges will not appear in the charges grid once they have been paid in full. Your goal is to have as few charges shown as possible because that means you’re being paid!

You can edit the payment in the top grid if you inadvertently entered something wrong. You are allowed to edit the same fields you can edit when loading a new payment. You cannot alter the *Source of Payment* once the payment has been applied to a charge. Of course, you cannot set the *Amount* to something less than that already applied either.

You can delete payments from the payment (top) grid but only if they have not been accepted on a *Daily Ledger Report* and have not been applied to any charge(s). You can also delete open charges from the charge (bottom) grid but only if they have not been posted and have not had any payments assigned. You can edit and delete (non-posted) payments and charges using the *Transaction* tab, even those with associated transactions (charges or payments).

There are just a couple more things to note regarding payments. First, the *Unassigned Payment* box. This box always shows the remaining amount of a payment that can be applied to charges. This is useful if, for example, you’re entering a lump sum payment from an insurance carrier and applying it to multiple charges. And, speaking of applying payments to multiple charges, that brings us to the *Max Payment per Line Item* box. Let’s say you have a $1000.00 insurance payment that will be applied to ten different charges at $100.00 per charge. Enter $100.00 in the *Max Payment per Line Item* box and click the *Yellow Payment (P)* Button on each charge row. Once you’ve clicked each charge, click the *Save* button and you’re finished. You’ve applied a large payment to ten different charges in just a couple of seconds.

There’s a lot of information about payments in the help file. When you have the *Payment* dialog open, press the F1 key and the associated Help information will be presented. Here you’ll find descriptions, explanations, and links to examples and tutorials.
Chapter 13 – Individual Billing

Patient Billing

Normally you will provide the patient with a bill before they leave the office. Below is the Billing dialog within the patient’s account.

There are two basic types of bills: The Patient Bill and the Insurance Claim. First we’ll look at the Patient Bill. The above image shows the Billing dialog with the Billing Type set to Patient. On the left side of the dialog is a list of options/filters for the bills. On the right is the charge grid and the buttons that let us quickly select all or no charges, and to display or print the bill.

There are a number of optional print items for the Bill as shown and most are self-explanatory. The Bill Message option will print any standard message as defined for the payment period (see Tools->Bill Messages for more details on this) or a unique message if entered in the patient’s account (see Edit::Billing::Print Message on Bill).
individual message takes precedence. If you use the standard messages then you should define messages for all the aging and payment categories.

The first check box on the list of options is Set Bill Date. Checking this box will cause MedLook to update the Last Bill Date field for the patient. This date is used in various places, such as reports, and as a filtering option in Patient Batch Billing. The Last Bill Date is also shown on the Summary dialog of the Patient Account.

The next four options determine the type of patient bill that will print. The Line Items and Payments and Line Items Only options will create a plain-paper bill (as shown below). A Line Items and Payments bill will show the selected charges and payments that are applied to them. A Line Items Only bill will show only the selected charges.

Payments Only will give you a list of payments. Note that when you select this option you are presented with two date selectors. Payments don’t appear on the charge grid. Set the start and end dates, and MedLook will include on the bill any payments in that date range.

Selecting Transactions Ordered By Date will allow you to set a starting date and produce a bill that lists all the transactions since that date. This is essentially the same as a batch bill. This being the case, you can select Use Preprinted Format and print the bill on an actual batch form. Checking this box will give you three more options. The first, Form is Preprinted lets you use preprinted forms that MedLook will fill in. If you leave this unchecked MedLook will not only fill in the data, but will create the headings, graphics, shading, etc.

The next two options Exclude Closed Charges and Include All Open Charges let you fine tune how the bill will print. Select Exclude Closed Charges and any fully paid charges will not be included on the bill. Select Include All Open Charges and any open charge will be included on the bill regardless of the start date.

Note that when using Payments Only or Transactions Ordered By Date transactions are selected by the starting date or date ranges entered and not by selecting the charges from the grid. When either of these options is selected the charge grid is disabled.

Ignore Balance Forward should rarely be used. However, there are some cases where this may be handy. It applies to each type of patient bill (i.e. Line Items & Payments, etc.). Checking this box simply directs MedLook to forgo any balance forward calculation and display financial information only for the selected items. Again, this should rarely be used because you will almost always want to collect any outstanding amounts due from the patient.

Most of the options in the Items to Include list are pretty straightforward. If you want the item to print on the bill, check the box. Leave the box unchecked to prevent the item from printing. However, a few of the items may not be clear. Let’s take a look at those items.
Charge Receipts. Only effective when using the Transactions Ordered By Date option along with the Use Preprinted Format option. Using the batch bill form with this box unchecked will cause the transactions to be printed in chronological order. With Charge Receipts checked the transactions will print in chronological order, but the amount applied to charges will print in the Receipts column next to the charges.

Comments. This is the Comment field you can fill in for any transaction. Checking this box will cause any comment applied to a transaction to print along side the description field.

Insurance and Patient Due and Totals Boxes. Both of these check boxes affect the preprinted bill format. The Totals Boxes contain the sums of the bill’s Charges and Receipts columns. The Insurance and Patient Due check box contains the breakdown of the total amount due between patient and insurance. If the check boxes are checked the items will print. Left unchecked, only the Total Amount Due box will print.

Layout. A Layout is a file that defines many of the printing attributes for patient billing that uses the Transactions Ordered by Date and the Preprinted Format (it doesn’t apply to any of the other patient bills – this is basically the batch formatted bill style). The file is typically found in the database folder and is usually named BillingFormats.xml. Of course, the filename is inconsequential – the contents are what really matters. The layout data is stored in a well-defined, very common, structured file with the XML extension. The important thing for patient billing is that the file be of the same format as found in:

<Program files\Rem Systems\MedLook\Template\BillingFormats.xml>

There are two primary sections in the file:

PreprintedPatientBill and BlankPaperPatientBill.

The information in the PreprintedPatientBill applies to stationary that is preprinted with boxes, letterhead, etc. The BlankPaperPatientBill naturally applies to bills that are printed straight to blank paper.

Edit Layout. The Edit Layout command will invoke the layout editor so that the print format can be changed.

Some things worth noting include the Top and Left properties of each section. You can set these to less than 0 if necessary. However, it would be better to change the Page/Margins fields instead. By default the margins are all 0.50 inches which is pretty typical. Changing the margins will affect the entire document just as it would in Word or on a typewriter.

For most fields there are two related items. For instance, PatientNum and TitlePatientNum. PatientNum is where the actual patient number will print. The TitlePatientNum is the shaded box containing the similar title.

In addition to having the typical Top, Left, Width, and Visible fields patient bills also have Height, Title, Bold, Italic, Underline, FontName, and FontSize. Height is similar to
width and will rarely if ever be changed. Bold, Italic, and Underline are all booleans (0 is false, 1 is true). These give basic formatting features. FontName and FontSize are similar to what you'd find in Microsoft Word giving additional flexibility to every field. Title may be of more interest to some more than others. For instance, there have been requests to change the text in the "Payment Due Now" field. This can now be done easily. Simply select the proper section and TitlePaymentDue. Select the Title field and change the value from Payment Due Now to whatever you would prefer it to print.

Most of the items are named in such a way that with just a minimum of tinkering you can figure out what you're changing. Always keep a backup of your latest layout.

*Edit Header.* This opens the bill letterhead template and allows you to make any changes you wish to the name and address of the doctor or other provider that prints on the bill. There are two different headers, one for the batch style bill and one for the walk-out slips (either of the Line Items or Payments Only options plus the "unformatted" bill ordered by date).

*Edit Appointment Box.* This command will again invoke an editor allowing the appointment box region of the bill to be edited. This box can be modified to print anything or nothing at all.

*Edit Payment Options.* This command also opens an editor allowing for the payment options area to be edited (for credit card and check processing options). Like the Appointment Box this box can be edited to contain virtually anything, or nothing at all.

The *Edit Layout, Edit Appointment Box,* and *Edit Payment Options* are all specific to only the formatted style bill.

After you select the options you want to print, you can select the charges you want to include on the bill. You can select them all, some of them, or only one. Before you send the bill to the printer you should use the *Display* command to preview the bill. If the information is not what you need or expected, make any changes necessary and try again. If using *Transactions Ordered By Date* then it is not possible to select the charges as they are automatically selected by the date range provided in the options.
Some samples of the various types of bills that can be generated will be shown here for completeness sake.

Here’s a sample *Line Items & Payments* bill.
Before you print or display a bill be sure to set the Set Bill Date box if you want to update the patient’s last billing date. If you actually are sending the bill (i.e. not just previewing) you should check this box. This allows you to know what charges you have and have not billed to the patient. Of course, you can always come back, select the charge again, and re-bill.
Insurance Billing

You can create a printed HCFA 1500 form for postal mailing or a file for electronic filing. Before creating the bill you have to select the charges. Under the Filters option you can set the type of charge you want to process. All, Unsubmitted, Submitted, or Submitted Pending (submitted but not paid yet). Typically you would want to select Unsubmitted to list claims you have not yet submitted for payment. The other options are used when you need to re-submit a claim. The Carrier option limits the list of carriers shown in the Payor drop down. The possible options are All, Primary, and Secondary+ (Secondary, Tertiary, and Quaternary if entered for the patient).

Below is a snapshot of the dialog.

The HCFA Options are used to configure the claim for your electronic carrier (clearinghouse) or, more commonly, for your printer. These options are discussed in detail in a later chapter concerning the HCFA 1500 form. However, it should be noted that changing the layout file allows you to easily support different printers as well as the old and new CMS 1500 formats.

Check the Set Submission Date box if the claims are going to be submitted to insurance for payment. If you are only viewing/printing claims to check data, or to test electronic submission, you’ll probably want to leave the Set Submission Date box unchecked.

To create a claim, select the charge or charges from the grid and use View/eClaims to preview the claim or create the electronic file or select Print to complete the HCFA 1500 paper claim. You should use View/eClaims even for paper claims to be sure the fields are filled out correctly. The next snapshot shows the claim ready for further processing.
The Insurance Claim Preview dialog is divided into several sections. The main form section shows you the form and the data that will print on it. Be sure to turn off the form background by clicking the HCFA button if you are going to print the claims on preprinted HCFA 1500 forms. MedLook will print the entire form, including lines, but you’ll want to be sure your carriers will accept it before submitting.

The Claims box on the left side of the dialog is a Table of Contents. If there are multiple pages involved, you can click on one to instantly move to that page.

The open space at the bottom of the claim will show you any ICD9 or CPT codes on the claim that have been marked as invalid. A code marked as invalid is used for internal/office use only and not intended to be submitted to insurance for payment.

If you are generating a file for electronic submission use the Save command to specify the file where you want to store the claims. You can specify the default file to save your claims in with HCFA Options -> Edit Layout. As the file may already exist from earlier processing with other patients you are given the option of overwriting the existing file, merge into the existing file, save the claim(s) in a file with a different name, or canceling the operation completely. If you are starting anew, you should use Replace Existing File; if you are adding use Merge Changes into Existing File (Append).
If you select to *Print* a paper claim you will be presented with a standard printer dialog allowing you to specify the printer. Make sure you have exclusive access to the printer during this time and have the HCFA 1500 forms loaded. You can print from the *Insurance Claim Viewer* or by clicking the *Print* button on the *Insurance* dialog. For printing it is highly recommended to use the *Print* button as it will use the Printer layout and not the electronic layout.

The *New!* Button toggles to display the new CMS 1500 (NPI) form. It does not affect the data in any manner, only the graphic backdrop.
Chapter 14 – Notes

MedLook provides a really nice solution to patient notes that is extremely flexible. Patient notes are actually stored in rich text file (RTF) format. This means your notes can contain virtually any information your word processor can support and you can use your favorite word processor as well. Of course, MedLook has a limited built-in word processor as shown below.

Notice that the notes have the basic patient information at the top of the notes section. It also has its own toolbar with some standard word processor commands. Since these are so common across applications we will not discuss them here.

There is one built-in macro, Ctrl+D, to insert the date at the cursor location using the format mm/dd/yyyy (e.g. 02/25/2004).

RTF files support graphics (linked or embedded), audio, movie, and other objects or files. This means you can include any digital imagery you have for the patient. This includes a picture of the patient, scans of insurance cards or x-rays, and much more. You can store the doctor’s dictation, an EKG, anything you can convert to a computer readable format.

By default MedLook looks for two word processors you may have on your system: WordPad and MSWord. If you have MSWord, that becomes your default editor; otherwise WordPad; otherwise MedLook. The Notes editor can be specified using Tools->Options->Patient Account Defaults::Notes Editor.

If you use a powerful word processor such as MSWord, you can even create a book for your patient (logging everything you know about them), use and develop your own macros, and much, more.
If you choose to edit with something other than MedLook the dialog will appear as follows:

In this case, we chose WordPad and it displays with the notes as shown here.
Chapter 15 – Transactions

The Transactions tab contains all of the transactions contained within the patient’s account. This includes all payments, charges, credits, debits, interest calculations, etc. Below is a snapshot of the Transactions tab with one charge selected and the associated payment displayed in the bottom grid.

The Transaction Display

The dialog contains two drop down list and two grids. The first drop down list, Transaction Type, allows you to select what type of transactions to display in the primary (first) grid. The default, every time, is Show All. Below is a list of the options.

Show All
Show All
Credits Only
Debits Only
Payments Only
Charges Only

The Period drop down list contains the following options:

All
All
Current
Past

It always defaults to All. The options of Current and Past are in regards to patient batch billed transactions. All transactions are marked as past once they have been patient batch billed and updated.
The top grid lists the transactions as filtered by the two drop down lists. Many of the columns are easily understood by their column headings, but not all. Trx Date is the date the transaction was entered. The TR # is the assigned transaction number. Both of these fields are automatically assigned. Date is the date entered for the transaction whether it’s a payment or a charge. Thru Date applies only to charges as it relates to the HCFA 1500 Box 24 To Date. Type and Explanation describe the nature of the transaction and require more discussion.

If Type is “C” it’s a charge where Explanation is the procedure code. If Type is “P” it’s a payment where Explanation is Ins.1 (primary insurance), Ins.2 (secondary insurance), Patnt (patient), or Other. If Type is “X” then we have to look more closely at the Explanation.
  - If Explanation is Crtsy then it’s a write-off.
  - If Explanation is Credit then it’s a correction.
If Type is “D” it’s a Debit.

The Amount is the dollar value that was entered for the transaction. The Applied value is how much has been paid on a charge or a debit and how much has been assigned on a payment or credit (Crsy or Credit).

The Balance shows what remains to be applied for the transaction. For charges the balance should always be 0 or greater and for payments the value should be 0 or less (negative values are denoted using parentheses as in (5.00) for –5.00).

The Bal. Err. (balance error) shows any error in the balance. This value SHOULD be 0.00 or blank. If it is not then the monetary values do not add up correctly. In a few paragraphs we’ll discuss how you can fix this.

Ins1, Ins2, Patnt, and Other are estimated amounts due for charges; they are meaningless for non-charges. These values should be 0 or greater and their sum should total to the balance. These fields are directly generated when processing a charge and are related to the procedure fee, co-pay and deductible.

P1, P2, P3, and P4 are used to denote which items from Box 21 of the HCFA form will appear in Box 24E. For instance, if you have a charge with all four codes provided and P1 is set to 3, then the third code, or 3 will appear in Box 24E. If, in addition, P2 is set to 1 Box 24E will contain “3, 1”. Whether the actual code or the item number (1,2,3,4) appears in Box 24E is dependent upon the insurance carrier settings.
Like almost every other grid, this grid also has a right click menu as shown here.

<table>
<thead>
<tr>
<th>Show Preview Lines</th>
<th>Preview Print</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Fields...</td>
<td>Sort...</td>
</tr>
<tr>
<td>Sort...</td>
<td>Group By...</td>
</tr>
<tr>
<td>Group By...</td>
<td>Format View...</td>
</tr>
<tr>
<td>Format View...</td>
<td>Expand/Collapse Groups</td>
</tr>
<tr>
<td>Expand/Collapse Groups</td>
<td>Restore Default Layout</td>
</tr>
<tr>
<td>Delete Record</td>
<td>Delete Assignments</td>
</tr>
</tbody>
</table>

The first two items on this grid need just a little explanation. *Show Preview Lines* is used to show related transactions. Here’s a simple example.

```
02/12/2004   100346  02/12/2004   ×   $20.00  $20.00  $0.00  Crtsy
Chrg:       TrNum    Amount    Explanation
100345      20.00     90050     
```

In this case, we have selected a write-off (Crtsy) with TrNum 100346. The charge that the write-off was assigned to is shown as TrNum 100345 in the same row. Of course the charge will also appear in the bottom grid as well.

The *Preview Print* does exactly the same thing as the *Printer* command on the toolbar. Only those transactions selected will print (and at least one must be selected).

**Editing Transactions**

There are times when you may need to directly edit a patient’s transactions. To modify or edit a transaction you must first set the *Tools->Options->Patient Account Defaults::Allow Patient Transaction Edits* to “yes”. After doing this, the fields that are available for editing include: *Amount, Applied, Ins1, Ins2, Patnt, Other, Comment, P1, P2, P3, P4, and Prior Auth*. Even if edits are not enabled you can still delete records.

The simplest form of an edit is deletion. You might use this if you entered a charge or payment into the wrong account (hey, it can happen). To delete a transaction you just select it and delete it by pressing the DELETE key or using the right click menu and selecting *Delete Record*. If you do not have the edits enabled, then you can select the record anywhere on the row. However, if you are in edit mode, then you must select the record along the left-most edge where the widgets appear as shown here:

```
10/01/1992  C  $65.00  $65.00  $0.00  ($25.00)  90060
```

The column immediately to the left of the date must be selected. This doesn’t seem to make sense at first but consider how the edit functions work. If you are editing the amount and you really need to change the value from 165.00 to 65.00 you would naturally position the cursor before the “1” and select DELETE. So to edit you have to use the DELETE key as well for each grid cell and to use it on the entire record you must select the widget.
To modify one of the fields already mentioned you just poke the grid cell you wish to edit and change the value accordingly. The program will warn you if you try do something you probably shouldn’t (like set the Amount field to be less than the Applied field) but still you should use care when making any changes, particularly to the P1-4 fields.

You should avoid using this method of editing transactions as much as possible. Mostly it should be used to delete extraneous transactions or for adjusting the Ins1, Ins2, Patnt, Other estimate fields. To edit a charge, you really should use the Charge tab.

Deleting assignments is another form of transaction editing. If a charge or payment is applied in full then it will not appear on the payment dialog and therefore the only way to delete any assignment is on the Transaction tab (in a later version of MedLook even closed procedures will be allowed on the Payment dialog to eliminate this cumbersome solution). This is occasionally necessary when insurance overpays, etc., causing the payment trail to really get confusing. In any case, the charge or payment can be selected and with the right click Delete Assignments option all assignments (or part) can be removed. Likewise, selecting a charge on the top grid will result with the assigned payments appearing on the bottom grid. The individual transactions on the bottom grid can be selected and deleted/unassigned. Deleting on the bottom grid DOES NOT delete the payment or charge, only the assignment. Even posted transactions can be unassigned for later re-assignment.
A Patient Transaction Report

The following two snapshots illustrate the type of report you can generate from the Transactions tab. Note that this report is two pages but the second page is really the right-most half of the report (the header is repeated on every page). The report appears exactly as defined by the transaction grid. You can reduce the number of fields shown and make the columns narrower to get the information on a single page (in width).
Section 4 – Batch Billing

What’s a batch? In our terms, a batch is a group or multiple set. In an earlier section we discussed the patient account and learned how to produce individual patient and insurance bills. Batch billing allows you to produce a mass of bills at one time. Many offices still produce patient bills once a month, usually at the end of the month. Others produce bills weekly. In either case, it is easier to produce an organized group of bills to be processed all at one time rather than one at a time (where it is likely to be misplaced and lost – being a financial loss to the office).

In the same manner, insurance claims can be processed in batch and are most often processed at the same time as patient batch bills. There are some differences though, especially with electronic billing. With electronic billing insurance claims can be processed as frequently as you wish giving you a quicker return on your efforts (i.e. you can bill daily!).

Chapter 16 – Insurance Billing

Be sure to read the important note at the end of this chapter regarding processing Electronic Claims (Send to File).
Let’s take a look at the Batch Insurance Billing dialog, pictured below.
The Insurance Billing dialog is divided into several sections that give you numerous options for setting up, processing, and checking your claims.

The options in the main section include the Sort By and Set Submission Date. Sort By allows you to sort your claims by Patient Account Number, Patient Last Name, or Insurance Carrier Name.

The Set Submission Date option, if checked, will set each charge’s submission date to the current system date and will assume that they have been submitted to their respective insurance carriers. If you check the Unsubmitted Charges Only box the next time you process Batch Insurance Claims these charges will not be included in the process.

Next we’ll cover the Filters section. There are four check boxes to consider in this section. The first, Unsubmitted Charges Only, should probably be checked in most cases. Checking this box will cause MedLook to print claims only for charges that haven’t been submitted to carriers. What does “submitted to carriers” mean in MedLook? If the Set Submission Date box is checked, MedLook sets the submission dates and those charges are considered “submitted” to insurance.

So, what happens if you leave the Unsubmitted Charges Only box unchecked? First, the Use Date option will be used for further filtering by date. Typically the dates are filtered by DOS (date of service). However, sometimes it is necessary and more useable to filter by DOE (date of entry). The two options therefore are Use Date Of Service and Use Date Of Entry.

The two date selectors also become enabled. You can then use the Start Date and End Date selectors to set a date range. All charges within that date range for which the patients have insurance coverage will be processed even if they have been submitted previously. This, along with the Reprint Batches option described below, gives you a tremendous amount of flexibility if it becomes necessary to resubmit any insurance claims. Also note that you can print a HCFA 1500 claim for any charge in the patient’s account at any time, assuming the patient has insurance coverage, of course.

The Include Charges “Left Off Form” will cause the batch processing to ignore the “Left Off Form” flag on any charges. This is sometimes necessary, but not often.

The next three check boxes, Paper Claims (Send to Printer), Electronic Claims (Send to File), and Line Item Report let you select the type of claim to process, and in the case of Line Item Report, whether to create a list of charges at the end of the batch process. Both types of claims, Paper Claims and Electronic Claims can be processed at the same time.

If the Paper Claims (Send to Printer) box is checked, any claims for insurance carriers with Batch Mode set to Send to Printer will print (honoring all other conditions of course). You will be presented with the standard Windows printer dialog where you can select a printer if you don’t want to use the default.
If the *Electronic Claims (Send to File)* is checked, any claims for insurance carriers with Batch Mode set to *Send to File* are written to a file on your hard drive. The file is set up in *HCFA Options* and in the Insurance Carrier. MedLook allows up to three different file names for *Print to File* names. This allows you to send claims to different clearinghouses if necessary. In most cases the default name is all you’ll need.

The *Line Item Report*, as stated above, if checked will create a report of all charges submitted during the current batch process. You will be prompted to display or print the report after claims have finished processing.

The *Send Claims* option will allow the *Electronic Claims (Send to File)* and *Paper Claims (Send to Printer)* options to be ignored, sending all claims to one or the other. The *Patient Status* list lets you process claims for *All, Active, or Inactive* patients. If any other status has been defined it can be used here as well. Some uses of this might include “collections.” If you move a patient to “collections” by changing their status to collections, they would be excluded from batch billing in all cases EXCEPT when the status is *ANY* or “collections.”

*Advanced Filters* – There are a few options to filter with on the billing dialog but, to most of the filter options will be through the filters dialog.

The *HCFA Options* section contains numerous claim options and layout features that can be applied to either electronic or paper claims. The buttons in the *HCFA Options* section are also located in the patient’s account on the *Billing* tab. These options are discussed in detail elsewhere.

The *Reprints* section allows you to save and reprint specific batches. If checked, the *Save Batch for Reprint* will save the current batch process. You can later recall and print a saved batch by checking the *Reprint From Batch* box. This will enable the *Batch Dates* drop down list. This list will include all saved batches by date. Select the desired date to process an exact copy of that batch.

Use the *(DOL) Purge* and *Purge Reprints* button to delete old reprint files. Enter a date in the *(DOL) Purge* field, and click the *Purge Reprints* button. This will delete any reprint files for the date you entered and earlier. This will save space on your hard drive, and make your backup files smaller.
The View Existing Claim Files area is used to view and verify your Print to File claims after they’ve been processed. Each file is listed by File 1, File 2, File 3 and their respective paths and file names. To view the default claims, click the File 1: Filename button. Note that the Claim Viewer will open automatically when you process Print to File claims. The View Existing Claim Files buttons are used to view the latest claim files with or without processing. Note also that some clearinghouses, including LTC, may delete a claim file after it is transmitted, causing the file to be listed as not found when trying to view it.

When you’ve set the Batch Insurance Billing selections to your liking, click the Process button. Insurance claims will be processed according to your selections. If Paper Claims (Send to Printer) is selected you will be presented with a printer dialog in order to choose a printer. Click the Print button to continue. Note that clicking the Cancel button here will cancel all claim processing, not just Paper Claims (Send to Printer) claims. If Electronic Claims (Send to File) is checked the Claim Viewer will display all of your claims. Click the Save button on the Claim Viewer to save the claims to a file. The Claim Viewer is described in more detail in Chapter 13 – Individual Billing, in the Insurance Billing section.

Important! You MUST save the claim file by clicking the Save button, or the current claims will not be written to the file you will transmit. If you do NOT save, then you will either transmit an old file, or the file will not exist (depending on what the clearinghouse does with it after transmission). The claims are NOT automatically saved to file. Below is a screen shot of the Claims Viewer.
Chapter 17 – Patient Billing

*Patient Batch Billing* is usually performed once each month, but can be done as often as necessary.

The *Patient Batch Billing* dialog pictured above gives you many options that allow you to customize the output of your patient bills. We’ll take a look at each section starting with *Patient Billing Options*.

In the *Sorting Order* drop down you can select to sort your bills by the doctor and patient’s account number or doctor and last name, or you can sort by account number or last name without dividing things up by provider.

Next is the *Set Bill Date* check box. This is similar to the *Set Submission Date* discussed earlier in the *Insurance Billing* section. Each patient has a “date last billed” field. If the
Set Bill Date box is checked this field will be set to the current system date once bills have finished processing.

The Begin Itemizing On date lets you choose the date to itemize each account. Any transactions prior to the date entered will be listed as a balance forward. If left blank all transactions for each account (based on other filters) will be placed on the bills.

The Date on Bill, is the “print date” that is placed at the top of the bill form next to the patient’s account number. You may change this date to reflect any billing date you wish. By default, the current date is selected.

Exclude Closed Charges, if checked, will prevent any closed charges (Amount equal Applied) from printing on the bills.

Checking Include All Open Charges check box will cause any open charges (i.e. accounts where Amount – Applied is not 0) to display on the bills regardless of how you set the Begin Itemizing On date.

Checking Form is Preprinted means that you are using bill forms that you’ve purchased from a printing company. If this is the case and you print bills for multiple providers you’ll probably want to check the next box as well; Pause Printing Between Doctors. Checking this box will cause MedLook to pause between different doctors in a multi-doctor system, allowing you to change the bill paper. If you leave the Form is Preprinted unchecked MedLook will create the bill form and fill it out for you using plain paper.

The next item in the main section is the Add Interest check box and date. The date is informational and shows the last time you applied interest. If you check the Add Interest box an interest debit will be applied to each patient account and bill according to the settings in the account and in Options.

The next section contains check boxes for Items to Include. This means that if checked, each item will be included on the bills. The way this works is pretty straightforward. Check the Aging Balance box and each patient’s aging balance line will print on the bills. Only a few of these items really need explanation. Checking Charge Receipts will cause the amount applied to each charge to be printed in the Receipts column on the bill while payments are itemized chronologically. Checking the Totals Boxes (the default) will print the column totals on the bill. If for some reason you don’t want those boxes to print, just uncheck this box. If the ICD9 box is checked the primary ICD9 code for the last charge entered will print followed by all of the codes listed for the last charge in the order they appear in box 21 of the HCFA form. For example, if a patient has four codes: 036.0, 037.0, 007.1, and 055.0 and the third code is primary, you’ll see the following just above the transaction section of the bills: 007.1 (036.0, 037.0, 007.1, 055.0)

The Layout field points to a patient billing layout file (same type of file as an insurance layout but completely different in content). Normally this file is named BillingFormats.xml but it can be called anything. Likewise the file is normally found in the database folder such that a database backup will also include the layout file. If the
file becomes corrupt a default can be found in c:\Program Files\Rem Systems\MedLook\Template folder.

The Edit Layout button invokes the layout editor (see Tools->Options).

The Edit Header button lets you customize your office/doctor name and address (if you let MedLook print it). Clicking the Edit Header button will open the header template file in the program that handles rich text files on your computer (Ms Word, Wordpad, etc.). In the Help file (press F1) click on the index tab and enter “template” to view key words and definitions used when editing any of the custom templates in MedLook. Of course, this is unnecessary if you use preprinted forms.

Edit Appointment Box. This command will again invoke an editor allowing the appointment box region of the bill to be edited.

Edit Payment Options. This command also opens an editor allowing for the payment options area to be edited (for credit card and check processing options).

As noted in the Individual Billing either of the above boxes can be edited to contain virtually anything or nothing at all.

Next up is the Filters section. As with Insurance Billing, Filters give you a great deal of control over which accounts are included in the billing process.

First are the Account Due At Least and Patient Due At Least fields. These two options let you print bills based on a minimum balance. For example, if you don’t want closed accounts (total account balance = 0) to print, enter 1.00 in the Account Due At Least field. All patients with at least a $1.00 balance will be included in the bill process. If some accounts have balances that are completely due from insurance with no balance due from the patient, you may want to prevent them from being processed. Enter 1.00 in the Patient Due At Least field to make this happen. Leave this field 0.00 to include patients regardless of who is expected to pay the balance.

Auto Billing Turned Off allows you to override the patient’s automatic billing setting and print bills for all patients based on the other filter and option settings.

Selecting the New Transactions option will cause MedLook to print bills only for accounts with new transactions since the last time batch bills were printed. You can further tweak this option by checking the box directly beneath it. Checking the Include Patients Not Billed Since option and selecting a date allows you bill for new transactions only and include older accounts that haven’t been billed recently.

No Payments Since, allows you to select a date and print only bills with no payments since that date.
*Patient Status* let’s you choose a patient status setting to filter your bills. *Any* will include all patients, *Active* will only include active patient, and so on. The drop down list will contain all *Status* settings, including the options you’ve entered.

The sub-section *Exclude Accounts* contains one item: *With Insurance Due*. Checking this box will prevent accounts with any amount due from insurance from being processed.

The *SQL* drop down list in the *Advanced Filters* section works much the same as the identical option in *Batch Insurance* described earlier. Select an option and edit it to meet your requirements.

The *Reprints* section contains the *Save Batch for Reprint*, and *Reprint Batch* options, in addition to an option to clean up old reprint files. Checking the *Save Batch for Reprint* box will save the current set of batch bills to a PDF file. Checking the *Reprint Batch* box and selecting a date will open the reprints in the Adobe Acrobat Reader. You must have the Adobe Acrobat Reader Version 5.0 or greater to access this functionality. The reader is free and available at http://www.adobe.com/.

The *(DOL) Purge* and *Purge Reprints* button are used to delete old reprint files. Enter a date in the *(DOL) Purge* field, and click the *Purge Reprints* button. This will delete any reprint files for the date you entered and earlier. This will save space on your hard drive, and make your backup files smaller.

To process batch patient bills, make your selections and click either the *Display* or *Print* buttons at the top of the dialog. One of the most powerful features in MedLook is the ability to display the bills and reports. Once displayed, you can search, export, print ranges, and even print the entire set of bills.

The next page contains the output as produced by the *Patient Batch Billing* process.
Bill Barstow  
23 Spruce Street  
Anytown, UT 22222
The patient statements can also be exported to BillFlash format for processing very similar to that of a clearinghouse for claims. Once the statements are displayed select the Export menu as shown below and either set your BillFlash output Options or select BillFlash to save the claims:

The BillFlash Options brings up the following dialog:

These items are all pretty self-explanatory. The length of the Line 1 and Line 2 fields is not fixed. Text with a lot of wide characters, such as M, will print fewer characters than other text. Plan ahead and test your statements before going into full production.

Selecting BillFlash will result with the standard Save As dialog being displayed. By default the statements are saved in C:\Statements. Whatever you save the file as will be remembered for the next time. After exporting and saving your claims simply dismiss the display.
Section 5 – Reports

Reports and more reports. This section will focus on the many reports that MedLook is capable of producing. The section is broken into four separate chapters for each particular type of report. In each report, it is possible to generate completely different output by selecting different parameters. A lot of development effort has gone into the design of each report for content and appearance. Most of the reports have advanced coloring and shading which makes it easy to discern key fields. This is a great help when viewing the reports on a monitor but may be a concern when printing. The coloring and shading can be easily disabled using the Tools->Options->Misc. Options::Report Shading option.

Each report can be exported to a standard text file or to a more enriched file type such as PDF, HTML, Excel, or RTF. When viewing the reports you can use the search feature (see the binoculars), the table of contents (upper left icon), zoom in/out, single and multi-page display, change the ruler, and easily navigate between pages. The reports provide you the tools necessary to analyze your office finances and find out exactly what’s going.

Let’s start by looking at the report toolbar.

![Report Toolbar Image]

**Note:** Not every report will have a table of contents.

Most of the options need no additional explanation. The Copy option copies the current page of the report to the clipboard so you can paste it into another document. The Find option allows you to search your entire document for a particular phrase or word. The Ruler works very much like the ruler in most word processors (you probably won’t need to change it – ever). The Single-/Multi-Page options allow you to toggle between a single page or multiple page display. In addition to going backward and forwards a page at a time you can move directly to a page number by entering it in the key-in field.

You can cause all reports to open in the above Report Viewer by clicking on the Display button on the report dialog. From here you can perform all the functions described above. The Print option in the Report Viewer is particularly powerful. You can print single pages, or various page ranges.
Clicking the *Print* button on a report dialog will allow you to select a printer and then send the report directly to that printer. In MedLook it is always a good idea to *Display* all reports. You can always print them from the *Report Viewer* and the printed output from there is exactly the same as if you clicked the *Print* button on the report dialog.
Chapter 18 – Office Analysis

Percent Each Doctor

The Percent Each Doctor report is designed for multi-doctor practices, but can be used by anyone for a snapshot of cash flow. The settings shown below let you select a date range and output style for the report. Since this is one of the two aggregate reports it can be password protected. Go to Tools->Options->Passwords to set up passwords if desired.

Sample output.

<table>
<thead>
<tr>
<th>Amount &amp; Percent of Practice Totals</th>
<th>04/2000 - 08/2003</th>
</tr>
</thead>
<tbody>
<tr>
<td>For Doctor: JJJ</td>
<td></td>
</tr>
<tr>
<td>Billings</td>
<td>1,588.00</td>
</tr>
<tr>
<td>Payments</td>
<td>320.00</td>
</tr>
<tr>
<td>Credits</td>
<td>0.00</td>
</tr>
<tr>
<td>Debits</td>
<td>0.00</td>
</tr>
<tr>
<td>Writeoffs</td>
<td>0.00</td>
</tr>
<tr>
<td>Percent of Total</td>
<td>91.32</td>
</tr>
<tr>
<td>Percent of Total</td>
<td>95.52</td>
</tr>
<tr>
<td>Percent of Total</td>
<td>0.00</td>
</tr>
<tr>
<td>Percent of Total</td>
<td>0.00</td>
</tr>
<tr>
<td>Percent of Total</td>
<td>0.00</td>
</tr>
<tr>
<td>For Doctor: SSS</td>
<td></td>
</tr>
<tr>
<td>Billings</td>
<td>151.00</td>
</tr>
<tr>
<td>Payments</td>
<td>15.00</td>
</tr>
<tr>
<td>Credits</td>
<td>0.00</td>
</tr>
<tr>
<td>Debits</td>
<td>0.00</td>
</tr>
<tr>
<td>Writeoffs</td>
<td>1.00</td>
</tr>
<tr>
<td>Percent of Total</td>
<td>8.68</td>
</tr>
<tr>
<td>Percent of Total</td>
<td>4.46</td>
</tr>
<tr>
<td>Percent of Total</td>
<td>0.00</td>
</tr>
<tr>
<td>Percent of Total</td>
<td>0.00</td>
</tr>
<tr>
<td>Percent of Total</td>
<td>100.00</td>
</tr>
</tbody>
</table>
Billing Versus Payment

The Billing versus Payment report is similar to the Percent Each Doctor report, but gives an overall snapshot of even multi-doctor practices. Make your selections as shown below and click Display or Print. As with the Percent Each Doctor report, the Billing versus Payment report is an aggregate report and can be password protected.

Sample output.

02/16/2004

Billings vs. Payments
07/2000 - 12/2003

<table>
<thead>
<tr>
<th>Description</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>Billings</td>
<td>$201.00</td>
</tr>
<tr>
<td>Collections</td>
<td>$25.00</td>
</tr>
<tr>
<td>Writeoffs</td>
<td>$1.00</td>
</tr>
<tr>
<td>Receivables</td>
<td>$175.00</td>
</tr>
<tr>
<td>Credits</td>
<td>$0.00</td>
</tr>
<tr>
<td>Debits</td>
<td>$0.00</td>
</tr>
<tr>
<td>%Coll/Total</td>
<td>12.44%</td>
</tr>
<tr>
<td>%Coll/Net</td>
<td>12.50%</td>
</tr>
</tbody>
</table>

1 - Billings represents total for procedures +/- corrections
2 - Debit corrections include prior balances entered + current debits
3 - Receivables +/- represents billings - (collections + writeoffs)
4 - %Coll/tot represents collections divided by billings
5 - %Coll/net represents collections divided by (billings - writeoffs)
6 - Corrections
ICD9 – Diagnosis Report

The *ICD9 – Diagnosis Detail Report* lets you see which ICD9 codes are used for specific charges. Selecting to do a summary of this report will give you a list of selected codes, the number of times used, and the amount billed. To generate this report make your selections from the dialog pictured below. If you have a large number of ICD9 codes in your system you can use the *Find* function to search the list of codes.

**Sample output.**

```plaintext
02/16/2004

**Diagnosis Code Detail Report 07/01/2000 - 02/29/2004**

**259.0 Diabetes mellitus**

<table>
<thead>
<tr>
<th>Date</th>
<th>POS</th>
<th>Patient</th>
<th>Procedure</th>
<th>Doctor</th>
<th>Charge</th>
</tr>
</thead>
<tbody>
<tr>
<td>07/25/2000</td>
<td>22</td>
<td>100006 Avery, April</td>
<td>$11,233.00</td>
<td>SSS</td>
<td>0.00</td>
</tr>
<tr>
<td>07/25/2000</td>
<td>22</td>
<td>100006 Avery, April</td>
<td>$33,221.00</td>
<td>SSS</td>
<td>1.00</td>
</tr>
</tbody>
</table>

**259.4 Diabetes w renal manifest**

<table>
<thead>
<tr>
<th>Date</th>
<th>POS</th>
<th>Patient</th>
<th>Procedure</th>
<th>Doctor</th>
<th>Charge</th>
</tr>
</thead>
<tbody>
<tr>
<td>07/25/2000</td>
<td>22</td>
<td>100006 Avery, April</td>
<td>$11,233.00</td>
<td>SSS</td>
<td>0.00</td>
</tr>
<tr>
<td>07/25/2000</td>
<td>22</td>
<td>100006 Avery, April</td>
<td>$33,221.00</td>
<td>SSS</td>
<td>1.00</td>
</tr>
<tr>
<td>08/05/2003</td>
<td>11</td>
<td>100011 Farmer, Richard</td>
<td>90050 Limited Service</td>
<td>SSS</td>
<td>50.00</td>
</tr>
<tr>
<td>02/16/2004</td>
<td>11</td>
<td>100011 Farmer, Richard</td>
<td>90030 Minimal Service</td>
<td>SSS</td>
<td>25.00</td>
</tr>
<tr>
<td>02/16/2004</td>
<td>11</td>
<td>100011 Farmer, Richard</td>
<td>90040 Brief Service</td>
<td>SSS</td>
<td>35.00</td>
</tr>
</tbody>
</table>
```

$11,111.00
CPT – Procedural Report

The *CPT – Procedural Report* offers a detailed and summary version. The detailed report lists patients and dates of service for each selected code, and is grouped by doctor. The summary report lists each selected CPT code, the number of times used, and the amount charged, and is also grouped by doctor. To run this report, select any codes on the grid along with the doctors you wish to view. Set the date or date range and select the report type from the drop down list.

**Sample output.**

**Procedure Code Detail**
**For Period 07/2000 - 02/2004**

<table>
<thead>
<tr>
<th>Doctor: STEVEN SMITH, M.D.</th>
<th>Code: SSS</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPT Code: 11223</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Account</th>
<th>Name</th>
<th>DOS</th>
<th>Times</th>
<th>POS</th>
<th>ICD9</th>
<th>Amt Paid</th>
<th>Last Visit</th>
</tr>
</thead>
<tbody>
<tr>
<td>100009</td>
<td>Avery, April</td>
<td>07/25/2000</td>
<td>1</td>
<td>22</td>
<td>260.00</td>
<td>0.00</td>
<td>02/16/2004</td>
</tr>
</tbody>
</table>

**Total Number:** 1  **Total Amount:** $0.00

| CPT Code: 26505 | Treat fx radius-manip |

<table>
<thead>
<tr>
<th>Account</th>
<th>Name</th>
<th>DOS</th>
<th>Times</th>
<th>POS</th>
<th>ICD9</th>
<th>Amt Paid</th>
<th>Last Visit</th>
</tr>
</thead>
<tbody>
<tr>
<td>100009</td>
<td>Avery, April</td>
<td>02/09/2004</td>
<td>1</td>
<td>11</td>
<td>650.00</td>
<td>0.00</td>
<td>02/16/2004</td>
</tr>
<tr>
<td>100009</td>
<td>Avery, April</td>
<td>02/09/2004</td>
<td>1</td>
<td>11</td>
<td>440.00</td>
<td>0.00</td>
<td>02/16/2004</td>
</tr>
<tr>
<td>100009</td>
<td>Avery, April</td>
<td>02/09/2004</td>
<td>1</td>
<td>11</td>
<td>493.00</td>
<td>0.00</td>
<td>02/16/2004</td>
</tr>
<tr>
<td>100009</td>
<td>Avery, April</td>
<td>02/10/2004</td>
<td>1</td>
<td>11</td>
<td>493.00</td>
<td>0.00</td>
<td>02/16/2004</td>
</tr>
<tr>
<td>100009</td>
<td>Avery, April</td>
<td>02/10/2004</td>
<td>1</td>
<td>11</td>
<td>493.00</td>
<td>0.00</td>
<td>02/16/2004</td>
</tr>
</tbody>
</table>

**Total Number:** 5  **Total Amount:** $1,750.00
Referral Sources

There are three types of Referral Sources reports: Patient List, Summary, and Procedure Code List. The Patient List (show below) shows patients grouped by selected referrals along with amount billed, amount collected, and the primary and secondary insurance mnemonic for each patient. The Summary report shows the amount billed and collected, along with credits and debits for each selected referral. The Procedure Code List itemizes the CPT codes by referral, the number of times used, and the amount billed and collected. To run these reports make selections the same as in other reports. Use the Find function to locate specific referrals in the grid if necessary.

Sample output.

<table>
<thead>
<tr>
<th>Acct#</th>
<th>Name</th>
<th>Billed</th>
<th>Collected</th>
<th>Ins1</th>
<th>Ins2</th>
</tr>
</thead>
<tbody>
<tr>
<td>100012</td>
<td>Harris, Henry</td>
<td>2,154.00</td>
<td>395.00</td>
<td>N/A</td>
<td>N/A</td>
</tr>
<tr>
<td>100013</td>
<td>Cargill, Linda</td>
<td>435.00</td>
<td>442.00</td>
<td>BC</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>2,599.00</strong></td>
<td><strong>838.00</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Sub Total: 2

John Wilson, Dr. - wilsonidnum

<table>
<thead>
<tr>
<th>Acct#</th>
<th>Name</th>
<th>Billed</th>
<th>Collected</th>
<th>Credits</th>
<th>Debits</th>
</tr>
</thead>
<tbody>
<tr>
<td>100009</td>
<td>Avery, April</td>
<td>2,771.00</td>
<td>801.00</td>
<td>MD</td>
<td>N/A</td>
</tr>
<tr>
<td>100010</td>
<td>Barstow, Bill</td>
<td>480.00</td>
<td>10.00</td>
<td>BC</td>
<td>N/A</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>3,251.00</strong></td>
<td><strong>811.00</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Sub Total: 2

John Wilson, Dr. - wilsonidnum

<table>
<thead>
<tr>
<th>Acct#</th>
<th>Name</th>
<th>Billed</th>
<th>Collected</th>
<th>Credits</th>
<th>Debits</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>5,830.00</strong></td>
<td><strong>1,649.00</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Grand Total: 4
User Activity

The User Activity report lists the users who have accessed the current MedLook database and the transactions they’ve entered. The user names are based on the names used in Windows accounts on your computers. Select any users you wish to view and a Beginning Date. To view all of a user’s activity leave the Beginning Date check box unchecked.

![User Activity Report](image)

Sample output.

<table>
<thead>
<tr>
<th>Acct #.</th>
<th>Patient</th>
<th>Srvc. Date</th>
<th>Entry Date</th>
<th>Tnum</th>
<th>Explanation</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>100009</td>
<td>AVERY, APRIL</td>
<td>02/16/2004</td>
<td>02/16/2004</td>
<td>100349</td>
<td>90017</td>
<td>125.00</td>
</tr>
<tr>
<td>100009</td>
<td>AVERY, APRIL</td>
<td>02/16/2004</td>
<td>02/16/2004</td>
<td>100347</td>
<td>Ins.1</td>
<td>55.00</td>
</tr>
<tr>
<td>100013</td>
<td>BARSTOW, BILL</td>
<td>02/16/2004</td>
<td>02/16/2004</td>
<td>100549</td>
<td>90030</td>
<td>25.00</td>
</tr>
<tr>
<td>100011</td>
<td>FARMER, RICHARD</td>
<td>02/16/2004</td>
<td>02/16/2004</td>
<td>100350</td>
<td>90030</td>
<td>25.00</td>
</tr>
<tr>
<td>100011</td>
<td>FARMER, RICHARD</td>
<td>02/16/2004</td>
<td>02/16/2004</td>
<td>100351</td>
<td>90040</td>
<td>35.00</td>
</tr>
<tr>
<td>100012</td>
<td>HARRIS, HENRY</td>
<td>02/16/2004</td>
<td>02/16/2004</td>
<td>100352</td>
<td>90017</td>
<td>125.00</td>
</tr>
<tr>
<td>100012</td>
<td>HARRIS, HENRY</td>
<td>02/16/2004</td>
<td>02/16/2004</td>
<td>100353</td>
<td>Paid</td>
<td>75.00</td>
</tr>
</tbody>
</table>
Patient Statistics

The Patient Statistics report presents an overall view of your practice. There is nothing to configure for this single page report. Just click Display or Print.

Sample output.

<table>
<thead>
<tr>
<th>Report Type:</th>
<th>Display</th>
<th>Print</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patient Statistics</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Patient Statistics Summary

Display a statistical summary of patient data such as number of patients, patients with insurance, with automatic billing, etc., along with the charges, payments, and outstanding balances.

Patient Statistics

<table>
<thead>
<tr>
<th>Patient Count</th>
<th>9</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patients With Automatic Billing</td>
<td>9</td>
</tr>
<tr>
<td>Patients Without Automatic Billing</td>
<td>0</td>
</tr>
<tr>
<td>Patients With Primary Insurance</td>
<td>6</td>
</tr>
<tr>
<td>Patients With Secondary Insurance</td>
<td>0</td>
</tr>
</tbody>
</table>

Last Batch Billing Date: 11/01/2005

<table>
<thead>
<tr>
<th>Total Transactions</th>
<th>30</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Charges</td>
<td>$1,527.00</td>
</tr>
<tr>
<td>Total Payments</td>
<td>$785.00</td>
</tr>
<tr>
<td>Total Unapplied Payments</td>
<td>$63.00</td>
</tr>
<tr>
<td>Total Outstanding Balance</td>
<td>$742.00</td>
</tr>
</tbody>
</table>

Aging Balances

<table>
<thead>
<tr>
<th>Aging Balances</th>
<th>0 - 30</th>
<th>31 - 60</th>
<th>61 - 90</th>
<th>91 - 120</th>
<th>121+</th>
<th>Total Bal.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Insurance:</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>381.00</td>
<td>381.00</td>
</tr>
<tr>
<td>Secondary Insurance:</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>430.00</td>
<td>430.00</td>
</tr>
<tr>
<td>Patient:</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>430.00</td>
<td>430.00</td>
</tr>
<tr>
<td>Other:</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>Total Due:</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>430.00</td>
<td>430.00</td>
</tr>
</tbody>
</table>
Daily Ledger

The *Daily Ledger* report is probably the most important report you will run in MedLook. It lists all transactions entered since the last time you ran the report and lets you verify that all transaction data has been entered correctly. We recommend that you run it daily and print out and file a hard copy. However, all reports generated and accepted are ALWAYS saved online for easy retrieval as PDF files.

Once the *Daily Ledger* report is complete you will see the following dialog:

Go over the printed report very carefully before answering the above question. Once you’ve answered *Yes* here, any transactions that have been included on the report can no longer be deleted from the database.

To run this report, select either *Report for Entire Practice* or *Report for Selected Doctors*. The drop down list allows you to sort transactions by patient account number or last name, date of service, doctor, or date of entry. The *History* button will present a list of past reports to which you’ve answered *Yes* at the end. To view a report click on the desired file name and click the *View* button. You may also delete older reports that are no longer necessary. Below is what the *History* dialog looks like:
If the ending balance from the prior posting and the starting balance do not equal each other then a message will be displayed as a warning. Typically this happens as a result of editing previously posted transactions such as changing the payment or procedure amount. It is not critical and is informational only.

<table>
<thead>
<tr>
<th>Last Name</th>
<th>Code</th>
<th>First Name</th>
<th>MI</th>
<th>Title</th>
<th>Grade</th>
</tr>
</thead>
<tbody>
<tr>
<td>Smith</td>
<td>SSS</td>
<td>Steven</td>
<td>S</td>
<td></td>
<td>M.D.</td>
</tr>
<tr>
<td>Jones</td>
<td>JJJ</td>
<td>Jane</td>
<td>J</td>
<td></td>
<td>M.D.</td>
</tr>
</tbody>
</table>
Sample output.

Section 1.

Procedures Entered Since Last Posting

<table>
<thead>
<tr>
<th>Account#</th>
<th>DOS</th>
<th>Doc</th>
<th>Amount</th>
<th>Name</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>100009</td>
<td>07/25/2000</td>
<td>SSS</td>
<td>0.00</td>
<td>Avery, April</td>
<td>11223</td>
</tr>
<tr>
<td>100009</td>
<td>07/25/2000</td>
<td>SSS</td>
<td>1.00</td>
<td>Avery, April</td>
<td>33221</td>
</tr>
<tr>
<td>100009</td>
<td>02/09/2004</td>
<td>SSS</td>
<td>350.00</td>
<td>Avery, April</td>
<td>26505</td>
</tr>
</tbody>
</table>

Section 2.

Payments Entered Since Last Posting

<table>
<thead>
<tr>
<th>Account#</th>
<th>DOS</th>
<th>Doc</th>
<th>Amount</th>
<th>Name</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>100009</td>
<td>07/25/2000</td>
<td>SSS</td>
<td>10.00</td>
<td>Avery, April</td>
<td>Check Ins.1</td>
</tr>
<tr>
<td>100009</td>
<td>07/25/2000</td>
<td>SSS</td>
<td>5.00</td>
<td>Avery, April</td>
<td>Check Ins.1</td>
</tr>
<tr>
<td>100009</td>
<td>02/12/2004</td>
<td>SSS</td>
<td>30.00</td>
<td>Avery, April</td>
<td>Check Ins.1</td>
</tr>
</tbody>
</table>

Section 3.

Adjustments, Writeoffs, Corrections

<table>
<thead>
<tr>
<th>Account#</th>
<th>DOS</th>
<th>Doc</th>
<th>Amount</th>
<th>Name</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>100009</td>
<td>07/25/2000</td>
<td>SSS</td>
<td>1.00</td>
<td>Avery, April</td>
<td>Check Crisy</td>
</tr>
<tr>
<td>100009</td>
<td>02/12/2004</td>
<td>SSS</td>
<td>20.00</td>
<td>Avery, April</td>
<td>Check Crisy</td>
</tr>
</tbody>
</table>

Section 4.

Daily Ledger Totals

Total Accounts Receivable - Last Posting 2,967.00
Previous existing balances entered since last posting 0.00
Total New Charges 2,611.00
Checks Received 187.00
Credit Card Payments 0.00
Cash Received 0.00
Total New Payments 187.00
Adjustments
Writeoffs 21.00
Other Credits 0.00
Total Credits 21.00
Total Debits 0.00
New Receivables Total 5,370.00

02/16/2004
Chapter 19 – Insurance Analysis

Insurance Reimbursement

The *Insurance Reimbursement* report will let you track cash flow from insurance carriers and offers a detailed and summary view. The summary report will list debits, credits, charges, and payments for each insurance carrier. The detailed report, shown below, will list individual transactions and allow you to include payments and comments. If you are concerned with outstanding charges, you can limit the detailed report to show only those charges by checking the *Outstanding Charges Only* box. You can also choose to show one custom designed User Field (from the Edit Patient dialog). Some offices find this option extremely important for state reporting.

<table>
<thead>
<tr>
<th>Insurance Number</th>
<th>Carrier Name</th>
<th>Address 1</th>
<th>Address 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>10001</td>
<td>Blue Cross/Blue Shield</td>
<td>PO Box 533</td>
<td></td>
</tr>
<tr>
<td>10002</td>
<td>Aetna</td>
<td>3 Highwood Drive</td>
<td></td>
</tr>
<tr>
<td>10003</td>
<td>Cigna Healthcare</td>
<td>PO Box 2098</td>
<td></td>
</tr>
<tr>
<td>10004</td>
<td>Tricare</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10005</td>
<td>Medicaid Alabama</td>
<td>EDS</td>
<td>PO Box 244032</td>
</tr>
<tr>
<td>10006</td>
<td>Medicare</td>
<td>Cahaba Govern Benefit Adm</td>
<td>PO Box 830140</td>
</tr>
</tbody>
</table>
## Insurance Reimbursement Detail

07/01/2004 - 02/29/2004

**Smith M.D., Steven - SSS**

Medicaid - MD

1245 Peach Street

Anytown, KS11112222

### Avery, April - 100000

<table>
<thead>
<tr>
<th>Date</th>
<th>Sub Date</th>
<th>Procedure</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>02/09/2004</td>
<td></td>
<td>26685/Treat fx radius-manip</td>
<td>350.00</td>
</tr>
<tr>
<td>02/09/2004</td>
<td></td>
<td>26685/Treat fx radius-manip</td>
<td>350.00</td>
</tr>
<tr>
<td>02/05/2004</td>
<td></td>
<td>26685/Treat fx radius-manip</td>
<td>350.00</td>
</tr>
<tr>
<td>02/10/2004</td>
<td></td>
<td>26685/Treat fx radius-manip</td>
<td>350.00</td>
</tr>
<tr>
<td>02/10/2004</td>
<td>02/11/2004</td>
<td>90017/Extended svc, new</td>
<td>125.00</td>
</tr>
<tr>
<td>02/10/2004</td>
<td></td>
<td>90015/Intermediate svc,newptnt</td>
<td>100.00</td>
</tr>
<tr>
<td>02/10/2004</td>
<td></td>
<td>26685/Treat fx radius-manip</td>
<td>350.00</td>
</tr>
<tr>
<td>02/12/2004</td>
<td></td>
<td>90050/Limited Service</td>
<td>50.00</td>
</tr>
<tr>
<td>02/12/2004</td>
<td></td>
<td>90050/Limited Service</td>
<td>50.00</td>
</tr>
<tr>
<td>02/16/2004</td>
<td></td>
<td>90017/Extended svc,new</td>
<td>125.00</td>
</tr>
</tbody>
</table>

**Patient Totals:** 100000

**Carrier Totals:** MD

$2,300.00

**Medicare - MC**

Claims Processing Section

Anytown, KS11112222

1112223436

### Farmer, Richard - 100011

<table>
<thead>
<tr>
<th>Date</th>
<th>Sub Date</th>
<th>Procedure</th>
<th>Amount</th>
</tr>
</thead>
<tbody>
<tr>
<td>02/05/2003</td>
<td></td>
<td>90050/Limited Service</td>
<td>50.00</td>
</tr>
<tr>
<td>02/16/2004</td>
<td></td>
<td>90030/Minimal Service</td>
<td>25.00</td>
</tr>
<tr>
<td>02/16/2004</td>
<td></td>
<td>90040/Exit Service</td>
<td>35.00</td>
</tr>
</tbody>
</table>

**Patient Totals:** 100011

$110.00

**Carrier Totals:** MC

$110.00

**Physician Totals:** SSS

$2,310.00

**Grand Totals:**

$2,310.00
Patients With Insurance

The *Patients with Insurance* report will list your patients, their insurance carriers and their balances. If grouped by insurance you will see the patients and an aging balance line. By default patients with zero balances are not included in the report. You can choose to include such patients by checking the *Include Zero Balances* box.

Sample output.

**Patient List By Insurance Carrier**

<table>
<thead>
<tr>
<th>Acct#</th>
<th>Patient</th>
<th>Balance</th>
<th>Fmmts</th>
<th>0-30</th>
<th>31-60</th>
<th>61-90</th>
<th>91-120</th>
<th>121+</th>
</tr>
</thead>
<tbody>
<tr>
<td>100010</td>
<td>Barlow, B</td>
<td>900.00</td>
<td>10.00</td>
<td>25.00</td>
<td>0.00</td>
<td>0.00</td>
<td>75.00</td>
<td>810.00</td>
</tr>
<tr>
<td>100013</td>
<td>Cargill, L</td>
<td>(7.00)</td>
<td>7.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td></td>
<td></td>
<td>$913.00</td>
<td>$17.00</td>
<td>$25.00</td>
<td>0.00</td>
<td>$5.00</td>
<td>$75.00</td>
<td>$810.00</td>
</tr>
</tbody>
</table>
Chapter 20 – Patient Analysis

Patient Data Sheet

The Patient Data Sheet report allows you to print patient transactions as shown below, or by unchecking the Transactions box, a patient sheet that contains detailed information as shown on the following page.
Sample output: *Patient Data Sheet* - With Transactions Selected.

**Patient Transactions**  
**Starting 12/01/2003**

<table>
<thead>
<tr>
<th>Date</th>
<th>POS</th>
<th>Procedure</th>
<th>Charge</th>
<th>Payment</th>
<th>Credit</th>
<th>Source</th>
<th>Doctor</th>
</tr>
</thead>
<tbody>
<tr>
<td>02/16/2004</td>
<td>11</td>
<td>99030 Minimal Service</td>
<td>25.00</td>
<td>0.00</td>
<td>0.00</td>
<td>SSS</td>
<td></td>
</tr>
<tr>
<td>02/16/2004</td>
<td>11</td>
<td>99040 Brief Service</td>
<td>35.00</td>
<td>0.00</td>
<td>0.00</td>
<td>SSS</td>
<td></td>
</tr>
</tbody>
</table>

Sample output: *Patient Data Sheet* - Without Transactions Selected.

**Farmer, Richard R**  
3443 Sheridan Place  
Anytown, KS 11111  
DOB: 04/22/1914  
Sex: M

Spouse/Parent: Charlotte  
Referred By

Home Phone: 555-223-4438  
Work Phone: 555-722-1114  
Ins1: MC=Assign  
Ins2: None

Primary Insurance: Medicare  
Claims Processing Section  
232 Insurance Road  
Anytown, KS 11311-2222  
ID # farmeridnumber  
Group # farmergrouapnumber

Last hospital admission date:  
Last hospital discharge date:  
Responsible physician: Steven S Smith M.D.  
UPIN

Last Bill Date
Aging Balance

The *Aging Balance* report lists patients with balances, showing the age of those balances. There are various filtering and grouping options for this report. The *Balances* section lets you choose between *Outstanding* balances, *Late Payment*, and accounts that are *Overpaid* selecting a number of days for the first two.
### Accounts With Outstanding Balances

**Date:** 02/16/2004

#### JANE JONES, M.D.

<table>
<thead>
<tr>
<th></th>
<th>0 - 30</th>
<th>31 - 60</th>
<th>61 - 90</th>
<th>91 - 120</th>
<th>121+</th>
<th>Unassn Pmts</th>
<th>Total Bal.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Doctor:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Patient:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last Pay Date:</strong></td>
<td>11/07/2003</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last Pay Amt:</strong></td>
<td>$10.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Doc Code:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Acc#:</strong></td>
<td>100010</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Primary Ins:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Secondary Ins:</strong></td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Phone #:</strong></td>
<td>665-330-8992</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>(H)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>(W)</strong></td>
<td>665-636-8084</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last Bill:</strong></td>
<td>09/30/1992</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>AutoBill:</strong></td>
<td>On</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### STEVEN SMITH, M.D.

<table>
<thead>
<tr>
<th></th>
<th>0 - 30</th>
<th>31 - 60</th>
<th>61 - 90</th>
<th>91 - 120</th>
<th>121+</th>
<th>Unassn Pmts</th>
<th>Total Bal.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Doctor:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Patient:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last Pay Date:</strong></td>
<td>02/16/2004</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last Pay Amt:</strong></td>
<td>$55.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Doc Code:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Acc#:</strong></td>
<td>10009</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Primary Ins:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Secondary Ins:</strong></td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Phone #:</strong></td>
<td>665-883-3093</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>(H)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>(W)</strong></td>
<td>665-392-8921</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last Bill:</strong></td>
<td>09/30/1992</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>AutoBill:</strong></td>
<td>Off</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### FARMER, RICHARD

<table>
<thead>
<tr>
<th></th>
<th>0 - 30</th>
<th>31 - 60</th>
<th>61 - 90</th>
<th>91 - 120</th>
<th>121+</th>
<th>Unassn Pmts</th>
<th>Total Bal.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Doctor:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Patient:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last Pay Date:</strong></td>
<td>06/08/2000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last Pay Amt:</strong></td>
<td>$40.00</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Doc Code:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Acc#:</strong></td>
<td>100011</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Primary Ins:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Secondary Ins:</strong></td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Phone #:</strong></td>
<td>665-223-4888</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>(H)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>(W)</strong></td>
<td>665-722-1114</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last Bill:</strong></td>
<td>None</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>AutoBill:</strong></td>
<td>Off</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### STEVEN SMITH, M.D.

<table>
<thead>
<tr>
<th></th>
<th>0 - 30</th>
<th>31 - 60</th>
<th>61 - 90</th>
<th>91 - 120</th>
<th>121+</th>
<th>Unassn Pmts</th>
<th>Total Bal.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Doctor:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Patient:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last Pay Date:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last Pay Amt:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Doc Code:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Acc#:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Primary Ins:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Secondary Ins:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Phone #:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>(H)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>(W)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last Bill:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>AutoBill:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Report Totals

<table>
<thead>
<tr>
<th></th>
<th>0 - 30</th>
<th>31 - 60</th>
<th>61 - 90</th>
<th>91 - 120</th>
<th>121+</th>
<th>Unassn Pmts</th>
<th>Total Bal.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Doctor:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Patient:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last Pay Date:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last Pay Amt:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Doc Code:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Acc#:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Primary Ins:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Secondary Ins:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Phone #:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>(H)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>(W)</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Last Bill:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>AutoBill:</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Totals:

- **Total Bal.** 900.00
- **Unassn Pmts** 241.00
- **Total Bal.** 2,959.00

---

118
Patients In Hospital

The *Patients In Hospital* report is a simple list of patients who have had a hospital entry date entered, but no discharge date entered.

### Sample output.

```
<table>
<thead>
<tr>
<th>Code</th>
<th>First Name</th>
<th>MI</th>
<th>Last Name</th>
<th>Hospital</th>
<th>Address 1</th>
<th>Address 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>SSS</td>
<td>Steven</td>
<td>S</td>
<td>Smith</td>
<td>General Hospital</td>
<td>Oak &amp; Division St</td>
<td></td>
</tr>
<tr>
<td>JJJ</td>
<td>Jane</td>
<td>J</td>
<td>Jones</td>
<td>University Hospital</td>
<td>Memorial Plaza</td>
<td></td>
</tr>
</tbody>
</table>
```

02/16/2004
Chapter 21 – Custom Reports

MedLook provides a variety of reports formatted and ready to go. Nevertheless, there are reports that are unique to each office and because of this we provide you the means to provide a template to MedLook to use to generate a report that you are solely responsible for creating. The templates that you create must be in Rich Text File (RTF) format. RTF files provide the capability to use tables, bullets, underlining, italicizing, bolding, colors, different fonts, inserted images (like your corporate logo), and more.

Unfortunately, at the moment not all RTF utilities are equal across the Windows platforms. Some can do more than others. Some support tables, some do not, etc., etc. So you will have to use some care when designing your report templates. You may want to try a simple skeleton template and see how it works with MedLook. In the future we anticipate a significant increase in compatibility with RTF files.

Using The Custom Reports

Using MedLook you can generate custom reports for patients, appointments, insurance carriers, and referrals. Each of these reports has a dictionary of terms that will be translated from the dictionary term to the actual data. The interface for each report is identical with only a couple of exceptions. First, the data presented in the grid varies with report type. Second, the Custom Appointments also allow for a selection of begin and end dates. Below is the custom report interface.
Here are the additional options if *Appointments* are selected.

Let’s get a handle on what the interface is before we discuss how it all works.

The *Report Type* drop down list simply allows you to change to a different type of report (e.g. Billing versus Payment).

The *Process* command will generate the reports for the selected items using the template you have provided with the result being written to the output folder.

The drop-down list titled *Customization of:* lists the types of reports we allow you to customize. The list includes the following: *patients, appointments, insurance carriers,* and *referrals.*

The *Single File* option (which should not be used on Windows 98 or ME) allows you to create all of your reports into a single file.

The *Plain Text* option allows for the data to be stored as a standard text (.txt) file. If not checked the file format is rich text format (.rtf).

The *Template* allows you to key-in or use the *Browser* command to specify the template file for the report. It must be a RTF file in any case.

The *Output Folder* allows you to key-in or use the *Browser* command to specify the output folder. If you enter a folder that does not exist it will be created if possible. You should not store your output anywhere within the “Program Files” folder tree. Something like c:\MedlookReports might be suitable.

The *Edit* and *Browser* fields on the *Template* line apply to the template only. Using *Edit* will invoke whatever program your system has associated with the RTF file extension with the selected file. You can then edit and save the template. The *Browser* will start the Windows Open dialog allowing you to locate the file you want to use as the template.

The *Edit, Browser,* and *Explore* fields on the *Output Folder* line apply to the output folder only. Using *Edit* will invoke whatever program your system has associated with the RTF file extension with the last file created. The *Browser* will start the Windows Browse For Folder dialog allowing you to locate the file folder you want to use for the generated reports.

So here’s how it all works. You select the type of report you want to customize. Specify the template you want to use, select the output folder, select the records you want to use, and use *Process* to generate your reports. If you enable the *Single File* option then the output report file will be named exactly the same as the input file but in the output folder. If you do not enable this option then each report will be named as the input file and
appended with “_” and key-id. As an example, assume you specify template PatientSummary.rtf. For patient account #1000 the output will be PatientSummary_1000.rtf.

The *Edit* command for the *Output Folder* can only edit one file. If you select multi-file output then only the last file will be edited. Generally you should use the *Explore* option. You can then select all the reports and edit or print them as you prefer. You will probably want to delete the reports you generate periodically.

In designing your reports if you find that you regularly need to generate more than one report for a patient perhaps you should combine your reports into a single template. Be careful though, your design may look great in MSWord but not come out with quite what you expect because of the limitations we mentioned earlier.

Another thing to consider when using the *Single File* option is the potential file size. With each record used in the report the output file increases in size. Because of this, the report becomes slower to update with each additional record. It would probably be faster to generate them in separate files and then join them together with a better tool afterwards.

### Designing Custom Reports

What about designing custom reports? Sometimes examples are the best teachers. We have provided at least one template for each report type. The names of the files are fairly obvious (PatientTemplate.rtf, AppointmentList.rtf, Insurance.rtf, Referrals.rtf). The default templates can always be found in the product directory (usually `c:\program files\Fagerman Technologies\medlook\template`).

The custom reports require an RTF editor such as MSWord or WordPad. The templates provide text formatting, etc., and use the provided MedLook dictionary to allow MedLook to replace dictionary terms with the your data. For instance, LastName and FirstName are two simple dictionary terms defining the patient. If you select a patient named George Washington then wherever [LastName] appears in the file Washington will appear. The same holds true for [FirstName] and George.

You have already been into a patient’s account in an earlier section. The *Summary* screen is actually driven by the template: PatientSummary.rtf. Let’s take a look at this template since it contains a lot of information that we are very familiar with.
The PatientSummary.rtf file.

That’s it. Now this only somewhat looks like what you see in a patient account. Here is an actual summary for one of our patient’s.

Avery, April A.  Mrs.  
DOB: 02/01/1944  Age:  62  
212 West Coast  
Primary Insurance: MD, No Assign, None

Send Bill To Other  
Scheduled Appointments  
Secondary Insurance (Life)  

Balance Summary

Perhaps the first thing you might notice is that the data is contained within tables. We designed this template this way to keep things organized better. Not all fields (such as last names) are the same length and without tables it is difficult to present this information in a nice neat format. Of course, we can organize the data such that all fields are exactly a certain width (and on Windows 98 we had to do this) but that will give us a slightly different look. If we force the last name to be 15 characters wide and the first name 10 characters wide then there will be a big gap between the last name and the first name. While this is still a decent presentation it is not nearly a nice as we have shown above. Plus you have to keep a character count to make everything line up nicely (too much work).
You probably also noticed that some of the key fields, such as [LastName] are **bolded** while most others are not. That’s because we wanted to accentuate the patient’s name. This is entirely up to the designer.

Here’s another example for appointments.

| [ApptStart] | [ApptStatus] | [DocLastName] | [FirstName] | [LastName] |
| [ApptEndTime] | [ApptProcedure] | [ApptDescription] | [HomePhone] | [WorkPhone] |

For output we selected three appointments and the following file was generated.

| 02/16/2004 8:00:00 AM | Scheduled | Smith | April Avery |
| 02/16/2004 9:15:00 AM | Scheduled | Smith | Richard Farmer |
| 02/16/2004 10:45:00 AM | Scheduled | Jones | Henry Harris |

This also used the **Single File** option.

Here’s the template for insurance carriers.

```
Insurance Listing ([Ins1Mnem] - [Ins1Num])

[Ins1Name]
[Ins1Address1]  Contact: [Ins1Contact]
[Ins1Address2]  Phone: [Ins1Phone]
[Ins1City] [Ins1State] [Ins1Zip]  Type: [Ins1Type]
```

Here’s the output for two carriers.

```
Insurance Listing  (BC - 100090)

Blue Cross Blue Shield
1234 Highway 10 West  Contact: Virginia Rogers
Phone: (111)888-9376
Somewhere, KS 23456-7890  Type: Other

Insurance Listing  (MD - 102)

Medicaid
1234 Peach Street  Contact:
Phone:
Anytown, KS 1111-2222  Type: Medicaid
```

Notice that Ins1Address2 is blank because it wasn’t provided. This isn’t the most eye-appealing format, but perhaps the one you want to use. It could have been done completely differently such that you wouldn’t notice Ins1Address2 is even missing (i.e. the city, state, and zip code would have moved up to fill it in).

The referral report is very similar.

See the appendix for details regarding the complete dictionary for each report.
The key to designing any report is understanding the basic MedLook syntax and dictionary, skill using an rtf editor, creativity, and time to test your report.

Here’s one last report that may work for you (Encounter2.rtf).

<table>
<thead>
<tr>
<th>OFFICE VISITS</th>
<th>RADILOGY</th>
<th>PROCEDURES / TESTS</th>
<th>IMMUNIZATIONS</th>
<th>DIAGNOSIS CODES</th>
</tr>
</thead>
<tbody>
<tr>
<td>99201 NEW PT. LEVEL 1</td>
<td>70210 SINUS XRAY</td>
<td>11200 SKIN TAG REMOVAL</td>
<td>90659 INFLUENZA VACCINE</td>
<td>285.9 Anemia, Unspecified</td>
</tr>
<tr>
<td>99201 NEW PT. LEVEL 2</td>
<td>71020 CHEST XRAY</td>
<td>11400 EXC. LES. &lt;= 5CM</td>
<td>90701 IMMUNIZATION, DIE</td>
<td>401.0 Malig, Hypertension</td>
</tr>
<tr>
<td>99201 NEW PT. LEVEL 3</td>
<td>73100 SPINE, AP &amp; LAT</td>
<td>11400 EXC. LES. 5-10CM</td>
<td>90701 DT VACCINE</td>
<td>401.1 Benign Hypertension</td>
</tr>
<tr>
<td>99201 NEW PT. LEVEL 4</td>
<td>73200 SPINE, SINGLE VIEW</td>
<td>20150 TRIGGERS POINT (per adj)</td>
<td>90701 TETANUS TOXID</td>
<td>413.9 Asthma Pectoris</td>
</tr>
<tr>
<td>99201 NEW PT. LEVEL 5</td>
<td>72070 SPINE, THOR, AP &amp; LAT</td>
<td>20600 JOINT INJ - MINOR</td>
<td>90701 INJECTIONS</td>
<td>520.0 Congr Hart Failure</td>
</tr>
<tr>
<td>99211 EST PT. LEVEL 1</td>
<td>72110 SPINE, LUM, AP &amp; LAT</td>
<td>20600 JOINT INJ - INTERM</td>
<td>90701 PNEUMOCO VAC.</td>
<td>533.81 Esophaeged Reflux</td>
</tr>
<tr>
<td>99211 EST PT. LEVEL 2</td>
<td>73030 SHOULDER, COMP.</td>
<td>20610 JOINT INJ - MAJOR</td>
<td>90701 MMR VACCINE</td>
<td>535.90 Peptic Ulcer Disease</td>
</tr>
<tr>
<td>99211 EST PT. LEVEL 3</td>
<td>73140 FINGERS, MIN 2 VIEW</td>
<td>15852 DRESSING CHANGE</td>
<td>90701 INJECTIONS</td>
<td>535.00 Acute Gastro</td>
</tr>
<tr>
<td>99211 EST PT. LEVEL 4</td>
<td>73510 HIPS, COMD, MIN 2 VV</td>
<td>29705 REMOV/REV OF CAST</td>
<td>90701 IMMUNIZATION, DIE</td>
<td>564.1 Irritable Bow Synd</td>
</tr>
<tr>
<td>99211 EST PT. LEVEL 5</td>
<td>73564 KNEE, 4 OR MORE VV</td>
<td>57505 ECG</td>
<td>90701 INJECTIONS</td>
<td>285.9 Anemia, Unspecified</td>
</tr>
<tr>
<td>-</td>
<td>73610 ANGLE, COMP, 3 VV</td>
<td>92001 VISUAL FIELD EXAM</td>
<td>90701 IMMUNIZATION, DIE</td>
<td>401.0 Malig, Hypertension</td>
</tr>
<tr>
<td>-</td>
<td>73630 FOOT, MIN 3 VV</td>
<td>92552 PURETONE AUDIOMETRY</td>
<td>90701 TETANUS TOXID</td>
<td>401.1 Benign Hypertension</td>
</tr>
<tr>
<td>-</td>
<td>76075 DEXA BONE DENSITY</td>
<td>74000 ABDOMIN, AS VIEW</td>
<td>90701 INJECTIONS</td>
<td>520.0 Congr Hart Failure</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
<td>92567 TYMSPANOMETRY</td>
<td>90701 PNEUMOCO VAC.</td>
<td>533.81 Esophaeged Reflux</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>INSTRUCTIONS</th>
<th>RETURN TO CLINIC</th>
<th>PAYMENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN _ DAYS</td>
<td>IN _ WEEKS</td>
<td>IN _ MONTHS</td>
</tr>
<tr>
<td>AS NEEDED</td>
<td>NEXT APPOINTMENT</td>
<td>DATE</td>
</tr>
</tbody>
</table>

PHYSICIAN SIGNATURE ___________________ DATE __________

PATIENT SIGNATURE ___________________ DATE __________
Section 6 – Labels

MedLook provides a very nice feature for creating labels. Typically these labels are used for mailing labels, but not necessarily. Labels can be created simply to identify a chart or physical folder. They can be designed to have just the information you require and in the format you need. A wide variety of labels are supported.

Chapter 22 – The Labels Folder

MedLook supports five types of labels: Patients, Birthday, Recall, Insurance Carriers, and Referral Source. Each type of label has its own interface but there are several things common to them all.

Common Features

The dialog below shows those options common to each label type.

The Display command is used to display the labels in a dialog prior to printing. You would normally do this to preview the labels to make sure you have the right information being printed, in the format you want, on the right label type, and starting where they should be. The preview dialog allows you do quite a few things to the labels. The preview dialog’s toolbar is shown here just to give you an idea of what’s allowed.

The Print command is used to send the labels to the printer without previewing them. The system Print dialog will appear allowing you to select the printer for the job. Make sure you have inserted your label paper in the printer before you send a whole bunch of labels to the printer (and get the paper orientation right too). This toolbar is discussed in more detail elsewhere in this document.

Copies by default is set to 1 but you may make any number of the same label by increasing the number. Some offices choose to create a full page of labels for a patient at the onset of the patient’s services.
You can choose to set the starting point for the label printout via the *Set Starting Point* option. You must provide the *Row* and *Col* values (for row and column) for the labels.

The *Label Size* is a drop-down list containing nearly 90 different types or formats of labels for Avery and MACO labels. Be sure to select the label that matches what you have purchased.

The *Change Font* command brings up the standard Windows Font selection dialog as it appears here.

![Font selection dialog](image)

After you have changed the font you should use the *Display* command to preview your labels before printing. You want to make sure everything looks right and fits on your labels. This option allows you to change the font for all of the text to be printed.

**Custom Labels**

The remaining options shown in the “Common Features” section of this chapter apply to custom labels. If you select *Use Custom Layout* then other options for each of the label types will become disabled as appropriate. Similarly, if the *Use Custom Layout* item is not checked then the *Reset, Text Template, Browser*, and *Edit* fields will be disabled.

Each report type supports the use of custom designed labels via Rich Text Files (RTF) and a dictionary of terms provided by MedLook. The program is delivered with a sample template for each type of label. Using the *Edit* command to edit the template specified in the *Text Template* field will invoke whatever application your system has associated with
files with the rtf extension. This may be MSWord, WordPad, or some other program. If you do not have a program associated with rtf files the system will let you pick a program (this is a standard Windows feature).

If you edit the provided template you can optionally save it to a different file (and folder) than the default. If you do edit the template and some how mess it up beyond your repair, use the Reset command and the template will be replaced with the proper default.

Since the templates are stored in rtf files you can format the information in almost any way you wish. You can bold, underline, italicize, colorize, change font style, size, etc., of each individual word item. Typically the templates have the most important information bolded and the rest in standard format.

See the Appendix for a complete list of formatting rules and dictionary items available for each label type.
Patient Labels

The *Patient Labels* specific options are shown below:

There are four check boxes that allow you to enable/disable printing of specific items in the labels. These are self-explanatory. There is also an associated grid listing all of the patients. Like almost every other grid you can search for particular records in the customary manner. You can also use the *Select All* or *Deselect All* commands for selecting all patients or clearing the selection entirely. You can select one or more patients in the normal manner. Only those selected will be used to create labels.

The *Load Patients* command will load those patients that had statements generated during the last batch patient billing. The file that is read (if ever necessary for any other purpose outside the scope of our intentions) is stored in the database folder and is called *BBPatientList.txt*.

If you choose to use the custom layout then the check boxes are ignored. The custom layout provided for patient labels is as follows:

```
[Title][FirstName] [MI.] [LastName]
[Address]
[City.][State] [Zip]
```

Notice that the first line has each field **bolded**. Again, all keywords are case sensitive. Any information available for patient custom reports is also available for patient custom labels. So you could include the patient’s age, primary insurance co-pay, etc.

One more interesting note is that while viewing patients or appointments a right click menu will contain the *Edit* command that will go directly to the specific patient’s account for subsequent editing if invoked.
Birthday and Recall Labels

The *Birthday Labels* specific options are shown below:

<table>
<thead>
<tr>
<th>Print Phone #</th>
<th>Print Last Name First</th>
<th>Change Font</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Birthday Label Settings:**
- Month: [August]
- Within Years: [2000 - 2000]
- [Print Date of Birth]

There are three self-explanatory check boxes. If you choose to use the custom layout then the check boxes are ignored.

The *Birthday Labels* allow you to print labels only for those patients that have birthdays during a certain month and optionally within a range of years. Select the month and the year range using the options provided.

The *Recall Labels* specific options are shown below:

<table>
<thead>
<tr>
<th>Print Phone #</th>
<th>Print Last Name First</th>
<th>Change Font</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Recall Notice Label Settings:**
- Date: [Jul 2000]
- [Clear Recall Date]

*Recall Labels* allow you to print labels only for those patients that have a recall date specified in their account for the date you select. You can use the *Clear Recall Date* option to clear the recall dates for all matching patients since you won’t need to print them again. After printing (or display), you will be prompted to finalize the *Clear Recall Date* option, giving you a chance to make sure all of the labels have printed correctly.

The custom layout for *Recall Labels* is identical to that of *Patient Labels*.

The custom layout provided for *Birthday Labels* is as follows:

- [Title] [FirstName] [MI.] [LastName]
- [Address]
- [City, ] [State] [Zip]
- [Birthday]

You can format the birthday and recall labels with the same information as you use for patient labels (i.e. you use the same dictionary).
Insurance Carrier Labels

The *Insurance Carrier Labels* specific options are shown below:

There are two self-explanatory check boxes. If you choose to use the custom layout then the check boxes are ignored.

There is also an associated grid listing all of the insurance carriers. Like almost every other grid you can search for particular records in the customary manner. You can also use the *Select All* or *Deselect All* commands for selecting all insurance carriers or clearing the selection entirely. You can select one or more insurance carriers in the normal manner. Only those selected will be used to create labels.

The *Load Carriers* command will load those carriers that had statements generated during the last batch insurance billing and that were sent to paper. The file that is read (if ever necessary for any other purpose outside the scope of our intentions) is stored in the database folder and is called *BBCarrierList.txt*.

The custom layout provided for *Insurance Carrier Labels* is as follows:

```
[Ins1Name]
[Ins1Address1\n]
[Ins1Address2\n]
[Ins1City, ][Ins1State] [Ins1Zip]
[Ins1Phone]
```

Note the “\n” values at the end of the Address lines. These allow you to suppress printing this line of information altogether if that particular keyword is unavailable. So if there is no Ins1Address2 line (i.e. no second line for the primary insurance carrier address field) then simply don’t print anything and move all other lines up by one line. This allows you to keep your labels a little neater in complex situations.

The fields available for this template include those noted above plus the following: Ins1Mnem and Ins1Phone.
Referral Source Labels

The *Referral Source Labels* specific options are shown below:

There is one self-explanatory check box. If you choose to use the custom layout then the check box is ignored.

There is also an associated grid listing all of the referral sources. Like almost every other grid you can search for particular records in the customary manner. You can also use the *Select All* or *Deselect All* commands for selecting all referral sources or clearing the selection entirely. You can select one or more referral sources in the normal manner. Only those selected will be used to create labels.

The custom layout provided for *Referral Source Labels* is as follows:

```
[RefFirstName] [RefMI.] [RefLastName]
[RefAddress]
[RefCity, ][RefState] [RefZip]
```

It is very similar to the other labels. The fields you see here are all of the fields available for this template.
Section 7 – Filters
The filters used in Medlook 4.0 gives you a great amount of versatility when organizing your patients, facilities, and insurance carriers. It also aids in creating reports and batch billing. The filters can be used to organize patients in a general way, such as by last name. They can also be used to target a specific group for billing. You also have the ability to create different filters for different uses, and you are able to choose which filter to use from a drop down menu. The amount of flexibility allowed by the filters is one of the biggest and most important tools in Medlook 4.0.

Chapter 23 – Navigating the Filters Dialog and Applying Filters
Finding the Filters:
The filters are available in almost every part of Medlook 4.0. There are two ways to access the filters:

- The first method is by clicking the “Filters” command button located at the top of the grid next to the “Find Now” command button.

- The second method is by right clicking on the grid and clicking on the “Show Filters” menu option.
Navigating the Filters

Once you open the filters dialog, you will see a drop down box in the top left corner of the filters dialogue. The filter that you have selected will be visible in the drop down box. To choose a different filter, click on the drop down arrow and select the filter you want. (Medlook 4.0 comes with only one DEFAULT filter)

Below the filter drop down, you will see four tabs. Each tab has a filter corresponding to the name of the tab. The ‘Patient Data’ tab has information dealing with patient information and appointment, while the ‘Providers’ tab has filters for doctors and insurance.

The abbreviations you will see above each tab show you what filters are available in the layout you are trying to apply filters to. If there are no abbreviations above a tab, that means you are not able to filter on those options for your selected layout.

Using the Filters

Most filters will use From/To to filter specified criteria. To use this you will need to enter the base value in the From box, you will enter the greater value in the To box. An example would be filtering on last names. If you want to have all patients whose last names is between A and F you will enter “A” in the From box and “F” in the To box. Beside most filters you will see a check box labeled Exclude. This check box is used to exclude the filter criteria that it is associated with. Using the example above when filtering from A to F, you could check Exclude next to these filters and it would exclude
all patients within that filter range. These Exclude check boxes work the same way throughout the filter dialog.

Another type of filter you can use is the list filter. These types of filters allow you to choose multiple items from the Available list and place them into the Selected list to be filtered on. To do this select an item out of the Available list and click the >> button to move it to the Selected list. To remove an item from the Selected list select an item and then click the << button to move it back to the Available list which removes it from filtering.

**Applying Filters:**

Now that you know how to navigate and use the filters dialog, you are ready to apply filters to a layout. Once this is complete, click the Apply button, or the OK button. Clicking Apply saves your filter and leaves the filter dialog open. Clicking OK saves your filter and closes the filter dialog. To exit the filter dialog without saving, click the ‘Cancel’ button, or click the red ‘X’ button in the top right corner of the filter dialog. If you want to create a new filter, click the text box on the filter drop down, and erase the text. Type in the name of the new filter you want to create, and save the filter. The filter you created and the filter you were previously on will both be available in the filter drop down from now on.

For more information and instructions on how to use the filters, click here.
Section 8 – Appointments

The scheduling or Appointment component of MedLook provides a great way to manage your patient visits. Every effort has been made to make this feature very easy to use, allowing you to create appointments quickly and easily. You can move appointments, delete them, reschedule, etc., all in just a matter of a few mouse-clicks. The key thing about the Appointments component is that it is graphical. This means you can see what’s going on and in this case a picture is worth more than a thousand words (or lots of busy dialogs). It’s very much like using a big appointment folder on your desk. You can view two weeks of appointments simultaneously just as easy as a single day. And you are only one click away from almost any date you want to move to.

Chapter 24 – Basic Scheduling Features

Defining the Display

The Appointment Manager is divided up into four basic display areas: the Appointment Editor, the Calendar, the Appointment List, and the Months. Each area is depicted below:
Each of these areas play a very important part in managing your appointments. The Appointment Editor allows you to create and edit appointments. The Calendar allows you to graphically see your appointments as well as edit them and create new appointments. The Appointment List allows you to view appointments filtered by some criteria, edit appointments, and also print customized reports. The Months allow you to quickly navigate to another date several months or even years away.

The Appointment Editor can be resized (but there is a minimum width). To change the width of the editor, simply move your mouse over the separator bar between the Appointment Editor and the Calendar. You should see your mouse change to an east-west mouse pointer (i.e. a double headed arrow pointing left and right). Once the mouse changes shape just hold the left mouse button down and drag the bar to the left or right until the width of the editor is what you want.

The height of the Calendar and Appointment List can be changed simultaneously by moving the mouse over the separator bar between them. You should see your mouse change to a north-south mouse pointer (i.e. a double headed arrow pointing up and down). Once the mouse changes just hold the left mouse button down and drag the bar up or down until the height of each area is what you want.

Finally, the Months display will always display at least one month’s width if it is enabled. By grabbing the separator bar between the Calendar and the Months you can make the display width wider or narrower, showing one or more columns of months. The width will “snap” to the appropriate size as you release it. If you are wider than one month’s area but not quite two months wide it will snap back to one month wide. If you are wider than two but not quite three months wide it will snap to two months wide. And so on.
 Viewing The Days On The Calendar

MedLook’s *Appointment Manager* is designed to give efficiency and organization to any medical office. To achieve this goal MedLook allows you to view a set of predefined day ranges on the *Calendar*. You can view it as:

- A single day (Today/One Day),
- Three Days,
- A Work Week (5 days),
- A Full Week (7 days),
- Two Weeks, Three Weeks, or Four Weeks.

You can change the number of days displayed simply by selecting one of these options under *Appointments* in the *Folder List*, *Button Bar*, or the *Folders* menu. Here’s a simple layout showing the options just discussed:

![Calendar layout](image)

The number of days you choose to display is a matter of preference, your function in the office, and also the size and resolution of your monitor.
Managing The Resources

Another important feature of the Appointment Manager is the ability to display the schedule for any single resource (doctor, room, etc.) or for multiple resources. The dialog shown at the beginning of this chapter shows a display with a single resource, Smith. We can just as easily display the schedule for two or more resources. Below you see an example of a single day with two resources, Smith and Jones:

In this example, Jones doesn’t have any appointments or scheduled activities. Of course, both doctors could have just easily had a full schedule for the day.

So you may be wondering how do you change resources and how do create resources? First, resources include all doctors and any additional resources you create such as rooms, machines, etc. To select a resource click on the Resources command on the toolbar and the following dialog will appear:
Since we are currently displaying both Smith and Jones, they are selected by default on this dialog. As with any other grid display simply select which item you want and select OK. The Calendar will then update to show the appointments for the resource you select. You should have at least one resource selected – otherwise you won’t be doing very much!

If you want to add another resource select Edit Resources from the Select Resources dialog. To go directly to Edit Resources from the Appointment toolbar use the drop down menu item Edit Resources. In either case, the following dialog will then appear:
Now you can edit your current resources, create new ones, or delete them if you wish using the DELETE key. To enter or edit a resource you need to understand only a very little regarding this dialog. First, the Type field allows you to choose from Doctor, Room, Machine, or Other via a drop down list. If it is important for you to include rooms or machines (like x-ray machines) in your schedule you can do so here. Other provides you a means of scheduling nurses, technicians, etc., whatever you feel needs to be included in your scheduling to make your office run smoothly.

The Phone field allows you to enter a phone number, if appropriate. The Resource/Last Name field allows you to enter the description or name of the resource (usually the doctor’s last name). The remaining fields are self-explanatory.

As you can see, there’s really not all that much to selecting and editing resources for scheduling. How you choose to use them in your display depends largely upon your preferences and job function.
Using The Months Display

By default the Appointment Manager starts on the today’s date. Again, depending on your job function you may only be concerned with today’s appointments (i.e. who you will be seeing next). However, if you’re scheduling appointments, or trying to plan a vacation around some slow time in the office, you’ll need to be able to conveniently move to a day months from now. The Months command on the Appointment toolbar allows you to easily navigate to a different day. Select the Months command and you’ll see the Calendar and Appointment List will be augmented to the right with a display of months.

To change to a different day simply select the day you want from the months display with a single click. That day will then be brought into focus on the Calendar and the appropriate appointments loaded. The day will be shaded in light gray on the months display. You can always return to Today’s Date by simply selecting Today from the Months display. If you select with a double click then the day will also be loaded directly into the Date field of the Appointment Editor.

To change the months displayed you can click on the left and right arrows on either side of the top month displayed (in this case, on either side of December 2003). You can change the year associated with the month display by single clicking immediately to the right of the year (2003). A pair of widgets will appear from which you can change the years forward or backward as shown here.
Any special days, such as holidays you have defined (more on this later), will be marked on the months display by bolded dates (such as Christmas in this example).

Using The Appointment Editor

The Appointment Editor is the focal point for editing appointments. This is where you can change the provider (or resource, they’re used interchangeably), patient, and other appointment information. The editor is comprised of six basic sections: the toolbar, the Appointment Editor, Colors, Daily Recurring Appointments, Weekly Recurring Appointments, and List Filters.

The Toolbar

The toolbar, which is really only half of the Appointment Manager toolbar, has four commands: New, Save, Add/Edit Patient, and Refresh. The first command is the New command and you select this to inform the system you are creating a new appointment, not editing an existing one. This is very important because it is sometimes difficult for the system to discern when you are editing an appointment as opposed to creating a new appointment. If you select a different patient from the drop down list you are by default creating a new appointment. If you load an existing appointment from the calendar (we’ll discuss how you do this shortly) and want to make a new appointment for that patient then you must select the New command; otherwise you’re editing that appointment. Selecting New every time you want to create a new appointment (just to be sure what mode you are in) is not harmful.
The Save command, which has a shortcut of Ctrl+S, will save the appointment and update all appropriate views. Using Ctrl+S is usually the most convenient and customary method as most software on Windows uses this key sequence to save data.

Add/Edit Patient is a command button and also has a drop down list.

Selecting the command itself will invoke the patient account in one of the two modes. If the Patient fields are filled then you will find yourself editing the patient’s account. If the Patient fields are blank then you will be in the patient account ready to create a new patient. Obviously the pull-down items behave as you would expect regardless of the Patient fields in the Appointment Editor.

The Refresh command should be used whenever you have entered new patients or you are working in a multi-user environment. In a multi-user environment you will have to use Refresh for the Appointment Manager to be kept current with the database so you can see what is happening on the schedule. Even if you are a single user office and you add a new patient, you must use the Refresh command for the new patient to be visible to the Appointment Manager module. This will change in the future and will no longer be necessary.

The Appointment Editor

The Provider is loaded by default from the Calendar when selecting a time slot. However, you can select any provider you wish using the drop-down list as well.

The Patient # and Patient Name fields are used to show or select the patient using either method, name or account number. A drop-down Find dialog is presented in either case.

Home Phone and Work Phone are informational fields making it easier for you to contact your patient on short notice.

The Description field is a free format field where you can enter any information you wish up to a 80 characters. Usually you would enter the reason for the visit. You can key in text or select from your pre-defined Appointment Reason list using the associated Find dialog (see Helpers for more information on this).

The Date is the date for the appointment. You can key in the date, select it from the drop down calendar, or select it directly from the Calendar (more on this shortly).
The *Start Time* and *End Time* fields represent the time of day for the appointment. You can enter these in as 8:15 (understood as 8:15am), 8:15am, 8:15pm, or select the time from the *Calendar*. The *Duration* field is informational letting you quickly see that you have the times set right (i.e. a 30 minute appointment is not a 3 hour appointment).

The *Status* field allows you to define the appointment status (obviously) via a pull-down list. The list is shown in two parts below with all available options:

<table>
<thead>
<tr>
<th>Status</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduled</td>
<td>New Patient</td>
</tr>
<tr>
<td>Checked In</td>
<td>Walk-In</td>
</tr>
<tr>
<td>Checked Out</td>
<td>Cancelled</td>
</tr>
<tr>
<td>New Patient</td>
<td>Late</td>
</tr>
<tr>
<td>Walk-In</td>
<td>Missed</td>
</tr>
<tr>
<td>Cancelled</td>
<td>Rescheduled</td>
</tr>
<tr>
<td>Late</td>
<td>Usually Late</td>
</tr>
<tr>
<td>Missed</td>
<td>Reserved</td>
</tr>
</tbody>
</table>

The *Status* can be directly linked to colors to facilitate your visualization of the schedule at a quick glance, as well as user specified time frames for each appointment status. This is controlled via the *Calendar Options* dialog discussed in a following chapter. One important thing to note about the values for this field is the *Reserved* value. Using this value does not require a patient or procedure (in fact they are ignored). The purpose of the *Reserved* status is to allow you to block of sections of the day for specific functions, like lunch, meetings, or special types of appointments like physicals. This can be very useful in a lot of ways.

The *Procedure* field allows you to define either the expected procedure to be performed or the procedure that was performed – it depends upon how you decide to use the scheduler.

**Colors**

This section of the *Appointment Editor* allows you to be creative. You can individually colorize appointments changing the color of the *text* and the *background*. The *Time Line* color is rarely used but just for reference, it colorizes the appointment when you choose not to display any text but just the time slot alone (useful in three and four week modes).

You can change the colors by selecting the browser to the far right of the color field as shown in the picture above for the *text* field. The standard Windows color picker will be presented for your selection.

After you make your color changes *Save* the appointment and the *Calendar* will update to reflect your changes.
Daily Recurring Appointments

In those cases where you need to see a patient several days in a row, for whatever reason, you can quickly create a sequence of appointments. You have already defined the initial appointment in the Appointment Editor section above, now simply specify the last day for the sequence of appointments. You can select the last day from the drop down calendar or by using a key in.

Every workday between the dates, inclusively, will have the appointment at the same time with all the same attributes. The recurring appointment will only be generated if you leave this section open; closing the section will disable the recurrence. Of course, you have to select Save for the appointments to be edited.

Caution! Be careful using this feature, there is no simple way to undo this without using the Appointment List.

Weekly Recurring Appointments

The Weekly Recurring Appointments work exactly like the daily option except it works week by week instead of day by day. The Interval specifies the frequency, in weeks, that you want to repeat the appointment by. An interval of 1 means every week; 2 is every 2\textsuperscript{nd} week, 3 is every 3\textsuperscript{rd} week, and so on.
**List Filters**

This particular section is not really pertinent to the editing of an appointment so much as it allows you to control what appointments are listed in *Appointment List*. It is placed here more out of convenience than anything else. The options available are shown in the dialog below:

```
<table>
<thead>
<tr>
<th>Field</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Any, Any</td>
</tr>
<tr>
<td>Provider</td>
<td>[Provider list]</td>
</tr>
<tr>
<td>Date</td>
<td>02/11/2004</td>
</tr>
<tr>
<td>Date Operator</td>
<td>Any Date, Any Date, After Date Shown, Before Date Shown, On Date Shown, On or After Date, On Calendar</td>
</tr>
</tbody>
</table>
```

The *Status* field allows you to filter on any of the status values already shown. It has an additional value of “Any” to allow you to show all appointments regardless of the status.

The *Provider* field simply allows you to filter on any specific provider. It also has an “Any” option to allow you to show all appointments regardless of the provider.

The *Date Operator* field allows you to filter on different date combinations as shown. If you select *Any Date* then all appointments are shown regardless of their date. The remaining operators are all self-explanatory except perhaps the last one, *On Calendar*. Selecting this option will show appointments that only fall within the date range as currently displayed on the *Calendar*. This is particularly handy if you are only interested in the appointments that are going to be arriving today, or perhaps tomorrow.

**Calendar Filters**

This section allows you to filter the appointment calendar instead of the appointment list. The *Facility* field lets you select which facilities appointments will be visible in the calendar. Selecting the “ALL” options for every facilities appointments as well as appointments that do not have an assigned facility.
Using The Calendar

Central to the Appointment Manager is the ability to graphically view and manage your schedule. The MedLook Calendar presents the schedule in much the same way it would be presented in a book. The time slots are shown along the left edge in a variety of increments of time (5, 6, 10, 15, 30, or 60 minutes) with the days along the top edge per resource (doctor). Below is a snapshot of the Calendar with each item defined to allow us to better discuss exactly how the Calendar works:

Most of these fields on the Calendar are self-explanatory so we’ll only look at those that need further discussion. The Forward/Backward arrows move the Calendar through time by the amount of time shown (e.g. 3 days at a time). Clicking the right arrow would move us to:

And so on.

The non-business or “off hours” time can be shaded a different color, in this case a darker yellow, than business hours. This will be discussed more in the next chapter.

The scroll bar works exactly like it does with every other Windows dialog. It allows you to slide up and down on the calendar from midnight (last night) to midnight (tonight).

The little red “+” signs on the bottom of the Calendar display only when there are more appointments scheduled but not currently visible. They can appear in any column at the top or the bottom. Selecting the “+” sign will automatically scroll the Calendar to the hidden appointments.
Selecting Time

Now that we have defined the components of the Calendar we can move along to actually using it. We have already discussed how to select how many days you want to present and what resources you want to work with. In the next chapter we will discuss how to change the workweek (beginning and ending times for each day), the time slot increment and height, and more. Let’s start by making an appointment. To do this, simply drag your mouse over the time you want to make an appointment for. In the illustration below we have selected 10:15 to 10:45 (two 15 minute slots) on 02/10/2004 (Tues 10) for Dr. Smith.

Immediately after letting go of the mouse the Set Time menu item appears allowing you to actually load the date, time, and resource into the Appointment Editor. Use the left mouse button to set the time. Once this is complete you can finish the appointment using the Appointment Editor. Select the patient and optionally select or enter a description, status, and procedure.

Clicking New Appointment will open a patient list which will allow you to search for and select the patient. The appointment and patient information will then be entered into the Appointment Editor where changes can be made if desired.

New Patient/Appointment allows you to enter a new patient and an appointment for that patient in one step. When selected, the following dialog will appear.

Enter the information and click the OK button. The new patient will be entered into the system and the appointment will be set as well.

To complete the appointment for any method, click Save on the toolbar or use Ctrl+S.
If you need to change the time or date, just select a new time as we just did by dragging the mouse over the time you want and select *Set Time*. Save the appointment and you’ll see the appointment move.

*Note*: You can also right click on the selected time to set the time. This does exactly the same thing as selecting the *Set Time* menu item, it’s just not nearly as obvious.
The Right Click Menu

If you right click on an existing appointment the following menu will appear:

You can choose to edit an appointment using the *Edit Appointment* menu item or by just double clicking on the appointment. When you select an appointment to edit the *Appointment Editor* fields will be filled with the information from the appointment. You can then select a new time and date from the *Calendar*, or change any of the fields you want directly from the editor.

If you only want to make a copy of an appointment select the *Copy Appointment* menu item. This is equivalent to double clicking the appointment (selecting it for edit) and then selecting the *New* command from the *Appointment Editor* toolbar.

If you want to delete an individual appointment simply right click on the appointment and select *Delete Appointment* or the DELETE key. If you have password protected (see the application Options for details) the deletion of items you will be prompted for the password. You will then have to confirm that you want to delete the appointment by answering the dialog below.
You can directly enter a patient’s account by selecting *Edit Patient* from the right click menu. This will not load the patient into the *Appointment Editor*. This facilitates entering patient’s charges, collecting co-pay, and printing a bill for them before they leave the office.

To quickly enter a co-pay you can select *Enter Copay* from the right click menu.

From this dialog you can enter the amount, method of payment, and enter a comment in for the co-pay payment. When you are finished entering the information click OK and the co-pay will be applied as a payment. Also from this dialog you can access the X-Charge application (discussed in a separate section of the manual) to process credit/debit card payments.

You are also able to change the appointment status of the selected appointment to any of the statuses listed in the menu. Simply click on the status you want and the appointment you have selected will be changed to that status.
Using Drag And Drop

Drag And Drop is a very common feature in many Windows applications. MedLook’s Calendar supports this feature in a handy way. If you make an appointment and find that you need to move it to a different day that’s visible on your Calendar you can select the appointment and drag it to the new location. It’s that easy. All lists will automatically update after you have moved an appointment.

If you want to make a copy of an appointment, hold the Ctrl key down, select an appointment and drag it to where you want a copy. After you drop the appointment you will have an exact copy of the original with the exception of the date and time fields. This is very handy when you need to see a patient several times in the same week for the same reason. Set your calendar to the week view and make copies of the appointment. You could also do this using the four-week view if you need to have appointments once a week for four weeks, for instance.

If you accidentally select a block of time as shown in the dialog below it is of no consequence as long as you don’t select set the time via Set Time or the right click.

Notice the time spans two days. You probably don’t want appointments like this.
Using The Appointment List

The Appointment List provides one more way to view your appointments, get custom printouts, and edit appointments. This list is displayed in a grid and can therefore be edited like any other grid in MedLook. The contents of the list are completely controlled by the List Filters found within the Appointment Editor as already discussed. Here’s what you can do with the Appointment List.

A single click will move the Calendar and Months displays to the date of the appointment selected. A double click will also load the appointment into the Appointment Editor.

If you right click on the grid you get the following popup menu:

From this menu you can delete the selected patients (yes, you can multi-select and delete more than one appointment at a time!). You can edit the last selected patient (just one more way to get into the patient’s account). You can format the view using the standard view functions we’ve already discussed. Lastly, you can get a Print Preview of the list. This function allows you to quickly and easily generate a customized report of the appointments. Below is the dialog that will be displayed for the Print Preview.
You can customize this display such that you see only those appointments you want using the List Filters and only those columns of data you are interested in using the formatting options.

One nice feature that cannot be underestimated is the ability to delete multiple appointments. Since it is so easy to create appointments, and particularly recurring appointments, the multiple delete is sometimes a real necessity. Let’s say at the beginning of the year you create a daily recurring appointment for your lunch break from 12 to 1pm everyday. In June you decide to move your lunchtime to 11:30am to 12:30. At this point you need to delete all remaining lunch breaks and create new ones. This is really quite easy. First, there is one field in the grid that needs some explanation and that is the Id # (all the other fields are obvious at this point). This field is a key field identifying the actual appointment number. It is a program generated field and has no bearing on how we handle appointments, except in this situation. Since we now want to delete all of these lunch breaks we can set our List Filter to the following: Status – Reserved, Provider – Smith, Date – Today, Date Operator – After Date Shown. Now we can sort by Id #, identify the first and last appointment we want to remove and select all in between, and finally delete them in one keystroke. The Id # simply allows us to sort the list such that other appointments matching the filters chosen will not be intermingled with those we want to delete.
Using The Toolbars

The *Appointment Toolbar* is broken into two parts: the first part is contained with the *Appointment Editor* and the second part is with the *Calendar*. While they are separate they function together. Below is the toolbar.

---

**Printer**

We’re going to take a closer look now at the commands we haven’t discussed yet. Selecting the *Printer* command will result with the following dialog being displayed:

As you can see, you can print *Daily* or *Weekly* reports, for specified date ranges, filtered by *Status*, and for any selection of *Resources*. You can print a separate page per resource or all of them together. If you select *Appointments Only* then only appointments will be printed/displayed. If a *Fixed Time Frame* is selected then only appointments within the specified range will be shown regardless of the default week settings. If neither *Fixed*
Time Frame nor Appointments Only are checked then the time range is automatically determined from the default settings.

You can choose to Display the report or Print it. If you use Display you can still print it and even export it to many other formats. If you were to output it to html you could publish it daily on your internal network for everybody to view, possibly updating it at regular intervals throughout the day.

Delete

The Delete command consists of two parts: Single Delete and Multiple Delete. The Single Delete menu item and the Delete command both do exactly the same thing as the DELETE key as previously mentioned – it allows you to delete individual appointments. Selecting the Multiple Delete menu item gives the following dialog:

This dialog provides you with one convenient method of deleting past appointments. You simply select the date and then Delete Now and all appointments prior to the date you selected will be removed.

Today, Backward And Forward One Day
These commands are self-explanatory. They help you navigate day by day through the Calendar and also return to Today.

Resources

This subject has already been discussed.

Options

Selecting the Options command is discussed in the next chapter.

Months

This subject has already been discussed.
Chapter 25 – The Bells and Whistles of the Scheduler

This chapter will deal primarily with the Options that are available within the Appointment Manager. Selecting Options from the Appointment Manager toolbar will give you the following dialog:

![Calendar Options dialog](image)

The dialog consists of five tabs: Basic Options, Work Week, Fixed Holidays, Floating Holidays, and One Time Events. The Basic Options tab is always displayed first.

Basic Options

The Basic Options allow you to control colors, time, the text display and a few other items all to be discussed now. Show Time allows you to show what time you want to appear at the top of your calendar. This may not actually be your official office hours. In the dialog below we see that 7am is the first time shown even though it is not during official business hours (which start at 8am).
The *Show Time* field allows you to set the amount of time you want to show for each appointment. Your choices are shown here:

<table>
<thead>
<tr>
<th>Field</th>
<th>Choices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Minutes</td>
<td>15 Minutes</td>
</tr>
<tr>
<td>Selectable Minutes</td>
<td>5 Minutes, 10 Minutes, 15 Minutes</td>
</tr>
<tr>
<td>Interval Height</td>
<td>10 Minutes</td>
</tr>
<tr>
<td>Time System/Type</td>
<td>15 Minutes</td>
</tr>
<tr>
<td>Start of Week</td>
<td>30 Minutes, 60 Minutes</td>
</tr>
<tr>
<td>Show Week Number</td>
<td></td>
</tr>
</tbody>
</table>

The *Selectable Minutes* field is directly related to the *Show Time* field as they must be multiples of one another. For instance, if you select 15 minutes for the *Show Minutes* field then your choices are limited to 5 or 15 minutes for the *Selectable Minutes* field. This field represents how many minutes will be selected when you drag your mouse on the Calendar.

The *Interval Height* is a unit-less measure of height between 10 and 100 representing the height of the *Selectable Minutes* field. All three of these fields just mentioned will take some experimentation on your part to find what works best for you.

The *Time System/Type* field allows you to determine if the display will be in standard 12 hour (civil) time or military time.

*Start Of Week* simply allows you to specify what day is used to display as the first day of the week when displaying in full week mode. Most offices would use Monday.

You can enable the display of the week number (1 to 52) in the caption of the Calendar using the *Show Week Number* field.

The *Show Text* field provides you with the option of showing your text for the appointment in one of three modes. Normally you would use only one mode and leave it at that. This field is directly related to the *Text Template* that is yet to be discussed. Needless to say, the template you choose will be saved with the *Show Text* design option you choose.
You can enable or disable the ability to drag appointments between resources (doctors) using the *Drag Between Resources* field. This is only of any consequence in a multi-doctor office.

The *Show Time Scale Only* field is really only necessary when you are viewing the calendar in the *monthly* view. This enables you to view the appointments but not information about the appointment, giving you just enough to see where appointments are located on the calendar.

You can change the font used to display the appointment details on the *Calendar* using the *Appointment Font* field. Use the browse button to select a font from the list for your appointments.

The *Reset Text To Template* command allows you to reset the *Text Template* to the factory settings in case you can’t find your way back.

The *Text Template* provides you direct control of the content displayed for each appointment on the *Calendar*. By default these templates are different for the *Calendar* depending upon the number of days being displayed. A single day view has its own template, 3 and 5 days share a template, and the week displays share a template. In the template below we have specified a four-line display (discounting any word wrapping).

```
[FirstName] [LastName]
H: [HomePhoneR8] W: [WorkPhone]
R: [Description]
P: [Procedure], [Account]
```

The first line will display the patient as first name and last name. The second line will display “H: “ and the first 8-digits of their home phone, followed by “W: “ and their entire work phone number. The third line will display “R: “ and any description or reason for the appointment. The last line will display “P: “ and the procedure code, a “,”, and then the account number. Confused? Sorry. In an effort to satisfy a multitude of personalities we have extended the flexibility of the system by allowing you to manipulate a limited vocabulary so you can define the format of the appointment that most appeals to you.

The dictionary available for these templates consists of the following keywords: *FirstName, LastName, HomePhone, WorkPhone, Description, Procedure, Status, and Account.*

Whenever you use a keyword it has to be surrounded by a pair of brackets, as [FirstName]. All keywords are case sensitive. The rules used in *Custom Labels* and *Custom Reports* apply here as well. For instance, in our example we show [HomePhoneR8] to represent that we want to display only the right-most 8 characters of the home phone. We could have used [FirstNameL3] to display only the 3 left-most characters of the first name. Experiment, you can also reset to the defaults.
The Color Assignment by Status provides the capability to pre-define the colors for the background and the text for each type of appointment by Status. Be sure to select colors that contrast enough so you’ll be able to distinguish between different Status values and such that you’ll be able to read the text. The Time text box allows you to enter a specified time interval for each appointment status. For example setting the Scheduled status to 00:30 will make all appointments created with a status of Scheduled, thirty minutes long (whenever you specify for it to).

The Work Week

All doctor’s offices are open from 8am to 5pm, Monday through Friday. Well, not really. Because we know this we allow you to specify a typical workweek for your practice. The dialog below allows you to specify the start and end time of each day.

If you don’t work on a particular day, use 12am for the start and end time. You can specify the color you want to use to represent your office hours for any particular day. The default is a flat yellow for all of them. You can also set the color of the caption for the day of the week if it helps you visually understand your calendar better.

Holidays And Other Special Days

MedLook allows you to identify special days such as holidays, birthdays, and other special events. These days will appear as bold dates on the Months display to the right of the Calendar as appropriate. Eventually (in a later release) they will appear in the Calendar itself. There are three types of such days: Fixed Holidays, Floating Holidays, and One Time Events. Below you see the Fixed Holidays display:
These types of holidays always occur on the same date every year, such as those shown. You can add more by selecting the Month drop down list on the first line, then the Day drop down list, and finally entering in a description for the holiday or event. Always press Enter when complete.

The *Floating Holidays* tab provides the display below:

<table>
<thead>
<tr>
<th>Month</th>
<th>Weekday</th>
<th>Week</th>
<th>Occasion</th>
</tr>
</thead>
<tbody>
<tr>
<td>January</td>
<td>Monday</td>
<td>First</td>
<td>Thanksgiving Day</td>
</tr>
<tr>
<td>May</td>
<td>Monday</td>
<td>Last</td>
<td>Memorial Day</td>
</tr>
<tr>
<td>September</td>
<td>Monday</td>
<td>First</td>
<td>Labor Day</td>
</tr>
</tbody>
</table>

Several of the floating holidays are provided with MedLook. These holidays occur every year but not always on the same day. If you need to add more holidays here select the *month, weekday, and week* from the menu when you click on that box and then type in the occasion.

The last tab, *One Time Events*, is shown below:

<table>
<thead>
<tr>
<th>Date</th>
<th>Occasion</th>
</tr>
</thead>
<tbody>
<tr>
<td>02/13/2004</td>
<td>My Birthday! : -)</td>
</tr>
</tbody>
</table>
Section 9 – Using MedLook

Why is this section so far back in the book? Shouldn’t this have been discussed much earlier? Good questions. Up to this point you have been learning how to use the basic features in MedLook. In this section we will pull it altogether and show you three ways in which you can use MedLook in your office. A combination of these methods will probably best fit you and your office.

Before we start into the different approaches to using MedLook let’s discuss some other important features. First, unlike a web-based solution, with MedLook you have all of your data in your office. The security of your data today is as good as it was when you were working completely from paper. Access to your data can only be gained by entry through your office – unless of course you are directly and continually connected to the internet. If you are connected to the internet you should institute a firewall to safeguard your system. If your systems are susceptible to a virus attack, they are just as susceptible to an intruder pilfering your files.

Second, you should regularly perform a backup of your data. Elsewhere in this document database maintenance is discussed. Remember, you should keep an offsite backup current to within at least the last month. A safety deposit box, home firebox, or relative in another city that can hold a CD with your password encrypted zip file of your office files is a good offsite safety.

Lastly, in MedLook it is possible to have multiple patient accounts open simultaneously. In fact, you can have several patient accounts open, their insurance information open, and be making an appointment all at the same time. MedLook is capable of multi-tasking per user because we know that you most likely have to multi-task in your office. It is not at all uncommon to be on the patient’s side of the window only to have to wait while the phone takes momentary precedence. This is multi-tasking and MedLook fully supports it. If you’re not sure MedLook can do something, just give it a try, it most likely can do it.

Chapter 26 – The Folder Driven Office

MedLook consists of folders of data. This is because most of the data you have in your office has been organized into folders ever since doctors started keeping patient records. Using the folder driven approach is probably the simplest way to use it. It is very easy to learn. However, once the learning curve is over it is probably not the most efficient way to use MedLook.

Before we get too far into our discussion we need to understand just a few basic items. First, not all folders are created equal but all folders do serve a purpose and without them you would have a less than completely functional product. For instance, the patient’s folder is the heart of the system for patient data. The patient’s folder lists all of your patients and allows you to manipulate their individual accounts. The Label’s folder allows you to select different means of generating labels (for charts, mailing, etc.). You
may use it all the time or never. Still some people find labels are an essential part of the system. So you can see that the folders can be entirely different in appearance and function.

Some functions allow direct editing of the data, such as the *Helpers*, whereas others allow indirect editing (like the Patient’s folder), and still others don’t allow any editing (like *Labels*). Folders such as the patient’s folder allow you to quickly and simply delete individual records (in this case patients) one at a time or through multi-selection. Use the Ctrl key to make a multi-selection, selecting to the far left on the row widget, and press the DELETE key to delete the items. You will most likely be prompted for a password allowing you the right to delete and then probably one or two additional confirmation dialogs.

Now then, using the *folder driven* approach allows you to move easily between individual patients, doctors, insurance carriers, etc., and down to reports, labels, and billing and even into scheduling. You would typically display the *Folder List*, the *Button Bar*, or possibly both. You could optionally display neither of these and navigate using the Folders menu item but do this only if screen space is very limited. Through the course of your workday you would find and select patients from the patient grid. Enter your payments, charges, etc., close the patient dialog and continue to the next patient. At the end of the day you would select the *Daily Ledger Report* and print and save the day’s ledger. At the end of the month you would select *Billing* and do both patient and insurance billing.

This would be your normal course of work within MedLook and it would work just fine.
Chapter 27 – The Patient Driven Office

This chapter is for the office person who enters a patient’s account at the beginning of the day and only leaves on rare occasions. In the Patient Driven Office everything you do is centered strictly around the patient account. Most likely you would select a patient early in your day, make a payment or two, and move to the next patient. Your day consists mostly of making payments, entering charges, and printing bills. And you do this over and over. Any extra navigation, any extra click or keystroke is multiplied into hundreds of wasted motions each day.

The Patient Driven Office by definition is centered upon the patient account. Here’s how it works. Let’s assume you have a big EOB from some insurance carrier and you need to update all of the associated patient accounts. You start your day by selecting the first patient to process and opening their account. You select the Payment tab and enter the patient’s payments. Assign the payment to the appropriate charge and make any write-offs or corrections necessary. Next you use the Find Patient command (the binoculars and drop-down field on the toolbar) at the top of the patient dialog to move along to the next patient on the EOB listing (remember to mark off those you’ve already processed).

You enter the payment and continue to the next patient. Repeat this process until you have completed all of the payments from the EOB and you’re caught up. Now you can take that well deserved two hour long lunch and go shopping or to the gym. Well, that’s probably not going to happen because things rarely work out like this.

What usually happens is the constant stop and go of interruptions. Interruptions seem to throw a big wrench in to our plans. Often times these interruptions come in the form of a patient waiting at the window. Before they can leave the office you have to enter their charges, possibly a co-pay, and print them a bill before you can resume with your next EOB payment entry. So you select the patient from the list using the Find Patient command, move to the Charge tab and enter the charge. They probably have a co-pay so next enter that on the Payment tab. Finally, you move to the Billing tab and print out a patient bill. Now you can resume with your next payment from two days ago – just in time for the next patient interruption (remember, these are good interruptions, it means money is coming in).

What if you have a patient that has an insurance carrier you don’t already have loaded into your system? It’s easy enough to add or edit any other folder item, including an insurance carrier, without leaving the patient’s account. Just select the New Insurance Carrier menu from the Folders drop-down.
The New Insurance Carrier dialog will display allowing you to enter this patient’s insurance information. When you are done just select OK and you’re back where you were just a moment ago in the patient’s account. If you were just entering a new patient, you should save that information (use Ctrl+S or select the Save command in the upper left of the dialog) before trying to use this new insurance information. Since you just added a new insurance carrier you need to refresh the data in the patient account using Ctrl+R or by selecting the Refresh command, again in the upper left (between New and Save).

**Note:** Whenever you add or edit an item in a folder other than the patient’s account you have to use the Refresh command to reload the data to the most recent values. Before you do a Refresh you may want to save whatever you were working on (particularly if you were entering a new patient and already had entered their address, etc.) as the Refresh will clear any unsaved changes.

If you use the Appointment Manager, or scheduling, component of MedLook, you can create a new appointment for the patient. Select the Appts command (short for Appointments) and the patient’s account dialog will be dismissed, the appointments loaded, and the current patient loaded into the Appointment Editor allowing you to quickly make an appointment. You can easily return to the patient account dialog using the Patient command on the Appointment Editor toolbar, the Patient drop down list menu item Edit Patient, or by using the right click menu item for Edit Patient. All three options are shown below, respectively.

The focus of this section was simply to demonstrate how you can use MedLook by focusing on the patient account.
Chapter 28 – The Schedule Driven Office

Some people prefer to work from an office schedule. Their day revolves around scheduled activities. MedLook provides a really nice, easy to use, and convenient interface that allows you to work from a schedule.

In the view above, the Button Bar and Folder List are both hidden along with all of the application toolbars. The Appointment Editor, Calendar, and Appointment List are the areas of focus. The presentation of each of these areas has already been discussed elsewhere but keep in mind that you can change the width of the Appointment Editor and the height of the Calendar and Appointment List.

Using MedLook in this mode you are mostly concerned with your calendar, the area in yellow, containing the blocked appointments. Depending upon your function in the office you may want to only view appointments for a single day (today), three days, or more. If your job is to handle patients as they are checked in and out of the office, then only today’s appointments would really matter to you so you would use a single day
view. As patients come into the office you would probably want to edit the appointment and change their status to Checked-In. This would allow anybody else in the office, possibly the doctor or someone at another desk, to check today’s schedule and look for patients who are checked-in so they can make preparations, etc. When the patient’s visit is complete, you can edit the patient’s account, enter their charges, collect and enter their co-pay, and print them a bill/receipt. You should also update the patient status to Checked-Out.

If the patient doesn’t show up after a reasonable amount of time you could change their status to Missed.

At the end of the day it would probably be a good practice to compare the appointments that have been marked as Checked-Out with the Daily Ledger Report or User Activity Report. There should be a good correlation between the appointments and the ledger.

If your office still keeps and uses paperwork and delays posting charges until the following day, you can easily view all appointments from the prior day and simply edit each patient and enter their charges. Of course, this applies to any day and can also be used for entering payments as well.

If your job entails scheduling appointments, then you would probably be best suited to work in one or two week display. By viewing whole or multiple weeks, you can quickly and easily determine open time slots and how much time is actually open. Often patients will request appointments during a certain time of day (after 2pm, before 10am, etc.) and with the visualization you get from the calendar you can quickly find a suitable time slot. There are two left/right arrows on the top of the calendar as shown here:

Using these you can easily navigate forward and backward by a week or more. It’s very, very similar to using an appointment book with the exception you are not flipping pages, erasing, scratching appointments out, etc. Plus you can easily move, copy, edit, or delete an appointment. Scheduling appointments doesn’t get much easier than this.

If you use the Custom Report option in the Office Reports folder you can select to list appointments. You can design a report specific to your office for any occasion. Perhaps you want to make a printout of all appointments for the coming day, listing each patient on a separate page, showing the details of their appointment as well as details of their account. Do they still have insurance? What’s their account balance? You can show almost anything you want from the patient’s account.

Of course, you can also make a list of patients who are coming in on a single sheet.

If you do backups regularly (and we know you are), you can periodically delete past appointments (after all, it’s hard to travel back in time for these anyhow). Any time you can remove unnecessary information and pack your database you maintain your database
performance. Over years of data entry the database will eventually become large and slower.

The Appointment List below the Calendar can be really handy for just about anybody in the office. If you only want to know about pending appointments, simply set the List Filters within the Appointment Editor section to select appointments for any status, any provider, any patient (just clear it), using today’s date, and with the Date Operator set to On Date Shown. This will show you only today’s appointments. By periodically using the Refresh option on the Appointment Editor toolbar you will be able to see how the schedule changes throughout the day and make adjustments accordingly.

If you work in an office with multiple users entering and editing data, you will need to periodically use the Refresh command on the Appointment Editor toolbar to update your display. Also, if you choose to create a new patient you will need to refresh the appointment information so that patient will become available.

To wrap things up, you can see almost everything you do throughout the day can be done from the scheduler. There are some exceptions. Batch Billing, Office Reports, Office Labels, and Helpers all require that you leave the Appointment folder and move to the respective folder for these other actions. As you become more familiar with MedLook you’ll see there are many, many more things you can do than just these simple things outlined here. This is just a good starting place to get you going.
Section 10 – The CMS/HCFA 1500 Form

The CMS/HCFA 1500 form (both old and new NPI format) is central to all of the insurance claim processing. In this section we will look at editing the 1500 form layout files (positioning and display of all data items).

To print test pages or generate test claims files it is easiest to use the CMS Test Print Page utility. This is discussed elsewhere in this document.

Chapter 29 – Selecting And Editing Layout Files – Getting Started

In this chapter we will discuss how to install, configure, and use the XML Notepad program as the MedLook Layout editor.

To begin we need to go to the MedLook home page (www.remsys.com). Next select Downloads. On this page select the XML Notepad.exe link to begin the download process.

Save xmlnotepad.exe to your desktop.

Dismiss your browser and then double click on the xmlnotepad.exe file on your desktop and install the software. After it’s installed you can delete the file from your desktop.
Next, start MedLook and select Tools->Options.

The Layout Editor (last item in Misc. Options) should be set to c:\program files\xml notepad\xmlpad.exe. This configures MedLook to invoke XML Notepad when editing any layout file. Do not key this in as you may easily make a mistake but rather browse to the file.
Next, select a patient’s account that has insurance and go to the Billing tab. On the lower left side, under the HCFA Options, there are two menu items. The first is the name and location of the layout file to use and the second is a command to edit the selected layout file. You most likely will not be able to see the entire path or filename in the area provided. To see the hidden parts just place your cursor in the field and arrow left or right.

By default your filename is probably something like `c:\medlookdata\cms1500formats.xml` or, as in the case shown, it might be in the product folder as `c:\program files\rem systems\medlook\template\cms1500formats.xml`. In either case, let’s edit the layout currently displayed. Just select the Edit Layout command.
The dialog shown below starts up. This is actually XML Notepad and it’s editing cms1500formats.xml.

This is a VERY simple editor. On the left hand side, under the column titled Structure, you see Data, then Comment, Electronic, Paper, and a bunch of Comment lines. The right hand side has a single column labeled Values. We’re concerned with the two sections: Electronic and Paper. Electronic contains all of the parameters controlling the layout of electronic claims while Paper is for printed claims. Let’s assume we need to edit the output claims filename and location.
In the dialog below you see that we have opened up the Electronic section (by clicking on the + symbol to its left) and have highlighted the data in the Values column to the right of Claims-File1. At this point you would enter the complete path and filename you want to use for your primary output claims. There is no validation during this process so use some care in specifying a valid path and file.
After changing the data we need only to save the file. In this case we are going to save
the data to a new file so we don’t disturb the original in any way. Use the File->Save As
menu item and put the file in either a new folder or a new name. In the example we are
putting the file into Customer2, a folder containing the MedLook database for
Customer2. The filename remains as Cms1500Formats.xml, but it could be changed to
almost anything.
Since we saved the file in c:\customer2\cms1500Formats.xml we need to direct MedLook to look in that same location. In the Layout field simply browse or enter c:\customer2\cms1500formats.xml. Browsing will bring up the dialog shown below.

The next time claims are generated it will use this parameter file. It’s that easy to get started.

**Supporting Multiple Printers.**

As no two printers seem to have the same top and left offsets you can also create layout files per printer. Do the same as we have done above but create a file per printer. When you switch printers simply direct MedLook to the appropriate layout file.
Chapter 30 – The CMS/HCFA 1500 Layout File

The CMS/HCFA 1500 form is central to insurance claim processing. At this time most clearinghouses still prefer/require the old 1500 format (pre-NPI) whereas most carriers that process paper claims require the new 1500 (NPI-ready) format. The following 1500 form is the old format.
1500 LAYOUTS - EDITING AND DEFINITION

The insurance layouts have two sections: *Electronic* and *Paper*. Additional sections can be added but these two MUST be present and their names are case sensitive. If you need to experiment with a section but don't want to completely get rid of the current values you can easily duplicate an entire section. Right click on the folder icon to the left of either of these sections and select Duplicate. You can then rename the duplicate (e.g. PaperDup) so you can retrieve it later if needed.

**ELECTRONIC ALIGNMENT**

The *Electronic* section considers all Top, Left, Width, and similar fields in regards to characters. The range for Left is from 1 to 80 characters (1 being the far left and 80 the far right). The Top ranges from 1 to whatever NumLines is set to. This value cannot exceed 66 though. Basically an electronic page cannot exceed 80 characters wide by 66 lines. The page can be shortened by setting NumLines to some value less than 66, typically 62 or 63. Top starts with 1 at the top and NumLines down the page.

The *Electronic* section allows you to move the Top and Left of each item by a single line or character. You can move all the data fields by altering the Top and Left fields that appear as data elements of *Electronic* (you should edit these using XML Notepad as mentioned above). You should not set either of these to a value less than 0 (that just doesn't make sense). Additionally, this is where you define how many lines are in an electronic claim (usually 62 or 63) and also the three claims files used to store the generated claims (Claims-File1, 2, 3). You should provide a full path as c:\claims\claims.txt or something similar.

**PAPER ALIGNMENT**

The *Paper* section measurements are all in regards to hundredths of an inch (0.01 inches). The Top is 0.00 and the Left edge is 0.00. The bottom right corner would have Top = 8.50 and Left = 11.00 for an 8.5 x 11 sheet of paper (a typical 1500 form). Since each field can be controlled to within 0.01 inches every item can be placed in near perfect position on the 1500 form. To move the equivalent of one character horizontally change the Left value by 0.10 (roughly 8.5 inches divided by 80 characters). To move the equivalent of one line vertically, change the top value by 0.17 (11 inches divided by 66 lines).

**1500 LAYOUT DEFINITION**

If a field appears as a boolean (yes/no, true/false) type of field then generally a 0 is false, and anything other than a blank or 0 is true. You should use 1, or True, to denote a true value. For instance, Box24aCopyFromIntoTolfEmpty is 0 (false) if you do not want to automatically copy the data from box 24a “from” into
the "to" data field if the "to" date field is empty. If you do want to automatically copy it, then set the value to 1.

Likewise, Box13PrintSignatureOnFile is generally 1, meaning you do want to print the Signature On File in box 13.

Beyond this each area of the 1500 claims form is logically grouped by its area. For example, Box1 has the following elements: Medicare, Medicaid, Champus, Champva, GroupHealth, Feca, Other, alnsuredsId. These are all elements anybody working with the1500 form should be very familiar with. There is nothing new here. Each of these elements in turn has attributes for Top, Left, Width, and Visible. In general you would want to leave the Width blank (automatically determined), Visible is generally 1 (you want to print it if appropriate), and the Top and Left should be set to their proper position in the file to appropriately fill their respective areas.

FORMATTING 1500 FIELDS

Formatting the data allows for a great deal of flexibility. Let's look at formatting dates first. Box 3 has a DOB field. The additional field is Format. Normally it would be something like "mm dd yyyy" to print 2-digits for the month and day and 4-digits for the year with a space separating each field. If you needed no spaces and only 2-digits for the year you could use "mmdyy". There is a lengthy section of comments in the layout file giving further formatting details for dates.

Formatting phone numbers is very flexible. Typically you may want to have the area code separated by a space followed by the 7-digit local number. You do this simply by setting the Format to "@@@ @@@@@@@@@". The @ sign is used to print a character in this position starting from the right. Alternatives include, but are by no means limited to:

"(@@@)@@@ @@@@@@"  
"@@@.@@@.@@@@@@"

Formatting numeric fields. To provide the greatest flexibility, all numeric fields (box 21 codes, $ fields, etc.) use the same strategy as phone numbers. Here are a few examples of how to format $12345.67:

@@@ gives 1234567 (no spaces or decimals)
@@@.@@ gives 12345.67 (a decimal/period included)
@@@ @@ gives 12345 67 (a space included)

Sometimes printing requires filling from the left, not the right, as in printing Box 21 codes. In this case the last character should be an "!". For example, a typical format may be @@@@@@@!. Here are a few examples using "@@@@@@!":

If the value is 123.00 the output is "12300 
If the value is 123 the output is "123 
If the value is 123.5 the output is "1235 

181
SPECIAL FIELDS/BOXES

Box 5 Phone. There have been requests in the past to allow for determining which phone number from the patient data prints in this field. To allow for all possible combinations the following fields have been added for this box:

None
WorkOrHome
WorkFirst
WorkOnly
HomeOnly

If None is true, then nothing is printed.
If WorkOrHome is true then we follow these rules. If WorkFirst is true AND there is a work phone number then the work phone will print; otherwise the home phone will print. If HomeFirst is true the opposite rules apply. If neither number is available nothing is printed.
If WorkOnly is true, then only the work phone number will print.
If HomeOnly is true, then only the home phone number will print.

Box 24 has six (6) lines. Each line and each field in the line must be edited individually. The Top values for each line should be constant throughout the line (at least that makes sense). Still, you cannot change only one item and expect the rest to "follow" it. Each item must be changed individually.

Box 14 Type. Recently there has been a request to print textual information in box 14 to the right of the red triangular widget to clarify the data entry. If this box is set to true (1) then the following information will print:

I if Illness,
LMP if Pregnancy
A if accident

Box 17 ReferralNPI. The new field is printed using this field.

Box 24 Use Space. The Box24UseSpace parameter within each section allows for printing the modifiers with a space (enabled, or true) or without a space.

Box 24 Line 1...6 dCPT/dModifiers. By default the modifiers will print as necessary with the CPT values. However, it is possible to control the format of the modifiers separate from the CPT values. If the modifiers are enabled (visible set to 1) then the CPT width should be shortened to the five (5) character field width required for the CPTs.

Box 24 Line 1...6 NPI. This field is available and ready. The field directly above it is used for the old numbers and additional qualifiers.
Box 24 Line 1...6 cTOS/iEMG. On the new 1500 form the TOS field is no longer available and the EMG field has been moved to this location.

Box 24 Line 1...6 xTrNum. Typically this is not used but if the transaction number is required to print for each procedure, this field can be included just as any other field.

Box 32 NPI. This field is available and ready.

Box 32 Phone. This field is typically turned off but is available if required.

Box 33 NPI. This field is available and ready.

Box 33 Phone. The phone number on the new 1500 form appears on the first line of box 33.

More. Within each section it is possible to also include a More section. This section currently includes an SSN field to include the patients SSN if necessary. So within the appropriate section there needs to be a section added called More with a sub-section called SSN. The SSN field will be like any other box having a Top, Left, etc., data field.

Parameters. At this time there is only one parameter that spans across both Electronic and Paper claims. This parameter can be entered into a separate section at the same level as Paper and Electronic. The section name is Parameters and the parameter is NumberOfClaimsPerPage. By default this is six (6) to default to a CMS 1500 form but it can be increased. If you need 10 lines per claim then in box 24 there should be “Line1” through “Line10” with each Line having the appropriate data. See the template named CmsC19Formats.xml for an example.
XML NOTEPAD

Using XML Notepad has some real advantages. For instance, all the items on any one of the box 24 lines can be quickly changed to a new value by using the Edit Replace feature and selecting Content in the Search In boxed area. Simply enter the first value (The Top of Box 24 Line 1 aFromDate) and Search and Replace like you would in any other document (replacing all of the remaining Top values only for Box 24 Line 1). Exercise care when doing an operation like this to make sure you are only changing the values in the boxes intended. Similar operations can be performed on vertically aligned fields. For instance, changing the left value for items in boxes 2, 5, 9, 17, 19, 25 and 31 can all be done very quickly. Simply select the left value in Box 2 Patient Name and begin Search and Replace on matching values, replacing with your new value. This was impossible with the older dialog.

DEFAULT TEMPLATES.

Default templates can be found in

```
c:\program files\rem systems\medlook\template.
```

These should not be overwritten. Additionally it is not recommended to point to these layouts for regular usage as software updates may overwrite these. If these are by some accident corrupted, there are copies of the originals in the template\defaults folder. If these are additionally messed up then the only recourse to recovering these files is to copy them from another computer, re-installing the software, or emailing us for the defaults. The defaults will eventually be posted to our website as well.

NPI CHANGES FOR THE CMS 1500 REVISED FORM

In providing for the NPI fields changes have been made to the following dialogs: Edit Doctor, Edit Referral, and Edit Hospital. Each of these now includes the NPI data field. None of the other items have been removed and will remain until they become obsolete (probably in MedLook 4.0).

In addition to entering the NPI fields you must set the HCFA Options::Layout for insurance claims to point to an NPI enabled layout file. Default files are provided in c:\program files\rem systems\medlook\template as CMS1500NPI.xml and Cms1500npiPaperOldElectronic.xml. The first file uses the NPI format for the Electronic and Paper sections. The second file uses the NPI format for Paper and the old CMS 1500 (non-NPI) format for Electronic claims. This second file is convenient at the moment as most clearinghouses still require the old format of the Print Image while carriers are requiring the new format on paper. Furthermore, when you display the claim in the HCFA/CMS 1500 Preview (View
eClaims) a NEW button is available. If you select this button the new NPI-ready 1500 form is displayed (regardless of the layout).

Primarily the NPI changes include:
- Box 17 a/b - UPIN & NPI
- Box 24 c - TOS has been dropped, EMG is now in box c
- Box 24 e - pointer to box 21 only, no more codes allowed
- Box 24 i - top is for special coding, etc.
- Box 24 j - top for old 24k info, bottom for NPI
- Box 24 - top of a-h for supplemental information.

To enter this information the Charge comments must begin with an "!".
- Box 32 a/b - NPI and old info
- Box 33 - phone number is above all other fields in new position
- Box 33 a/b - NPI and old info

Also worth noting is that if you display the old form with the old layout the items in box 33 will appear to be lower than they used to be. In fact they are not. The old background 1500 image was stretched in this area and MedLook had to compensate for it. Since MedLook now supports both the old and new form it cannot make exceptions for the old form. The data is still in the right place in the file but looks out of place on the form. Of course, you can move the fields up if you wish.
Section 11 – More Helpful Features

This section includes the kitchen sink. There are lots of little and not so little features provided in MedLook intended to make your job easier. Once you have grasped everything already discussed you are ready to really start putting the program to work for you. In this section we will help you do just that.
Chapter 31 – The Helpers Folder

MedLook's Helpers allow you to manage several lists in the program that facilitate rapid data entry. These lists include zip codes, case codes, payment and charge comments, and appointment reasons. To enter a new item, key in the data in the top row of the grid. Press the Enter key to place the new row in the list of existing items. To edit a cell, click that cell. To delete an item, select the row along the left edge where the right pointing black triangle appears and press the DELETE key on the keyboard.

Zip Codes Helper

The Zip Code Helper allows you to manage zip codes that appear in drop down lists for data entry. You can add, edit, or delete items in the list. You can have one zip code for one or more cities and you can have several cities with the same zip codes (because these places really do exist). In the zip code pull-downs (particularly in when editing a patient) these entries will appear but perhaps not in the order you might expect. To facilitate rapid data entry the zip code, city, and state are presented by order of most frequently used to least used.
Case Code Helper

The *Case Code Helper* allows you to add, edit, or delete ICD9 Cases that may be used when entering charges. The patient “Cases” are only helpers and are not strictly required, i.e. you don’t have to have them or use them. The intention is to provide you a means of creating a method of quickly entering ICD9 codes for those situations you most frequently encounter in your office.

You can enter any text that helps you identify the case and select from one to four codes for the case. If you select an account number then the case is specific to that patient. For Billing Master customers who have upgraded they will have one case per patient called “Initial”. Leaving the account number set to 0 means that the case is generic and will appear in the list of cases for every patient. Obviously if you create a case specific to a patient then when you list the cases in the patient charge dialog only generic cases and cases specific to the individual patient will be listed. Generally a long list of cases, especially generic cases, would not be very helpful. If you use the *Case Code Helper* wisely by considering what codes you use most frequently use you can save yourself a considerable amount of time when entering charges.
Charge and Payment Comment Helpers

The *Comment Helpers*, for payments and charges, allow you the simple means of creating a list of comments specific to charges and payments that you repeatedly use during the patient encounter. When entering a payment or charge you can choose to enter an entirely new, free format comment simply by keying a comment in or you can select a predefined comment from the list you create here. Many times you may want to include a simple comment such as “paid at window” or “billing parent.” Again, keeping the list relatively short will make it that much easier for you to use and therefore save you more time.

Editing existing items is very simple. Just click in the field and edit the text the way you want it to appear. To delete an item entirely click to the left edge where the black triangle appears and press the DELETE key.
Appointment Reason Helper

The Appointment Reason Helper allows you the simple means of creating a list of comments, reasons, or descriptions specific to patient appointments that you repeatedly use during the patient encounter. When entering an appointment you can choose to enter an entirely new, free format comment simply by keying a comment in or you can select a predefined comment from the list you create here. Many times you may want to include a simple comment such as “annual check up” or “tetanus shot.” Again, keeping the list relatively short will make it that much easier for you to use and therefore save you more time.

Editing existing items is very simple. Just click in the field and edit the text the way you want it to appear. To delete an item entirely click to the left edge where the black triangle appears and press the DELETE key.
Chapter 32 – The View Menu

Appearances are everything. Well… not really but obviously they do matter because we spend a lot of time on our personal appearance every day. In MedLook we have designed what we think is a very appealing product. However, we know that “beauty is in the eye of the beholder.” With this in mind, we have designed the program to allow you to customize, personalize, and otherwise organize the appearance of the program. The View menu is your first step towards this end. In fact, you can so drastically modify the appearance of the program that even we would have a hard time recognizing it as our product (no kidding!).

The View Menu is one of the main tools at your disposable to customize the screen display. The menu is broken into four basic sections: view type, formatting, navigation aids, and toolbars and status bars.
View Type

The view type gives you two options for viewing your screen. The first is a table view, as shown in the first dialog below, and the second is a card view, as shown in the second dialog below.

**Table View**

The table view presents data in row and column format much like a spreadsheet. Virtually all of the attributes of this view can be modified. You can display with or without grid lines, with a single color or alternating colors, different font sizes, etc. We will discuss formatting the display in more detail shortly.
Card View

The card view presents the data more like a ticket or a printout. Again, this display can be completely customized.

As you can see, the table view and card view can contain the same information but look very different.
View Formatting

Formatting a view can easily be done using any combination of the commands in this section. Each of these commands can be accessed from the right click menu on any grid (except the Find grids).

Show Fields

Select View-> Show Fields to view the following dialog.

![Show Fields dialog]

This gives you the ability to order the fields in any grid in the order you want them to be presented. Use the Move Up and Move Down buttons to place the field in the desired column order of the grid. You can also add or remove any fields by highlighting them and then clicking the Add or Remove buttons. Click OK to save your selections.

You can also reposition the display order of any grid column simply by grabbing the column header with the mouse and dragging it to the location you desire and dropping it where you want it to be.
Sort

The Sort dialog, as shown below, allows you to choose which items you want to sort and in which order. Select an item from the lists and select either Ascending or Descending. Practice with a few different ways and then decide what works best for you. By selecting Clear All all sorting will be removed. You can select to sort by up to four columns (such as state, city, last name, first name). You can also click on the column header of any grid and quickly sort by just that column. A triangle will usually appear (if there is sufficient room in the column header) to the right of the column caption indicating that the grid is sorted by that column. The triangle will be pointed up or down to indicate ascending or descending sort order.
Group By

The *Group By* dialog, as shown below, allows you to choose which items you want to group and in which order. Select *View* -> *Group By*. Select an item from the lists and select either *Ascending* or *Descending*. Practice with a few different ways and then decide what works best for you. By selecting *Clear All* all grouping will be removed.
For grouping columns select View -> Group by Box to display an area that you will be able to drag column headers into so you can group by that column. Below is an example of the columns grouped by last names, then by patient number, then by first names.
Format View

So far we’ve show how you can hide and show fields (columns), sort, and group data in a grid. Now we’re going to learn how to really change the way your data appears in a grid.

Select View->Format View to bring up the following dialog when you are using the table view.

This dialog gives you the options to change fonts, colors, and whether or not you want grid lines. You can change the grid line style and shade group headings. You can change the background colors in the Grid Cell Area, Non Cell Area, Header, Group By, Info Text, or Group Rows. Uncheck the Alternate Row Colors to activate the background color. You can return it back to its original color layout by clicking on Default in this dialog or canceling this dialog and going to your toolbar selecting View->Defaults (discussed later in this chapter).

You can change the column heading fonts as well as the fonts for the row data. Headings can be underlined or struck out by checking the appropriate box in the Font selection.
window. You can choose to hide or show grid lines by changing the Grid Line Style. The best way to learn this dialog is to experiment (learn by doing).

You can also choose to enable or disable the Show Record Navigator option. Enabling this option brings up the records tab at the bottom of the grid. The Record Navigator shows what record number is displayed and how many records there are in the grid.

The Show Group By Box is just one more way to enable or disable the display of the Group By Box as in the View->Group By Box section.

You can also change the size of the row items in the grid by checking the Allow Row Sizing option. Once enabled you can grab a row item and stretch it to the height you want. This is particularly useful if you choose a larger font for row item data. Unchecking this box and then clicking on the resize tab returns the grid to the default size.

If you are working in Card View almost everything works the same for formatting as it does in Table View.

View Summary

The View Summary menu item presents the same options as presented from View on the tool bar. From this you can choose what information you want to view on your grids and how you want it to be formatted. This dialog just saves you the time of traversing the menu to go from one selection to the next and also gives you a quick summary of what each is currently set to.

Once you have sorted your groups you can expand and collapse them by clicking Group By in the View Summary dialog and using Expand/Collapse, by double clicking on the top of the dialog just above the grid where the folder name and number of items appears, or right clicking in the grid and selecting Expand/Collapse groups.
**Defaults**

This option provides you a simple method for returning to the factory settings of any grid or subsystem of grids.

After experimenting with the view formatting options and you decide you don't like what you have chosen but you cannot figure out how to undo all the changes you have made you can return to the original formats of all views by selecting *View-* > *Defaults.*

Select which layouts you want to retrieve. You can select more than one at a time by holding the *Ctrl* key and selecting items with the mouse. Click *Apply* and your setting will be back to the factory settings.

**View Navigation**

A big advantage of MedLook is the diverse means by which you can navigate between folders. Like Microsoft Outlook, MedLook has a Folder list and a Button Bar as two primary means of navigation. You can also navigate using shortcut keys and the Folder menu item on the application menu.

Each of the items in this category have been covered very earlier in this book and will not be repeated. You should note that you can easily show or hide each individual item using the *View* menu.
Chapter 33 – Program Options

One of the first places you look in any Windows program is the Options dialog just to see what you can do. You will almost always find something in the Options dialog that allows you to do some sort of customization that is particular to your preferences. The same holds true for the MedLook Options.

Preferred Locale

This option saves you the time of repeatedly entering the same address of new, local patients. The most commonly used city, state, zip code, and area code are set to appear as the default in their allotted address fields when entering a new patient.

Misc. Options

Window Options: Choose how you would like your dialogs to appear on the screen. Choose between Center of the screen, Center or the upper left of the Application, or Cascading on the screen. This applies to new/edit screens within each folder.

Start on Reboot: Selecting Yes will allow Medlook to automatically start when you start your computer. If you normally start MedLook first thing when you boot your computer, you will probably want to set this to yes.

Read Database on Startup: Checked by default. When unchecked this will cause MedLook to run without loading a database. Uncheck this only at the recommendation of technical support.

Check Database Integrity: Checked by default. This forces MedLook to validate the database tables to make sure that all tables and fields are present along with the proper indices. This option can add a few seconds to the startup but it is well worth the time to
ensure that your database is still reliable. For offices that have their data local to the computer or have high performance servers, fast computers, and a fast network their will be very little negative impact from this feature.

*Verify Diagnosis Codes:* Checked by default. This option allows MedLook to do a minimal amount of claims scrubbing based upon the diagnosis codes. When creating diagnosis codes there is a flag to indicate if the code is valid for insurance claims.

*Include Valid Procedure Codes Only:* Checked by default. This option is very similar to the one above. When editing procedure codes there is a flag to indicate that the code is valid for insurance claims.

*Space Between Modifiers (Box 24D):* The insurance claims layouts can better handle this option by individually placing each modifier on each claim’s line. However, if the modifiers are set as invisible in the layout they will print with the procedure code and then this option is useful.

*Check Screen Resolution on Startup:* When checked, this will warn you if your computer monitor’s resolution may be set too low to properly display MedLook.

*Show Item On Startup:* If checked, this instructs MedLook to automatically open back in the same item it was last in. Typically this would mean it will automatically open up into the last patient edited (but it could be insurance, etc.).

*Show Folder Title:* Toggles the title of the selected folder just below the tool bar area.

*Report Shading:* By default reports contain various forms of shading and coloring. Unchecking this box will cause all reports to print as plain text. You would want this unchecked if you want to save on ink or toner.

*Auto Pack & Reindex:* When checked this will automatically perform database maintenance at prescribed intervals. Enter the number of days between packing by selecting the interval from the Days Between Packing drop down list. To effectively pack the database you have to have exclusive rights to the database. You should do this during non-business hours.

*Show Compression Status:* This goes hand in hand with backups. If checked MedLook will display more information as a backup is being performed. You’ll actually see a list of files scroll by as they are being compressed during the process. This is helpful in letting you know how much more processing remains during backups.

*Exclude Reprint Folder on Backup:* Checking this box will cause MedLook to skip the reprint files during backup. This, of course, will make your backup file smaller.
**Daily and Weekly Autobackup:** When checked this will automatically perform a database backup at the prescribed interval when you start MedLook. Key-in or browse for a folder to set the *Backup Folder* where you want the backup created.

**Layout Editor:** Blank by default. This should be configured to point to XML Notepad or some other similar XML editor. This editor is used to modify the billing and insurance layouts.

Below is a screenshot of the *Options* dialog with the *Misc. Options* section open.

![Options Dialog](image)

**Patient Account Defaults**

*Managed Care:* Choose from 0 to 4 using the drop down list. This will cause MedLook to warn you when your managed care patient’s remaining visits are fewer than the number you select here.

*CLIA #:* The CLIA # can be entered here to appear as the default when filling out information about a doctor's patients.

*Allow Patient Transaction Edits:* Selecting *Yes* will allow you to edit transactions in the
Patient Summary. Not all fields per transaction will be enabled for editing but those that are necessary to correct the transactions (such as amount, comment, Ins 1, Ins2, Ptnt, Other – poke the cells to see if you can edit them).

Auto-Save Notes: If enabled and the Patient Notes are edited using the built-in MedLook wordprocessor then the notes will automatically be saved (just like the QuickNotes are always saved automatically).

Auto Payment Comments: If checked will enter the Payer name (Medicare, for example) in the Comment field when entering payments.

Prompt on Changes: Selecting Yes (the default) enables MedLook to notify you of unsaved changes when leaving the Patient Edit or Patient Charge dialogs.

Notes Editor: You can select the word processor you prefer to use as default to edit patient notes. The list of word processors includes MedLook (the built-in word processor), WordPad (the simple free version on any Windows system), and MSWord (if you have MSWord installed). The editor you select must be able to handle Rich Text Files (*.rtf). A user-defined editor can also be defined using the Programs Add-In Manager. Simply name the new Program as "Notes Editor" and browse for the editor you prefer to use (such as WordPerfect or Microsoft Works Word Processor). After doing this the "Notes Editor" will also appear in the list of word processors available.

New Patient Default Settings: The fields in this section correspond to fields in the Patient Edit dialog. Here, you can set defaults for these items to your preference, for example, Marital Status. If the vast majority of patients you enter will be married, you could set this to Married, and thus not have to change it while entering most of your new patients. Patient Status, Title, Employment, Marital Status, and Student Status each contain a default list. You can add your own items to these lists. Just separate the items with a comma and type them in the box somewhere in the list. If you want nothing as the default then enter a comma as the first item. Some items are yes/no type defaults such as Add Interest. For these boolean data types simply select the default that best fits your office.

Include Notes Header: Selecting Yes will include the patient's name and address as a header on their notes. This is useful as the notes are stored separately from all other information and gives the user a quick reference as to whose notes they are currently editing, and of course for printed information as well.

Patient Charge Default Settings: You can select the defaults to boxes 17 UPIN, 23 CLIA #, 24A 'To Date', and 24H EPSDT to make filling out the HCFA form (Patient Charge) for a patient faster and easier.

The Box 24H EPSDT field allows you to specify what appears in the list of choices when filing a charge, with the first item listed being the default. For example, "N,Y,1,2,3,4" sets the list to display all six choices with "N" being the default value.
Fee Schedule: This allows for a default fee schedule to be defined for new patients.

Below is a screenshot of the Options dialog with the Patient Account Defaults section open.
Electronic Claims

If using the recommended clearinghouse (LTC) for electronic claims you can default all your electronic options (character alignment, line spacing, Box 24E numbers, etc.) to the LTC format instead of having to set those options in each insurance carrier.

Interest

If you wish to add interest charges to batch bills, enter an interest rate and the amount of days allowed before interest starts accruing.

HIPAA Compliance

Setting Password Protected to Yes will cause the program to disappear after a certain number of minutes (entered in the Minutes to wait field) and to prompt for a password before allowing any user to continue working with the program. An Application Password must be entered in the Passwords section for this option to function.
Passwords

The Passwords section allows up to several levels of password protection in MedLook. A password may be entered to protect main program access, to prevent access to aggregate financial reports (Billing vs. Payment and Percent Each Doctor), and to prevent data deletion. A password may also be added to your backups. This means that to restore a backup file or open it with a Zip program, you must know the password you had in force when you created the backup. Each password type has a Current, New, and Confirm field. To change an existing password enter the existing password in the Current field. Enter the new password in the New field, and again in the Confirm field. Once the desired passwords are set click the OK button. To enter a new password when there is no current password, leave the Current field blank and enter the new password in both the New and Confirm fields.
Note that if you change the Backup password, the new password will affect any backups you perform after the change is made. Existing backup files will still contain the passwords that were in effect when they were created.
Chapter 34 – Billing Messages (by Age)

It is common practice to print a standard message that varies with the age of the outstanding payments on your patient bills. MedLook provides an interface that allows you to define a message up to three lines long with sixty characters per line per aging category and activity level. The aging categories are the standard 30, 60, 90, 120, and 120+ days. The activity level is simply divided into two categories: No Payment and Partial Payment. Obviously No Payment means the account has not received any payments since the last billing and the Partial Payment therefore means there has been some payment activity but there is still an outstanding amount due.

To create your messages select Tools->Bill Messages and the following dialog will appear.

If you use the Close All button all the categories will close or collapse to just the banner making it easier for you to make a category selection. Open All will open all the categories showing the message content if there is a message selected for the category allowing you to quickly review each category and make any edits necessary.
To select a message select the topic you want to create a message for (e.g. 30 Days – No Payment), select the drop down in the Message # field, and the following dialog will then appear.

At this point you can select an existing message or create an entirely new message. To create a new message, enter the message formatted (i.e. centered) the way you want it to appear on the bill on each of the three lines in the text fields provided at the top of the dialog. Select Add and the message will be added to the message list. If you do not select Add and simply select OK you will lose the data you just entered, having accomplished nothing (so don’t do that unless you want to quit). Select OK and the message will be used for this category during the next billing cycle.

To select an existing message browse through the list of messages until you see the one you want and then double click it. You can edit the text and select Add to create a new message if you want or Update to edit the current selection. Again select OK to use this message as previously mentioned.

The Clear button simply clears the selection so you can start with a clean slate.
To completely delete a message just double click it and then press the DELETE key.

Selecting the OK or Apply buttons make your selections permanent for the billing category.

These same messages can be accessed during individual billing as well as batch billing.
Chapter 35 – Data Maintenance and Activity Scheduling

The database is a great tool. It makes searching for and filtering data a lot easier than it would be otherwise. It provides a common way for programmers to access data. The benefits from a database for multi-user access are tremendous. Of course, such a good thing must come at a cost and it does.

Selecting a database is no easy task. There are lightweight databases, middle-of-the-road databases, and then the true heavy-weight, enterprise-wide databases. The database used by MedLook is FoxPro. It is a middle-of-the-road type of database. The FoxPro database can handle a very large amount of data, do it very efficiently, and get along just fine with very little administrative upkeep. Very little is not the same as none. Some upkeep and maintenance is a must. Databases of all kinds can become sluggish and unpredictable over time and can result in corrupted and unreadable data.

*Note:* Before you can schedule tasks you must do a few administrative steps in Windows. See the last section in this chapter to enable scheduling for your system.

Scheduled Backups

The first line of defense for any office is to keep plenty of backups. We’ve already discussed one method of backups for MedLook through the Tools->Options dialog. The option provided there works fine as long as you run the software on a regular basis because the backup happens only when you start up MedLook. The method discussed here provides a way to perform the backup at any time of the day *as long as your computer is turned on.*
From the Tools menu select the System Scheduler menu item. The following dialog will display:

![System Scheduler Dialog](image)

The dialog consists of three basic parts: Schedule Tasks, Task, and Scheduled Tasks. The Schedule Tasks section allows you to specify the time and day you wish to perform the task at hand, in this case backup. You can specify the time of day and then the specific days. The selections as shown in the dialog will perform a backup every Monday, Wednesday, and Friday at 9pm. If we had selected next instead of every then the backup would have occurred only on the next Monday, Wednesday, and Friday (three backups) and then finished.

The Task section allows you to specify what task you want to run at the scheduled time. There are two built-in options, Backup and Pack. Backup will perform a full backup of the MedLook data to the folder specified. It is your responsibility to make sure the path is valid for writing at the time scheduled. By default the backup folder will return to the same folder each time you enter this command. DO NOT BACKUP YOUR DATA TO YOUR DATABASE FOLDER because this would accomplish only minimal security for your data. You should at least backup your data to some media other than your local hard disk and an off-site monthly backup would be great (take a CD home with you for safekeeping).

After you do a backup you should verify that the data is actually present in the backup. By all means do not overwrite a good backup with a bad one – this can and does happen more often than you might think.
The MedLook Help file contains step by step instructions regarding backing up to a CD using Windows XP. Regardless of the method you use, MedLook can create a backup file on your hard drive by clicking File, Backup Data, but will allow you to browse to a Zip drive, CD-R, etc. At some point, in addition to a location on the hard drive, you’ll want that backup on some kind of removable medium. Just in case your hard drive becomes unusable. Having the backup on the hard drive is great if you have to restore due to damaged data. It makes for a very fast recovery process, but if your hard drive suddenly stops working (and they do wear out), you’ll be glad you have that CD backup you made the day before.

In short, there are many ways to back up data. For example, MedLook will back up its own database, but you could include MedLook’s data in a backup of your entire hard drive to a tape drive. Whichever way you choose to back up your data, make sure you understand how to perform both the backup and restore functions of the method you decide to use. And make sure to test the backup. If a consultant sets up a tape backup system for your office, make sure to request that he verifies that the backup is actually working and can be recovered. On a couple of occasions we’ve had customers try to recover a backup only to find they didn’t have one, and never did. Trust us; this will ruin your day like you wouldn’t believe.

You depend on your data to get paid. Protect it by backing up daily.
Scheduled Database Packs

Selecting the Pack option will allow you to schedule the database maintenance pack process. This is a necessary step to keep your FoxPro database functioning at optimum performance. It keeps the database as small as possible and running as quickly as possible.

The directory of the current database will automatically be entered in the path text box. If you have multiple databases you can change the path using the browse button to the right of the folder field. This is particularly useful for billing services or offices with multiple providers in separate databases.

Scheduling Other Tasks

Any other tasks you might want to schedule can also be done through this dialog. For instance, if you have Word or Excel files you want to schedule for backup, you can simply create a script file and select a time for it to run and add it to the schedule. It’s really very easy. Below is the script file we use to backup our source to a zip disk just in case something at the office goes wrong.

```plaintext
;REM Source file backup using 7z to compress files.
::Start in c:\
c:
cd c:\

::Build list of file to exclude
set exlist=-x!*.*.exp -x!*.*.lib -x!*.*.exe -x!*.*.chm -x!*.*.tmp -x!*.*.$$$ -x!*.*.ppt -x!*.*.pps -x!*.*.zip -x!*.*.png -x!*.*.dll -x!*.*.ocx -x!*.*.oca -x!*.*.obj -x!*.*.bak -x!*.*.log -x!*.*.scc

::Display message to user
echo .
echo .
echo Exit MedLook and release all files for auto backup to begin
pause

::If zip file is not provided
if "%1"=="
    goto DefaultFile

    c:\utility\7za a -tzip %1 MedLook\* -r %exlist% > c:\%1.log
echo copy %1 h:\> c:\%1.log
copy /Y %1 h:\> c:\%1.log
copy /Y %1.log h:\

    goto Finish

::If zip file is provided on command line
:DefaultFile

    c:\utility\7za a -tzip MedLookSrc.zip MedLook\* -r %exlist% > c:\MedLookSrc.log
```
echo copy MedLookSrc.zip h:\ >> c:\MedLookSrc.log
copy /Y MedLookSrc.zip h:\ >> c:\MedLookSrc.log
copy /Y MedLookSrc.log h:\

:Finish
echo Backup complete.
pause

Adjusting and Reviewing Scheduled Tasks

Naturally if you have tasks scheduled you may want to edit them or review how they’ve been going. To do so is a simple matter. To delete a task just select the task from the Scheduled Tasks list and then press Delete Selected. Your task has been removed from the list. Next, edit the script file or just reschedule the task to run at a different time.

To review how prior tasks have been processed simply select the View Log File button. A dialog will appear with a listing similar to the following:

```
********************
12/09/2003 4:54:56 PM       Backup started
Database: C:\MedLookData\Backup: C:\temp\MedLookBak.zip
********************
01/21/2004 9:14:26 AM       Backup started
Database: C:\MedLookData\Backup: C:\temp\MedLookBak.zip
01/21/2004 9:14:57 AM       Backup finished
********************
```

Enabling Your System Scheduler

To schedule any tasks through the System Scheduler you must enable the Windows Task Scheduler. Note that this option is only available on Windows NT, 2000, and XP. It is not available on Windows 9x or ME.

To get going use Start->Settings->Control Panel (for NT and 2000) or Start->Control Panel (for XP) and select Administrative Tools, then Services, and scroll down until you see the Task Scheduler service as shown below.
If the service *Status* isn't "Started" and the *Startup Type* isn't "Automatic," then right click on the service and select *Properties.* The following dialog will then appear.
Change the *Startup Type* to *Automatic* and click the *Start* button under *Service Status* to start the service. The service will now run automatically when Windows starts.

Note that the *AT Command* runs in the background using the default system account. This account does not have network access for security reasons. If you wish to schedule backups that will be saved to another computer on your network you must set the *AT Command* to run under an account with network access. To change this setting open *Control Panel* as above. Double click *Scheduled Tasks* and on the *Advanced* menu, click on *AT Service Account*. 
Change from *System Account* to *This Account* and enter an account name. Enter and confirm the account password. You will now be able to schedule backups to be saved on other networked computers as long as the account you entered has access to those computers.

**Chapter 36 – Archiving, Recalling, and Un-deleting Patient Accounts**

As your database grows in size, performance will begin to suffer at some point. Plus, there may be at least some accounts in your system that are no longer needed. You could delete these accounts (on the main grid, right click on the account and select Delete on the menu, or in an account, while on the summary tab, click on the Delete button on the toolbar). Then again, you might want to view that account sometime in the future for some reason. In this chapter we’ll take a look at the options MedLook provides for dealing with these accounts.

Naturally, before doing any kind of maintenance work you should make sure you have a good, current backup handy just in case, especially where records will be moved and deleted as described in the rest of this chapter.

**Deleting and Un-deleting Patient Accounts**

As stated earlier, MedLook uses a Visual Foxpro database to store your data. Deleting a record in Visual Foxpro consists of two steps; Marking the record for deletion, and removing the marked record from the database’s table file. For example, to delete a patient account, you right click the row on the main patient grid and select *Delete* from the pop-up menu. At this point, the record is marked for deletion. You won’t see the account in the program after doing this, because MedLook is programmed to ignore records marked for deletion, but it’s still in the database file. To remove the record from the file, you would then issue the *MedLook Pack* command (*Start, All Programs, MedLook, MedLook Pack*). The Pack command will completely remove from the database any records marked for deletion, and is final. And by final we mean, once you’ve packed the database, the records that were marked for deletion are gone for good. The only way to recover packed data is to restore from a good backup that contains the deleted data. You are doing backups… aren’t you?

Now that you know how a record is deleted, you’re probably thinking, “If I don’t pack the database, I should be able to retrieve any patients I’ve deleted.” And you’d be correct. MedLook provides an Un-delete option. Click on Tools, Un-Delete Patient and you’ll see the following dialog.
This is a list of patient accounts that have been deleted. It’s the only place you’ll see MedLook pay attention to patient records marked for deletion. To un-delete records, click on the rows you want to un-delete and click the Recall button. Once you’ve finished, click the Close button and you’ll be returned to the main MedLook dialog.

Now that we’ve looked at deleting accounts (and how it can be dangerous) you may not want to delete any records at all. Unfortunately, deleting records is inevitable. You will probably have to delete some records, if for no other reason, due to mistakes in data entry, such as entering the same patient multiple times.

That said, what about patient accounts that have nothing wrong with them other than the fact they may be old or considered inactive? With some users these types of accounts may total in the thousands. You’d like to remove them to make your database smaller, which in turn will improve performance, and make your backups smaller, but, you can’t do that without packing the database, and that means those accounts are gone forever. What if one of those patients returns for an office visit? You would have to re-enter all their data. That’s where Archiving comes in.

**Archiving and Restoring Patient Accounts**

Archiving a patient account removes it from the database files, but unlike the above deletion process, we can recover the account without resorting to restoring a backup. To archive patients click on Tools, Archive Patients. You’ll see the following dialog.
This dialog displays a patient grid (with all of your patients) and a *Folder List* with the *Patient Folder* expanded. To archive accounts, highlight the rows you want to archive and click the *Archive* button. Those patients will be moved to a separate database where they will be included in the backup process, and most importantly, they can be recalled if needed.

The grid and sub-folders on the *Patient Archive* dialog are there to assist you in determining which patients to archive. For example, you may decide that you want to archive patients who have no transactions after January 1, 2005. Take a look at the following image. We’ve scrolled down the Folder List and selected *DOL (Date of Last Transaction)*. Notice that the grid is now grouped by year.
In the sample database we’re using there is one account that meets our criteria. Click on that row and click the Archive button. The point in this example is that anything you can do to the main patient grid in MedLook, you can do here. That is, you can sort, group, create views by adding/removing fields, etc. You can also use the large list of subfolders which will automatically group and sort your patient data based on the item you select.

Patient accounts that are archived are deleted (remember, that means marked for deletion) in the main database. Once you’ve archived any patient records, the most important thing to do is to immediately run the Pack command. Again, exit MedLook and click on Start, All Programs, MedLook, MedLook Pack to run the pack command. This will remove the archived patient accounts from the main database. Until you do this, you will not be able to restore archived patient accounts back into the main database. At the end of the archive process you’ll see a message reminding you to do this. At that point you should close all MedLook dialogs and perform the pack command.

Now, let’s look at how you can restore that patient account to the main database.
Ok, we’ve archived a patient account. We’ve issued the pack command. The account is completely removed from the main database. Now let’s assume we want to bring the archived account back into the main database. Click on Tools, Restore Patients. You’ll see the following dialog.

![Recover MedLook Patients from Archive](image)

This dialog is similar to the Archive dialog except it contains a list of archived patients. In the case of our example we see the patient account we archived earlier. Highlight the row and click the Recover button. You’ll be reminded again with the following message that you should pack the database before using the Restore function.

![Exit to PACK?](image)

At this point, if you haven’t packed the database since you archived accounts you should click the Yes button, exit MedLook, and perform the pack operation as described above. If you did pack the database after archiving accounts you can click the No button and any highlighted rows will be pulled back into the main database.

So, now you’ve seen how you can use Un-Delete to recall any patients you’ve deleted (but not packed), and how you can pretty much ignore the delete option, at least where patient accounts are concerned, and use the Archive/Restore functions. Most importantly, be sure to do good backups before starting any processes that alter data.
Chapter 37 – Editing Layouts

Generally the “Find” dialogs are formatted to best serve you straight out of the box. However, everybody does have their own special preference for colors, sorting, etc. Since you cannot right click on a “Find” box and use the formatting tools normally available we have provided a means to edit them elsewhere. The process of changing the grid layouts is the same as already described (sorting, grouping, formatting) with the difference here that you actually select a grid by layout file name.

Every grid has a unique layout name (*.lyt) and until now you have been completely isolated from these files and their names. The layout files are stored in the product directory in the etc folder (usually c:\program files\Fagerman Technologies\medlook\etc). The files starting with a “C” such as Cpatients.lyt denote Card view layout files and those starting with a “T” such as Tpatients.lyt denote Table view layout files. You probably see a pattern forming already. The word patients in both of these layout files references the patients folder. The layouts we’re really concerned with are those we can’t edit in their normal place. These are all named Tfind*.lyt. Here’s a quick list of the files at present:

<table>
<thead>
<tr>
<th>Table Name</th>
<th>“Find” Grid Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TFindApptReasons.lyt</td>
<td>Appointment Reasons</td>
</tr>
<tr>
<td>TFindCComments.lyt</td>
<td>Charge Comments</td>
</tr>
<tr>
<td>TFindCharge.lyt</td>
<td>Edit/Select Charge</td>
</tr>
<tr>
<td>TFindDiagCode.lyt</td>
<td>ICD9 Diagnosis Codes</td>
</tr>
<tr>
<td>TFindDoctor.lyt</td>
<td>Doctors</td>
</tr>
<tr>
<td>TFindFee.lyt</td>
<td>Fee Schedules</td>
</tr>
<tr>
<td>TFindHospital.lyt</td>
<td>Hospitals</td>
</tr>
<tr>
<td>TFindIns.lyt</td>
<td>Insurance Carriers</td>
</tr>
<tr>
<td>TFindModifier.lyt</td>
<td>Modifiers</td>
</tr>
<tr>
<td>TFindPatient.lyt</td>
<td>Patients</td>
</tr>
<tr>
<td>TFindPComments.lyt</td>
<td>Payment Comments</td>
</tr>
<tr>
<td>TFindPOS.lyt</td>
<td>Place of Service</td>
</tr>
<tr>
<td>TFindProcedure.lyt</td>
<td>CPT Procedure Codes</td>
</tr>
<tr>
<td>TFindRef.lyt</td>
<td>Referral Sources</td>
</tr>
<tr>
<td>TFindTOS.lyt</td>
<td>Type of Service</td>
</tr>
<tr>
<td>TFindZip.lyt</td>
<td>Zip Codes</td>
</tr>
</tbody>
</table>

Once you have selected the layout, editing the appearance is done through the right click menu as always.

While there are many other layouts we do not recommend altering their format from here but rather where you would normally use it. This feature is intended to provide you the means of customizing those grids that cannot be changed in the normal course of usage as all others can.
Chapter 38 – Importing Codes, Patients, and Insurance

Whether starting a new office or changing software, it is very possible that pre-existing data is available in some sort of electronic file. MedLook provides a variety of utilities for importing the most probable type of data. This includes procedure and diagnosis codes, patient data, and insurance carriers. This chapter will look at the options available in MedLook for each of these data types. Let’s begin with the easiest items: procedure and diagnosis codes.

Importing Codes

These utilities can be found on the Tools menu as shown below:

Starting a new office requires acquisition of procedure codes (CPT) and diagnosis codes (ICD9) along with everything else. Some practices use only a handful of codes and can easily afford to enter them manually; others may require a thousand or more codes. There is a quick and easy way to load a list of either type of codes from existing files either on your computer or some other media. (Note: Remember to backup your data before doing an operation like this… just in case something goes wrong!) To import the data the files must be formatted with one code per row with some sort of delimiter between columns of data. The format must remain constant throughout the entire file with no blanks, headers, or footers.

Here are a few examples:

Comma delimited:
320.0, Haemophilus influenzae meningitis, Some cross-reference text

Semi-colon delimited:
320.0; Haemophilus influenzae meningitis; Some cross-reference text

Space delimited:
"320.0 " "Haemophilus influenzae meningitis, Some cross-reference text "

Tab delimited:
320.0 Haemophilus influenzae meningitis Some cross-reference text

To import the codes use the Tools->Import menu and one of the dialogs will appear as shown below depending upon the type of codes you are importing.
These two dialogs are very similar with the most significant difference being the bottom right key-in field. For diagnosis codes the field is *Cross-Reference* and for procedures codes the field is *Amount*.

The dialogs work as follows. Enter or browse for the data files containing the codes. You can view the files using the View button (highly recommended). Specify how the file is delimited (comma, semi-colon, colon, space, or tab). You should be able to see that when viewing the file. Once you have identified the files you can load them into the program for display in the grid using the *Load* button. This does not load them into the
folder – not yet. At this point you will see each column of data as we have parsed the file. If something doesn’t look right it’s probably the wrong file or the wrong delimiter being used to parse the file. Carefully review the file to make sure it’s a valid file in a valid format (remember, one code per row with delimited columns of data, no blank lines, headers or footers).

Once the grid looks correct, specify on the bottom of the dialog which item you are going to identify with a column (e.g. code) and then double click the item in the grid that corresponds to that column of data. Repeat this for each item/column of data as appropriate. Finally, select Import Data and the codes will be imported and are ready to be used. I highly recommend reviewing the respective folders at this time to make sure the information is correct.
Importing Insurance

Often times a list of insurance carriers is provided by a clearinghouse or some other organization. While it is simple enough to enter these on an as-needed basis they can also be loaded in one operation from an external data file. The utility for loading insurance carriers can be found on the Tools menu pull-down as shown below:

The dialog for importing insurance is shown below.

By following the instructions on the dialog alone you can import your data. For a billing service that has multiple clients in the same area carriers from one database can be copied with relative ease into another database by following these simple steps.
Use the Database Analyzer and enter “SELECT * FROM InsIdent” in the bottom right box. Click the XML option for output. Execute the SQL command. Note where the file is saved. Now launch Microsoft Excel (see the Programs menu pull-down). Open the XML file created in the Database Analyzer. Save the file as a CSV file. In the dialog shown above browse for the CSV file. Identify each of the columns of data you want to import as noted on the dialog. Click on Load and the carriers will be imported to your new database. Yes, that’s complicated but it demonstrates this feature quite well.
Importing Patient Data

This section will discuss two powerful methods of importing patient data. The first method assumes column delimited patient data (typically CSV format). The second method is far more powerful in that it can do virtually everything the first can do but can also import Print Image (CMS 1500) format data, etc. The data to be imported need only be in a regular format (like the Print Image).

**Column Delimited Patient Data – Method I**

Patient data can be imported in the same manner as insurance carrier information. Below is the Tools menu pull-down for selecting the *Import Column Delimited Patients*.

The dialog for importing column delimited patients is shown below.
This dialog works exactly the same as the *Insurance Carrier Import* dialog. The most common source of patient data in this format is from QuickBooks or Excel as these are simple, uncomplicated tools frequently used by new and/or small practices with a very limited number of patients.

**Formatted Data – Method II**

The *Import Formatted Data* is accessible via the *Tools* menu pull-down as shown below.

While we have this listed under Patient Data Import it is not strictly limited to importing patient data. In fact, it can import everything BUT actual transactions (charges and debits), patient notes, and appointments. It CAN import patient data, doctors, referrals, insurance carriers, hospitals/facilities, modifiers, PINs, etc.

Typically this feature is used to import data in Print Image format as this is the single most widely used format in the medical industry for billing information. Defining the map is not difficult but it is not particularly easy either. Once the map is created it can be used over and over again making it very easy for a billing service with many clients to quickly and easily convert each client to MedLook.

The dialog to do this is shown below.
This dialog will not be discussed in any detail here as it requires technical assistance to define the map and therefore to even initiate the import command. It is sufficient to know that the capability exists to do this function.
Chapter 39 – Searching All Patients Notes

We can’t remember everything – I can’t, you can’t. However, we are good at remembering some details or special little identifiers that can link us back to the information we are really looking for. For just these occasions we have included a feature that allows you to search through all of the patients notes identifying matching patients. In this way you can then quickly scan the list of patients for the one you are searching for and edit their account as appropriate.

*Hint:* It is best to have the Patients Folder displayed when using this feature (after all you are searching for patients).

You can invoke this function from the tools menu as *Tools-* > *Search Notes*. The following dialog will then appear.

![Search Notes dialog](image)

In the first key-in field simply enter the text you wish to find and press enter or Go. All of the patients that have notes containing text that match the text you entered will be listed. You can restrict the match to be case sensitive if you wish.

Once the patients are listed, you can continue to search for new patients using different criteria without removing those already found. Any new patients simply get added to the list (and there may be duplicates). You can easily start anew by using the Clear button. You can edit any of the listed patients simply by double clicking on the patient in the search dialog to make the patients folder jump to that patient and then double clicking on the patient in the Folder list.
Chapter 40 – Adding External Programs

Your computer comes equipped with literally hundreds of programs installed. Most of these programs run behind the scenes and are necessary just to keep the system running. Other programs you purchase and install for your routine use. MedLook provides a convenient means of activating your favorite programs without leaving MedLook. Using the Add-in Manager you can literally add new programs to the Programs menu pull-down. Here’s the dialog.

![Program Add-In Manager dialog](image)

Simply type in the program name or title in the captions area and then click in the program path area. A small dialog will display where you can key in the program path (such as c:\windows\notepad.exe) or use the browser to the right of the field to select the file you wish to include using the common Windows Open dialog. After you enter the information, select close and then press Enter to actually accept and load the entry into the program. It will then be added to the pull down menu. Close the Program Add-in Manager dialog and re-select the Programs menu. You should now see your new, personal entry at the end of the menu list.

Add-ins that are always present include: Network Neighborhood, Control Panel, Printer, and My Computer. Network Neighborhood allows you to visit other networked nodes. Control Panel allows access to settings and properties to other tools such as modems, the system clock, and other devices. Printer allows you to select a printer or add a new printer connection. My Computer gives you access to your drives and files.
You can use this for more than just programs too. You can enter a URL (such as www.remsys.com) or file name (such as myFile.txt). If you click on the URL from the pull-down menu your web browser will activate and load the page at the specified address (this is great for electronic claims processing). If you selected a file then the file will be loaded with its associated program.

Using the Program menu is just one more way to keep things simple.
Chapter 41 – Utilities

In this chapter some of the less frequently used utilities will be discussed. Each of these items can be found some where in the Tools menu pull-down. The current implementation has them listed under Tools->Utilities as shown below:

Renumber Patient Accounts

Sometimes it is necessary, for whatever reason, to renumber a patient’s account. To do this, simply select the Renumber Patient Accounts to invoke the following dialog:

The dialog is very easy to use. Enter the account number you need to renumber in the Current Number data field and the New Number. If the number is available the account will be renumbered.

This command can also be used to merge to accounts together (in the advent that duplicates are created). If the New Number is an existing account then a notification to this affect will be displayed and confirmation required to continue for renumbering. The Current Number account will be merged with the New Number and subsequently the Current Number account will be removed.
Merge Two Databases

Sometimes a doctor may have two completely separate offices. In this case they would typically have two separate MedLook databases. At some later point in time it may become necessary to merge the offices and consequently the databases. MedLook provides a feature to do this. Rarely is this command used. The dialog to do this is shown below.

The dialog is very simple but what it does is by no means trivial. Before performing this command be sure to have a good backup of ALL of your data.
Utilities 1 of X

Let’s clear the air on this at the very outset. Neither Utilities 1 of X nor Miscellaneous Utilities are good names for this utility. However, the features found in this utility are quite powerful. The dialog contains basically six (6) tools and is shown below:

**Update DOL Transaction.**

This utility is rarely useful. Most often it is to fix the DOL (date of last) transaction as imported from The Billing Master. MedLook itself should maintain this field properly for any new or edited patients. This function will soon become obsolete as these imports come to a halt.
Close Overpaid Accounts.

Occasionally you will have accounts that are overpaid. The overpayment may be a result of an insurance adjustment, etc. In any case, if the overpayment is only a few cents or dollars often times the remit is not processed as it cost more than the actual remit (we have actually received remits from our phone service, etc. for less than the postage required to mail it!). You may accumulate accounts like this that are still open but remain dormant for years. Obviously at some point you probably want to adjust the account and move on. The easiest way to do this is to add a debit to the account with a simple comment regarding what is really being done. You could do this for each account but this is not economical or efficient. Using this feature you can set a couple of fields and finish the job in a single click. Simply enter an appropriate date in the Only Accounts Inactive Since field and a meaningful comment in the Comment for Debit Lines field and click on Process. If there are any accounts to be processed they will be displayed in your browser similar to the following:

<table>
<thead>
<tr>
<th>PINUM</th>
<th>FULLNAME</th>
<th>TOTALBALANCE</th>
<th>LASTPAYDT</th>
<th>LASTCHGDT</th>
<th>DOC</th>
</tr>
</thead>
</table>

In addition a dialog will pop up as:

Continue?

Review the patient list generated.
It may take a few moments to display in your browser.

Do you accept this list and want to finish by applying the debits for the balance shown?

[ ] Yes  [ ] No

If the information displayed in your browser looks ok, simply click Yes on the above dialog and the accounts shown will be closed with a debit. Clicking No will result with nothing happening to your data. If you click No you will probably want to review some of the accounts individually to make adjustments. In either case you will eventually dismiss your browser.
Close Open Accounts With A Balance Due.

Like the previous option, this feature deals with seemingly dormant accounts that are still open. In this case, the accounts are open with a balance due. Some accounts will just never be paid in full – this is pretty much a truth just like death and taxes! The only way to close these accounts is to add a credit to them. Enter the data you wish to filter by for inactive accounts, the dollar amount you wish to filter by in the Having No More Than This Amount Due field, and finally the comment you wish to add. Of course, a credit will be generated for each account to close the balance. Clicking on the Process command will result in your browser being displayed with any accounts that meet your criteria. Below is an example.

The following dialog will pop up allowing you to complete the command and credit the accounts shown or to abort the command.
**Write-off Open Charges.**

Many times there are accounts that are not dormant but that have old, open transactions. This is usually due to an ongoing issue with insurance or negligent patients. In the end you may have to resign to the simple fact that is easier, less frustrating, and more economical to simply forfeit some procedures and close them. This feature allows you to filter by primary or secondary insurance, by patient/responsible party, and by the age of the claim. If an individual carrier is desired then the Select Carrier field should be used to single out that carrier; otherwise this field should be blank. Simply check which payor you want to filter by and enter the date of the transactions to filter by and click Process. If there are any records that meet your criteria they will be displayed in your browser as shown below:

![Image](https://example.com/image.png)

Again, a dialog will pop up allowing you to close the transactions or to abort the command.

<table>
<thead>
<tr>
<th>PTNUM</th>
<th>TRNUM</th>
<th>AMOUNT</th>
<th>APPLIED</th>
<th>FULLNAME</th>
<th>DOC</th>
<th>INS1</th>
<th>INS2</th>
<th>PTNT</th>
<th>OTHER</th>
<th>DATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>10007</td>
<td>1</td>
<td>72</td>
<td>0</td>
<td>Miss Kate C. Kenduck</td>
<td>DAD</td>
<td>42</td>
<td>0</td>
<td>30</td>
<td>0</td>
<td>12/27/2005</td>
</tr>
<tr>
<td>10007</td>
<td>2</td>
<td>100</td>
<td>0</td>
<td>Miss Kate C. Kenduck</td>
<td>DAD</td>
<td>70</td>
<td>0</td>
<td>30</td>
<td>0</td>
<td>12/27/2005</td>
</tr>
<tr>
<td>10002</td>
<td>3</td>
<td>300</td>
<td>275</td>
<td>Mr. Vincent K. Osagbe</td>
<td>DAD</td>
<td>0</td>
<td>0</td>
<td>25</td>
<td>0</td>
<td>12/27/2005</td>
</tr>
<tr>
<td>10003</td>
<td>14</td>
<td>100</td>
<td>57</td>
<td>Mr. William</td>
<td>DAD</td>
<td>0</td>
<td>0</td>
<td>43</td>
<td>0</td>
<td>11/6/2005</td>
</tr>
</tbody>
</table>

---

**Continue?**

Review the patient list generated. It may take a few moments to display in your browser.

Do you accept this list and want to finish by applying the credits for the charges shown?

[Yes] [No]
Remove Managed Care Records.

For those clients that extensively make use of Managed Care information it occasionally becomes necessary to cleanup expired information. This option works very much the same as the earlier options but lists those patient accounts that meet the managed criteria shown on the dialog.

Fix Duplicate Patient Insurance Policies.

This command should not ever be necessary. The only reason it is even listed is due to a bug in one of the minor updates of MedLook. Somehow a patient’s account would list two insurance carriers, both being identical and both being primary. This command would fix such accounts. The result of such accounts would be a ledger/posting report with seemingly duplicate procedure entries (but they weren’t really duplicated, just the report was messed up).

All of the commands listed above can be performed simultaneously by select each of them. This is generally not the normal mode of operation.
CMS 1500 Test Page

Filing electronic claims (using the Print Image) and printing paper claims on CMS 1500 forms require formatting your output. Each clearinghouse requires a slightly different Print Image file. Likewise, it seems no two printers have the same margins, etc. This utility prints every item enabled in the layout file at the specified location. The nicety here is that the test page is independent of any patient data. This means you don’t have to create a test patient with hospitalization dates, etc. Below the CMS 1500 Test Page dialog is shown.

The Layout field defaults to the layout for the current database but can be set to anything.

Edit Layout is a command that will invoke the current XML editor defined in MedLook under the Tools->Options dialog (usually XML Notepad from Microsoft).

The Left Margin/Top Margin options are fields to allow you to quickly test margin settings of your printer (this is rarely used).

The Height/Width fields should always read 15840 and 12240 but this may be different on some printers.

The eClaim Output File is the file used to save the Print Image file for testing of electronic claims.

The eClaim File command generates a test page using the Electronic section of the layout file. The output is automatically saved to the eClaim Output File and the file is displayed with the default text editor (usually Notepad).

The next page shows the output generated in two separate windows (top half and bottom half).
The eClaim Print button allows testing to use the electronic layout with output being converted and sent to the printer. This is an interesting option as the Electronic layout is defined using row and column (row being the line number from the top of the file and column being characters from the left) and the printer output is defined using inches (usually 8.5 x 11 for normal paper). Not all electronic Print Image file formats are designed to print to the paper forms, in fact very few are. Still, this is a useful option in some situations.

The Print option of course is the option that uses the Paper section of the layout. Clicking this option invokes the printer dialog.

As can be seen in the output on the previous page each item is printed with a semi-meaningful piece of identifying text. For instance, box 33 has DOC GROUP OR NAME where the doctor’s name or group name would print. Yes/No check boxes usually print with Y or N (of course, they should be at least close to their appropriate location). S, M, and O are used for Marital Status of Single, Married, or Other. And so on.

Modifying the layouts is done using the defined Layout Editor and will be covered in another section.

Chapter 42 – Miscellaneous Tools

In this chapter you will learn how to use some of the miscellaneous tools in Medlook 4.0. Most of these tools can be accessed through the Tools menu option or through the Options dialog.

List Data Editor

The List Data Editor is a tool that lets you edit list data such as ethnicities, patient categories, service codes, and much more. This tool can be used to create custom fields for your business or specialized fields for a region.

To access the List Data Editor go to Tools and click on the Edit List Data menu option, or you can use the shortcut keys ctrl + shift + L.
Once the dialog is open you can choose the list you want to edit by selecting an item from the List Name drop down. When you have selected a list to edit, the items in that list will appear in the table under List Data and you can edit these items by selecting them.

To add a new item to a list, simply click the New button and enter the new item’s list text and list value. The Item Priority field sets where the item will appear in the list. Setting an item’s priority to a low number will make it move up the list, while setting the priority to a high number will move it down the list. Once you have created the new item and filled in the fields, you must click the Save button to save newly created item.

When you want to delete an item from a list select the item you want to remove and click the Delete button. Some items cannot be deleted; if you selected an item from the list and this icon appears ! then that item cannot be deleted.

**Patient and Insurance Aging**

The Patient/Insurance Aging dialog is used to adjust the date by which aging is adjusted.

To access the Patient/Insurance Aging dialog, go to the Options dialog and go down to Office Reports Options and click on Click to Edit Aging.

By default charges are aged by the Date of Service (DOS) but, to change that simply select the date field you want to age by. The choices are DOS, DOE, First Billed, and Last Billed. After you have changed the aging field click Recalculate Aging, this adjusts the aging based on the date field you selected. WARNING!!! Depending on the size of your database the recalculation process could take several minutes. Only recalculate aging when you have a large amount of time to spare.
Export Diagnosis Codes, Procedure Codes, and Insurance Carriers

To access the Export dialog go to Tools and click the Export menu option.

In order to export, you must first designate a database that you want to export to. Click the browser button on the right side of the screen under the Database label. Simply browse to your preferred database and click the open button on the browser dialog. Next you will need to select what you want to export by clicking the check box next to the export option. Under Diagnosis Codes and Procedure Codes you will see some option buttons, these two options will affect how the codes are exported. The Merge button will only export codes you have in your current database that do not exist in the database selected to export to. It could take several minutes to merge the diagnosis and procedure codes, so only do this when you have time to spare. The Delete/Replace option deletes all the diagnosis or procedure codes in the select export database, with the diagnosis or procedures codes from your current database.

Clock In/Out

To get to the Clock In/Out dialog, go to Tools:Clock In/Out. When the dialog intiially comes up the current date will be the display in the Date text box. All you need to do when entering hours is 1.) make sure you add AM or PM onto the end of the time 2.) Enters times in a 12 hour time frame, not in a 24 hour time frame. After you are done filling in the time boxes click the Save button, or click the OK button to save the changes and exit the dialog. If you want to select a previous date you can type the date into the Date textbox or click on the prefered date in the grid.

Print Employee Hours

This options is only available to a user in the Administrator group. To get to the Employee Hours dialog go to Tools:Print Employee Hours. If you want to filter on a
specific date range or user id, just fill in the text box associated with what you want to filter on then click the Filter button. To print just press the Print button and click Yes for all the records in the grid, or No for only the items you have selected in the grid.

**Default Provider/Facility/Procedure/Diagnosis Codes**

You can set a default for four different categories, Providers, Facilities, Procedure Codes, and Diagnosis Codes. To set a default such as Provider, go to the Providers folder in the Folder List. Once the folder is open, right click on the provider you want and click the Set Default menu option. To view what you have set as default go to View:Default Provider, Facility, Etc… on the dialog you will see what you have set as your current defaults. To remove a default check the box next to what you want to delete and click the Update button. You can also remove defaults from the List Data Editor.

**Section 11 – What To Do When Something Goes Wrong**

Wrong? You mean something can go wrong? Unfortunately… yes, things can go wrong. As we provide features to leverage the latest technology on the current Windows operating systems (7 and 8), it is increasingly difficult to make them work “ok” on the older systems (like Windows 98 and XP). It’s not just the different versions of Windows either. Hardware has a lot to do with everything. The amount of memory, processor type, speed, etc., all can influence how the product performs. Then there are other programs that might be running in the background on your computer. Who knows what kind of conflicts they might cause. Because there are so many things that can go wrong a few tools are provided to help us help you solve any unforeseen problems that may occur.

If your system in general just seems to be having trouble, the first thing to try is rebooting the computer. You may even have to shutdown the system and leave it off for 30 seconds for everything to clear. Be sure the computer has plenty of ventilation and fans to keep it cooled. An overheated system can behave in completely inexplicable ways.

There is one simple problem that occasionally occurs. Sometimes your grids may end up with column headers that just don’t look quite right. This can happen, and this happens almost exclusively on Windows 98, and fortunately there is a simple solution. Most often the problem occurs in the Patient Payment dialog. All you need to do is get your default grid layout back. To do this use View->Defaults, select Patient Payment and then OK. That’s it.
Chapter 42 – Using the Diagnostic Tools

Before running any of the diagnostic tools, or performing any maintenance functions, you should make sure you have a good backup. Maintenance and diagnostics involve accessing and sometimes manipulating or changing data. Normally things proceed without any problems, but that one time it doesn’t you’ll be extremely glad you have a backup.

And since we mentioned it, what exactly do we mean by a “good backup?” A good backup is a backup made when you know MedLook was functioning normally and your data was up to date. You should set up a backup method/routine, use it daily, and test it periodically to make sure you can recover files if necessary. When you run into a problem set aside the CD, Zip Disk, Tape, or whatever device you save your backups on. It’s now worth your computer’s weight in gold. It may be the only way to get your system up and running again… short of entering all of your data again manually. Some of our users have as few as 500 patients in the system, which we consider a small database, while others have as many as 30,000 patients. As you can probably imagine, in either case entering all of those patients, their transactions, insurance carriers, etc., from scratch would be a daunting and time consuming task.

MedLook contains numerous options for troubleshooting and repairing problems you may run into. Most of these options are contained in the Database Analyzer. You can access the Database Analyzer in MedLook by clicking Tools, Diagnostics, or by exiting MedLook and clicking the Start menu, All Programs, MedLook, Diagnostics, Database Analyzer.

In some cases (as in the example below) you will need what’s known as “exclusive access” to the database. This means you’ll have to exit MedLook and run the Database Analyzer by clicking on the Start menu as described in the previous paragraph. If you have multiple users on a network (LAN) you’ll also have to make sure all users have closed MedLook before you can use any functions of the Database Analyzer that require exclusive access. The Database Analyzer will let you know if you don’t have exclusive access to the database with a message in the lower left corner of the dialog as shown in the screenshot below. If you have exclusive access, only the path to the database will be displayed. Now, let’s do some troubleshooting.

Let’s assume you are having some strange problem on your computer with MedLook and an error message pops up telling you something is wrong with the database. There will probably be a few error numbers, and some names that don’t make much sense. Go
ahead and write down the error message. It may help tech support narrow down the cause of the problem.

Once you’ve written down the exact error message click the Ok button to acknowledge the error, MedLook opens, but you see no data on your patient grid. To troubleshoot this error, start with the easiest and most obvious solution. Indexes.

**Rebuilding Indexes**

What are indexes? Basically, indexes allow your data to be sorted. MedLook stores data in a Visual Foxpro database. One requirement of Visual Foxpro databases is that the index files be rebuilt periodically in order to prevent data from seemingly disappearing, and performance from degrading. The frequency will depend on how much new data you enter on a daily basis.

There are certain indications that the index files need to be rebuilt. You may see an error message that specifically mentions the indexes or some other problem with the database, or reports or bills may be missing data you know is in the database. In short, when you see a database error, the first troubleshooting step should be to rebuild the index files.

We recommend you perform a *Rebuild Index* operation at least once every two weeks. If you notice any of the problems mentioned in the preceding paragraph, increase that frequency to once per week, and so on. If you have to increase to more than once per week, you might want to give tech support a call. Also call tech support if the *Rebuild Index* process itself gives you an error. This means there’s a serious problem somewhere.

The first thing you’ll need to do to rebuild the index files is to exit MedLook. Next, from the Start menu navigate through Programs to MedLook. At this point you will see several options available on the MedLook menu. The one we are interested in at the moment is *Diagnostics*. *Diagnostics* contains several menu items: *MedLook with Debug Logging, MedLook with Debug Messages, View Log File*, and *Database Analyzer*. Here is a screenshot of the *Diagnostics* menu. Following is a brief description of each item on the menu. Other than the *Database Analyzer*, you’ll probably not use the others unless a tech support representative requests that you do so. Let’s take a brief look at the first three items on the *Diagnostics* menu before we continue, and we can leave them behind.

The first item on the menu creates an extensive log file as you work in MedLook. By default MedLook creates a general log file. When running MedLook with the *MedLook with Debug Logging* option you won’t notice any difference in the way the program operates, but MedLook is working behind the scenes to write everything it tries to do to a
file. Support representatives can look at this file and (sometimes) determine the point in the program operation that causes the problem you’re seeing.

The second item, *MedLook with Debug Messages*, will cause message boxes to open with almost every step you take in MedLook. You’ll definitely want to call tech support before using this one. It doesn’t generate more than the normal log file, but can help pinpoint the cause of a problem.

The *View Log File* item will display the log file created by MedLook. You can email this file to tech support as an attachment, or copy and paste parts of it into an email message.

You really won’t need to worry about these first three items unless a tech support representative asks you use one, or you want to get ahead of the game a bit and use the first item and then email the log to tech support. Now that you’re familiar with the other items on the *Diagnostics* menu, let’s continue our troubleshooting session.

On the *Diagnostics* menu, click *Database Analyzer*. The following dialog will open.
Each command area is assigned a number for clarity. Note that 9 and 12 are both *Load SQL* commands. The numbers help distinguish them.

On the left side of the dialog there is a section titled *Database Repair*. Click the button that reads “*Rebuild Index (repairs lost or broken table indices and improves performance and reliability)*.” You’ll see a white screen open which will flash a series of messages. Don’t worry about the messages. The program is simply listing each table file and its indexes as it rebuilds the index files. Once the process finishes the white screen will close automatically. The indexing process is complete. You can click the Cancel button, or the red close button in the upper right corner of the dialog to close the *Database Analyzer*.

At this point you’re ready to run MedLook normally and see if the problem is solved. If it is, congratulations, you’ve just debugged and solved a computer problem. If the problem persists, it’s probably time to contact tech support. Support representatives will help you with the other troubleshooting and repair options described below. We’ve just described how to perform the *Rebuild Index* option. Since we’re in the *Database Repair* section, let’s take a look at the other option here; the *Table Repair* function.

**Table Repair**

If the database error in the above example gives you a table name (Patient table *Identfil.dbf*, for example) you may be able to solve the problem by using the Table Repair button (labeled “*Table Repair (fixes badly damaged database tables)*”). Clicking the Table Repair button will open the following dialog.

![Table Repair dialog]

First, and most importantly, notice the big red and white warning at the top of the dialog. We can’t emphasize enough the need to have a good backup before using this and the other options of the *Database Analyzer*.
The MedLook database is comprised of container files (DB CONTAINER) and table files (everything else on the drop down list). MedLook also ships with a blank database that allows you to create new, empty databases. Billing services would use this capability to create a separate database for each of their client physicians. If you are a multi-physician practice and would like to keep your physicians’ data completely separate, you could do the same. For details see the File Menu, New Database covered earlier in this book.

Why does any of this matter in the case of a database problem? The Table Repair function will take the container or table you select on the Select Table to Repair drop down list from the blank database and copy your existing data into it. Then it will delete the existing table. This will put your data in a new file, which should solve any structural problems in the database - a very simple, but powerful function.

Let’s take a look at the dialog. Again, remember that big warning at the top. The box labeled Current Database Path will show you the last database you were in when you closed MedLook. Most users won’t have to worry about this, but if you access multiple databases you’ll need to be sure to work in the database that has the problem. You can change databases by clicking on the button with three dots (…) to the right of the box.

The Select Table to Repair drop down list contains the DB Container, and a list of all the tables in the database. Using the drop down list you can repair the container or one table at a time. Check the All Tables box to have the Repair Table function automatically repair all of the files.

Once you’ve made your selection(s), click the Start button. As you might imagine, it would be very bad to interrupt this process, so let it continue until you see the following message.

You should see this whether you repair the container or table files. Note the Reindex part of the message; it’s a good idea to rebuild the indexes after repairing tables, and it’s required after repairing the container. If you’ve repaired the container files you won’t be able to use the database until you do. Once you’ve rebuilt the indexes, you’re ready to run MedLook.

If our original error still isn’t resolved, don’t give up. We still have a couple of tricks to try.
Analyze Database Version

The Analyze Database Version will force the program through some database exercises to help determine and solve the problem. This section of the Analyzer is located in the upper left corner of the dialog. You should see (the screenshot is below) three options; Leave Version Unchanged, Set Full Analysis, and User Specified Version. This is a good tool to use after a MedLook update is installed and things don’t seem to be working correctly.

Make a selection and click the Analyze button. MedLook will initiate a database analysis with the database version as selected. Message boxes will periodically pop up with information regarding the current state of the analysis. Take note of what they say as they are your guide in solving the problem at hand. In the worst case, you may have to set the version to “Analyze Tables, Fields, and Indices”. The analysis will give you detailed information regarding the state of each database table if there are errors.

Do not use the User Specified Version except under technical supervision.

That takes care of the options that let you maintain and repair the database files and structures. Of course, problems can lie elsewhere. Patient accounts, for example. The database files may be up to date with no structural damage, but the data they contain may be wrong. Balances can be off, mismatched, etc. MedLook will attempt to show you where an error occurs, and most of the time you will correct these errors in the patient’s account, but sometimes (as with imported DOS data from The Billing Master), it can be difficult to sort out where a balance problem lies. That’s where the Account Corrections section comes in.

Account Corrections

The Account Corrections section contains a single, large button. It has a very long caption that reads as follows:

“Repair account balances, estimates due, assigned payments, and other inaccuracies in the patient's financial information. The total amount due in the account is left unchanged. Use as a last resort.”

The caption listed above tells you what this function is going to attempt to do. As with any other function of the Database Analyzer, you should make sure you have a good backup before using Account Corrections. And, as the last sentence of the caption says, “Use as a last resort.”
Let’s take a look at the Account Repair dialog and see just what it can do. It’s probably a good idea to test the Account Repair on a single patient before running it on all accounts. For our example we’ll run the Account Repair on an account where we’ve manually and incorrectly changed the patient amount due. This would easily be repaired in the patient account, which is where you would normally take care of it, but we’ll use it to illustrate the Account Repair function. Here is a screenshot of a patient account Transactions dialog and the charge we’ve changed.

<table>
<thead>
<tr>
<th>Type</th>
<th>TR #</th>
<th>DOS</th>
<th>Trx Date</th>
<th>Amount</th>
<th>Applied</th>
<th>Balance</th>
<th>Bal. Err.</th>
<th>Ins1</th>
<th>Pnt</th>
</tr>
</thead>
<tbody>
<tr>
<td>C</td>
<td>100959</td>
<td>02/28/2005</td>
<td>02/28/2005</td>
<td>$100.00</td>
<td>$100.00</td>
<td>$0.00</td>
<td>($20.00)</td>
<td>$0.00</td>
<td>$20.00</td>
</tr>
</tbody>
</table>

We’ve changed the Ptnt amount to $20.00 on a charge that has already been closed (paid in full). This is, of course, incorrect and causes a balance error of ($20.00) in the “Bal. Err.” column. Again, we would normally take care of this right here on the Transactions grid by changing the Ptnt amount to 0.00. But, for this example we’re going to use the Account Repair function. Click the Repair Account Balances… button and you’ll see the following dialog.

Since we’re working with one account, we’ll check the Single Account box and enter the patient’s account number in the Patient Account # box. If you leave the Single Account check box unchecked, MedLook will attempt to repair all of your accounts that have errors.
Take a look at the list of check boxes on the dialog. Some are disabled and will become enabled based on other selections. If checked, each of the check boxes accomplishes pretty much what their captions describe. To repair badly damaged accounts you’ll probably want to leave the defaults as is.

Once you’ve made your selections, click the OK button and MedLook will attempt to repair the account. Once finished, the Repair Account Options dialog will close and you’ll be back in the Database Analyzer. Repeat for other damaged accounts.

That covers the left side of the Database Analyzer. Let’s move on to SQL Commands.

**SQL Commands**

SQL stands for *Structured Query Language*, which is simply a way to access data. MedLook uses it to get and update the data for just about every operation you perform in the program. The Database Analyzer contains two areas wherein you can enter SQL commands.

The box at the top of the dialog allows you to make changes to your data, and even alter the database table settings.

Naturally, you’ll probably call tech support before using this option, and you’ll definitely want that backup we keep harping on before starting.

Using this function is simple. In the Name field enter something meaningful that you can use later to possibly recall this command. Enter the SQL command in the text box and click the Execute SQL button. We can even provide the SQL command in a file for you if necessary. That’s what the Load SQL button is for. If we send you a file, you’ll click the Load SQL button and browse to that file to open it and load its command into the SQL Commands to Execute box. Once the command is there, click the Execute SQL button.

When you click the Execute SQL button, you won’t see any output, with the exception of error messages if anything goes wrong. Whatever change the command will cause will happen behind the scenes, and you can then go into MedLook to see the changes.

The box on the lower portion of the dialog shown below and titled To View allows you to create output from your databases. The operation of this function is similar to the previous SQL option with a few differences. Again, any commands are entered in the text box (this one is larger since the commands here can be quite extensive), and you
click the Execute SQL button. The Load SQL button works the same way it does for the SQL Commands to Execute area described above. In addition to those two buttons, you’ll notice a few other options.

Clicking the Zip box will cause the output file to be compressed into a zip file. You can select from two formats for your output – XML and HTML – by clicking the appropriate radio button. With XML selected the output will be an XML formatted data file. This is just another way to store data, and allows you to create data files that could be imported into other programs that read XML. Once you’ve made your selections, click Execute XML. Your output file will be created. You can see the results by clicking the View button. The file will open in whichever program you have associated with XML files (probably Internet Explorer). Here is some sample XML data from the CPT (Procedure) Code database table using the command SELECT * FROM Codefile.

Not very reader friendly is it? That’s ok. It isn’t meant to be. This output is really just for programs to use, and they don’t need it in a reader friendly format. But let’s say you want to view that same data in a style that’s a little more user friendly. Just switch to the
HTML option. HTML is the language used to create web sites. This will give us a view we can understand. Here is the same data in HTML mode.

**CPT Codes**

<table>
<thead>
<tr>
<th>PROCNUM</th>
<th>CODE</th>
<th>DESCRIP</th>
<th>AMOUNT</th>
<th>SCRN</th>
<th>TOS</th>
<th>DOC</th>
<th>FEE_NBR</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>26505</td>
<td>Treat fx radius-manip</td>
<td>350</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>90015</td>
<td>Intrmdiate svc,newptnt</td>
<td>100</td>
<td>0</td>
<td>0</td>
<td>JJJ</td>
<td>1</td>
</tr>
<tr>
<td>3</td>
<td>90017</td>
<td>Extended svc,new paent</td>
<td>125</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>90030</td>
<td>Minimal Service</td>
<td>25</td>
<td>0</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This is a cutout of a large table that will open in your default web browser. It consists of the raw data from the CPT Code table. The headings are the field names in the table, and thus may not make sense to an end user. But enough information is clearly visible to know what is going on inside the table. For example, you can see the Code, Description (DESCRIP), and Amount fields. Notice also that the headings are formatted with a color background and there is a title at the top of the table. This can be accomplished by clicking the **HTML Options** buttons.

To change colors use the drop down list to select an item, then choose one of the colors for that item. You can change the font properties on the right side of the dialog. The Show Table Border will toggle the table lines on and off, and the Page Title and Text Size will allow you to set a title and its size. On the lower left corner of the dialog, you can
change the file name of the output file. This dialog will remember its settings once you’ve changed them.

These two tools can be used to change data not accessible in MedLook, alter table file properties, create custom reports, and they can be used to verify that your database is working.

**VFP Commands**

This command allows technical support to directly enter Visual FoxPro specific commands. This should be used only under technical supervision.

![VFP Commands screenshot](image)

**Other Possible Ways To Fix Problems**

That’s it for the diagnostic tools we provide with MedLook. Keep in mind that other software on your system can be causing havoc with MedLook. Anti-virus software is notorious for this sort of thing, to say nothing of viruses themselves. Also, gaming software can consume your system resources and lock your hardware causing all sorts of unexpected problems. Music players are also guilty of causing problems with other Windows applications. It is often helpful to just reboot your system and try again before doing much else.

One other thing that seems to be a guilty party in software malfunction is networking problems. Be sure your network is functioning properly. You may have to reset your network or even have all users on the network reboot to clear things up. Try using *net view* at the DOS command prompt to list out the machines connected to your network. You can get to DOS using Start->Run and type *cmd* (on Windows 98 use *command*
instead of cmd). Also, make sure all MedLook users have read and write privileges on the computer the database is stored. Without this they won’t be able to save any changes they make.

Appendix

Registration

Registration will “unlock” MedLook and allow you to use the program beyond the evaluation version’s capabilities. To register once you’ve purchased MedLook, run the program and click Help->Registration on the main dialog to open the following form.

Select the Product ID from the drop down list, enter all of the demographic information, select the Purchase Option for your situation, and we will provide you with a number that will be unique for each of your computers. Enter that number in the Serial Number field.
If you are registering more than one option, such as a MedLook Viewer, and a MedLook Appointment Manager, click on the *Apply* button after each. Click on *OK* after the final entry. You are now ready to use MedLook’s full features for the options you’ve purchased.

**Custom Dictionary**

The following series of illustrations show the complete dictionary available in MedLook for custom reports and custom labels. The first table discusses some basic syntax and is valid for all tables. To gain a better understanding how this all works refer to the *Custom Reports* section found earlier in this document.

<table>
<thead>
<tr>
<th><strong>Key Word</strong></th>
<th><strong>Meaning or Purpose</strong></th>
<th><strong>Valid Table</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Case sensitivity</td>
<td>All keywords are case sensitive</td>
<td></td>
</tr>
<tr>
<td>[]</td>
<td>Brackets are used to enclose all keywords</td>
<td></td>
</tr>
<tr>
<td>[Key]</td>
<td>Replaces [Key] with appropriate field data</td>
<td></td>
</tr>
<tr>
<td>[Key ]</td>
<td>Includes replacement with space; if no data is present space is removed</td>
<td></td>
</tr>
<tr>
<td>[Key, ]</td>
<td>Includes replacement with period and space; if no data is present period and space are removed</td>
<td></td>
</tr>
<tr>
<td>[Key, ,]</td>
<td>Includes replacement with comma and space; if no data is present command and space are removed</td>
<td></td>
</tr>
<tr>
<td>[Key\n]</td>
<td>Replaces Key with data field and carriage return; if no data present the carriage return is removed</td>
<td></td>
</tr>
<tr>
<td>[KeyL#]</td>
<td>Replaces Key with the left-most # of characters from the key. E.g. [LastNameL5] prints Fager for Fagerman.</td>
<td></td>
</tr>
<tr>
<td>[KeyR#]</td>
<td>Replaces Key with the right-most # of characters from the key. E.g [HomePhoneR8] prints 548-6148 for the REM sales line of (800)548-6148</td>
<td></td>
</tr>
<tr>
<td><strong>General Fields</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Today</td>
<td>Prints today’s data</td>
<td>FIRA</td>
</tr>
<tr>
<td>Time</td>
<td>Prints the current time</td>
<td>FIRA</td>
</tr>
</tbody>
</table>
This table defines the dictionary available to all patient information and can be used for patient and appointment reports, as well as patient, birthday, and recall labels.

<table>
<thead>
<tr>
<th><strong>Patient Fields</strong></th>
<th>Description</th>
<th>P</th>
</tr>
</thead>
<tbody>
<tr>
<td>Account</td>
<td>Account number</td>
<td>P</td>
</tr>
<tr>
<td>Title</td>
<td>Title</td>
<td>P</td>
</tr>
<tr>
<td>FirstName</td>
<td>First name</td>
<td>P</td>
</tr>
<tr>
<td>MI</td>
<td>Middle Initial</td>
<td>P</td>
</tr>
<tr>
<td>LastName</td>
<td>Last name</td>
<td>P</td>
</tr>
<tr>
<td>Address</td>
<td>Street address</td>
<td>P</td>
</tr>
<tr>
<td>City</td>
<td>City</td>
<td>P</td>
</tr>
<tr>
<td>State</td>
<td>State</td>
<td>P</td>
</tr>
<tr>
<td>Zip</td>
<td>Zip code</td>
<td>P</td>
</tr>
<tr>
<td>HomePhone</td>
<td>Home phone number</td>
<td>P</td>
</tr>
<tr>
<td>WorkPhone</td>
<td>Work phone number</td>
<td>P</td>
</tr>
<tr>
<td>WorkExt</td>
<td>Work phone extension</td>
<td>P</td>
</tr>
<tr>
<td>AutoBill</td>
<td>AutoBilling is Off or On</td>
<td>P</td>
</tr>
<tr>
<td>Birthday</td>
<td>Birthday</td>
<td>P</td>
</tr>
<tr>
<td>Age</td>
<td>Age in years</td>
<td>P</td>
</tr>
<tr>
<td>SSN</td>
<td>Social Security Number</td>
<td>P</td>
</tr>
<tr>
<td>Sex</td>
<td>Sex shown as Male or Female</td>
<td>P</td>
</tr>
<tr>
<td>LastPayDate</td>
<td>Last payment date</td>
<td>P</td>
</tr>
<tr>
<td>LastChargeDate</td>
<td>Last charge date</td>
<td>P</td>
</tr>
<tr>
<td>LastBillDate</td>
<td>Last bill date</td>
<td>P</td>
</tr>
<tr>
<td>Note</td>
<td>Note</td>
<td>P</td>
</tr>
<tr>
<td>Age30</td>
<td>30 day balance</td>
<td>P</td>
</tr>
<tr>
<td>Age60</td>
<td>60 day balance</td>
<td>P</td>
</tr>
<tr>
<td>Age90</td>
<td>90 day balance</td>
<td>P</td>
</tr>
<tr>
<td>Age120</td>
<td>120 day balance</td>
<td>P</td>
</tr>
<tr>
<td>Age120p</td>
<td>Over 120 day balance</td>
<td>P</td>
</tr>
</tbody>
</table>
This is the continuation of the patient dictionary.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>UnassignedPmts</td>
<td>Unassigned payments</td>
<td>P</td>
</tr>
<tr>
<td>TotalAging</td>
<td>Aging balances total</td>
<td>P</td>
</tr>
<tr>
<td>Ins1Due</td>
<td>Amount due from primary insurance</td>
<td>P</td>
</tr>
<tr>
<td>Ins2Due</td>
<td>Amount due from secondary insurance</td>
<td>P</td>
</tr>
<tr>
<td>PatientDue</td>
<td>Amount due from patient</td>
<td>P</td>
</tr>
<tr>
<td>OtherDue</td>
<td>Amount due from other</td>
<td>P</td>
</tr>
<tr>
<td>TotalCharges</td>
<td>Total charges</td>
<td>P</td>
</tr>
<tr>
<td>TotalPayments</td>
<td>Total payments</td>
<td>P</td>
</tr>
<tr>
<td>ApptStart1</td>
<td>Appointment 1 start time</td>
<td>P</td>
</tr>
<tr>
<td>ApptStart2</td>
<td>Appointment 2 start time</td>
<td>P</td>
</tr>
<tr>
<td>ApptStart3</td>
<td>Appointment 3 start time</td>
<td>P</td>
</tr>
<tr>
<td>ApptStart4</td>
<td>Appointment 4 start time</td>
<td>P</td>
</tr>
<tr>
<td>Ins1Copay</td>
<td>Primary insurance copay amount</td>
<td>P</td>
</tr>
<tr>
<td>Ins1Percent</td>
<td>Primary insurance copay percent</td>
<td>P</td>
</tr>
<tr>
<td>Ins1Deductible</td>
<td>Primary insurance deductible</td>
<td>P</td>
</tr>
<tr>
<td>Ins2Copay</td>
<td>Secondary insurance copay amount</td>
<td>P</td>
</tr>
<tr>
<td>Ins2Percent</td>
<td>Secondary insurance copay percent</td>
<td>P</td>
</tr>
<tr>
<td>Ins2Deductible</td>
<td>Secondary insurance deductible</td>
<td>P</td>
</tr>
<tr>
<td>PtIns1Id</td>
<td>Patient primary insurance ID</td>
<td>P</td>
</tr>
<tr>
<td>PtIns2Id</td>
<td>Patient secondary insurance ID</td>
<td>P</td>
</tr>
<tr>
<td>Marital</td>
<td>Marital Status</td>
<td>P</td>
</tr>
<tr>
<td>Student</td>
<td>Student Status</td>
<td>P</td>
</tr>
<tr>
<td>LastPaySource</td>
<td>Source of last payment</td>
<td>P</td>
</tr>
<tr>
<td>LastPayAmount</td>
<td>Amount of last payment</td>
<td>P</td>
</tr>
<tr>
<td>ICD91</td>
<td>First ICD9 code</td>
<td>P</td>
</tr>
<tr>
<td>ICD92</td>
<td>Second ICD9 code</td>
<td>P</td>
</tr>
<tr>
<td>ICD93</td>
<td>Third ICD9 code</td>
<td>P</td>
</tr>
<tr>
<td>ICD94</td>
<td>Fourth ICD9 code</td>
<td>P</td>
</tr>
<tr>
<td>Ins1Grp</td>
<td>Primary insurance group number</td>
<td>P</td>
</tr>
<tr>
<td>Ins1Eff</td>
<td>Primary insurance effective date</td>
<td>P</td>
</tr>
<tr>
<td>Ins1Trm</td>
<td>Primary insurance termination date</td>
<td>P</td>
</tr>
<tr>
<td>Ins2Grp</td>
<td>Secondary insurance group number</td>
<td>P</td>
</tr>
<tr>
<td>Ins2Eff</td>
<td>Secondary insurance effective date</td>
<td>P</td>
</tr>
<tr>
<td>Ins2Trm</td>
<td>Secondary insurance termination date</td>
<td>P</td>
</tr>
<tr>
<td>ApptStatus1…4</td>
<td>Appt status (1…4 being the next 4 appts)</td>
<td>P</td>
</tr>
<tr>
<td>ApptProc1…4</td>
<td>Appt Procedure/Reason</td>
<td>P</td>
</tr>
<tr>
<td>ApptDesc1…4</td>
<td>Appt Description (free text)</td>
<td>P</td>
</tr>
<tr>
<td>ApptStartB1…4</td>
<td>Prior 4 appointments. (Start time)</td>
<td>P</td>
</tr>
<tr>
<td>ApptStatusB1…4</td>
<td>Prior 4 appointments. (Status)</td>
<td>P</td>
</tr>
<tr>
<td>ApptProcB1…4</td>
<td>Prior 4 appointments. (Procedure/Reason)</td>
<td>P</td>
</tr>
<tr>
<td>ApptDescB1…4</td>
<td>Prior 4 appointments. (Description)</td>
<td>P</td>
</tr>
</tbody>
</table>
This table contains the dictionary for “Bill Other” or responsible party fields. This again is all available to the patient report.

<table>
<thead>
<tr>
<th><strong>Bill Other Fields</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>BOFirstName</td>
<td>Bill other first name</td>
</tr>
<tr>
<td>BOMI</td>
<td>Bill other middle initial</td>
</tr>
<tr>
<td>BOTitle</td>
<td>Bill other title</td>
</tr>
<tr>
<td>BOLastName</td>
<td>Bill other last name</td>
</tr>
<tr>
<td>BOAddress</td>
<td>Bill other address</td>
</tr>
<tr>
<td>BOCity</td>
<td>Bill other city</td>
</tr>
<tr>
<td>BOSTate</td>
<td>Bill other state</td>
</tr>
<tr>
<td>BOZip</td>
<td>Bill other zip code</td>
</tr>
<tr>
<td>BOPatientName</td>
<td>Bill other patient name</td>
</tr>
</tbody>
</table>

This table contains the dictionary for the primary insurance carrier and is available for the patient and insurance report.

<table>
<thead>
<tr>
<th><strong>Primary Insurance Fields</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Ins1Num</td>
<td>Primary insurance carrier serial number</td>
</tr>
<tr>
<td>Ins1Mnmem</td>
<td>Mnemonic, nickname, or abbreviation</td>
</tr>
<tr>
<td>Ins1Name</td>
<td>Full name of carrier</td>
</tr>
<tr>
<td>Ins1Assign</td>
<td>Accept Assignment (No Assign or Assign)</td>
</tr>
<tr>
<td>Ins1Phone</td>
<td>10 digit phone number</td>
</tr>
<tr>
<td>Ins1Address1</td>
<td>Street address, line one</td>
</tr>
<tr>
<td>Ins1Address2</td>
<td>Street address, line two</td>
</tr>
<tr>
<td>Ins1City</td>
<td>City</td>
</tr>
<tr>
<td>Ins1State</td>
<td>State</td>
</tr>
<tr>
<td>Ins1Zip</td>
<td>Zip code</td>
</tr>
<tr>
<td>Ins1Contact</td>
<td>Primary insurance carrier contact</td>
</tr>
<tr>
<td>Ins1Type</td>
<td>Primary insurance carrier type (Medicare, Medicaid, etc.)</td>
</tr>
<tr>
<td>Ins1PayorId</td>
<td>Primary Insurance payor id</td>
</tr>
<tr>
<td>Ins1Birthday</td>
<td>Primary Insured’s Birthday (DOB)</td>
</tr>
<tr>
<td>Ins1FirstName</td>
<td>Primary Insured’s First Name</td>
</tr>
<tr>
<td>Ins1LastName</td>
<td>Primary Insured’s Last Name</td>
</tr>
<tr>
<td>Ins1Sex</td>
<td>Primary Insured’s Sex</td>
</tr>
<tr>
<td>Ins1SSSN</td>
<td>Primary Insured’s SSN</td>
</tr>
<tr>
<td>Ins1Rel</td>
<td>Primary Insured’s Relationship (1-self, 2-spouse, 3-child, 4-other)</td>
</tr>
<tr>
<td><strong>Ins1RelT</strong></td>
<td>Primary Insured’s Relationship (self, spouse, child, other)</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Ins1ProvId</strong></td>
<td>Primary Insured’s Provider Id</td>
</tr>
</tbody>
</table>

The secondary insurance is nearly identical to the primary table as seen here.

<table>
<thead>
<tr>
<th><strong>Secondary Insurance Fields</strong></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Ins2Num</strong></td>
<td>Secondary insurance carrier serial number</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2Mnem</strong></td>
<td>Mnemonic, nickname, or abbreviation</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2Name</strong></td>
<td>Full name of carrier</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2Assign</strong></td>
<td>Accept Assignment (No Assign or Assign)</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2Phone</strong></td>
<td>10 digit phone number</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2Address1</strong></td>
<td>Street address, line one</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2Address2</strong></td>
<td>Street address, line two</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2City</strong></td>
<td>City</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2State</strong></td>
<td>State</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2Zip</strong></td>
<td>Zip code</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2Contact</strong></td>
<td>Secondary insurance carrier contact</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2Type</strong></td>
<td>Secondary insurance carrier type (Medicare, Medicaid, etc.)</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2PayorId</strong></td>
<td>Secondary Insurance payor id</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2Birthday</strong></td>
<td>Secondary Insured’s Birthday (DOB)</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2FirstName</strong></td>
<td>Secondary Insured’s First Name</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2LastName</strong></td>
<td>Secondary Insured’s Last Name</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2Sex</strong></td>
<td>Secondary Insured’s Sex</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2SSN</strong></td>
<td>Secondary Insured’s SSN</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2Rel</strong></td>
<td>Secondary Insured’s Relationship (1-self, 2-spouse, 3-child, 4-other)</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2RelT</strong></td>
<td>Secondary Insured’s Relationship (self, spouse, child, other)</td>
<td>P</td>
</tr>
<tr>
<td><strong>Ins2ProvId</strong></td>
<td>Secondary Insured’s Provider Id</td>
<td>P</td>
</tr>
</tbody>
</table>
This table contains the dictionary for the doctor and is available for the patient report.

<table>
<thead>
<tr>
<th>Doctor Fields</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>DocCode</td>
<td>Doctor code</td>
</tr>
<tr>
<td>DocFirstName</td>
<td>Doctor first name</td>
</tr>
<tr>
<td>DocMI</td>
<td>Doctor middle initial</td>
</tr>
<tr>
<td>DocTitle</td>
<td>Doctor title</td>
</tr>
<tr>
<td>DocLastName</td>
<td>Doctor last name</td>
</tr>
<tr>
<td>DocCredentials</td>
<td>Doctor credentials (M. D., D. O., etc.)</td>
</tr>
<tr>
<td>DocAddress1</td>
<td>Doctor address 1</td>
</tr>
<tr>
<td>DocAddress2</td>
<td>Doctor address 2</td>
</tr>
<tr>
<td>DocCity</td>
<td>Doctor city</td>
</tr>
<tr>
<td>DocState</td>
<td>Doctor state</td>
</tr>
<tr>
<td>DocZip</td>
<td>Doctor zip code</td>
</tr>
<tr>
<td>DocPhone</td>
<td>Doctor phone number</td>
</tr>
<tr>
<td>DocTaxId</td>
<td>Doctor tax ID</td>
</tr>
<tr>
<td>DocLicense</td>
<td>Doctor license</td>
</tr>
<tr>
<td>DocUPIN</td>
<td>Doctor UPIN</td>
</tr>
<tr>
<td>DocGroup</td>
<td>Doctor group name</td>
</tr>
</tbody>
</table>

This table contains the dictionary for the referral sources and is available for the patient and referral source report.

<table>
<thead>
<tr>
<th>Referral Source Fields</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>RefFirstName</td>
<td>Referral First name</td>
</tr>
<tr>
<td>RefMI</td>
<td>Referral middle initial</td>
</tr>
<tr>
<td>RefLastName</td>
<td>Referral last name</td>
</tr>
<tr>
<td>RefAddress</td>
<td>Referral street address</td>
</tr>
<tr>
<td>RefCity</td>
<td>Referral city</td>
</tr>
<tr>
<td>RefState</td>
<td>Referral state</td>
</tr>
<tr>
<td>RefZip</td>
<td>Referral zip code</td>
</tr>
</tbody>
</table>

This table contains the dictionary for managed care and is available for the patient and appointment reports.

<table>
<thead>
<tr>
<th>Managed Care Fields</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>McVisitsLeft</td>
<td>Number of visits remaining</td>
</tr>
<tr>
<td>McVisitsAuth</td>
<td>Number of visits authorized</td>
</tr>
<tr>
<td>McStartDate</td>
<td>Start date of managed care</td>
</tr>
<tr>
<td>McEndDate</td>
<td>End date of managed care</td>
</tr>
<tr>
<td>McCode</td>
<td>Managed care authorization code</td>
</tr>
</tbody>
</table>

This table contains the dictionary for the referral sources and is available for the appointment report.
This table contains the dictionary for the *Calendar* in the *Appointment Manager*. These fields can be used in the *Options::Text Template*.

<table>
<thead>
<tr>
<th>Appointment Fields</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>ApptStart</td>
<td>A</td>
</tr>
<tr>
<td>ApptEnd</td>
<td>A</td>
</tr>
<tr>
<td>ApptStartTime</td>
<td>Appointment start time</td>
</tr>
<tr>
<td>ApptEndTime</td>
<td>Appointment end time</td>
</tr>
<tr>
<td>ApptStartDate</td>
<td>Appointment start date</td>
</tr>
<tr>
<td>ApptEndDate</td>
<td>Appointment end date</td>
</tr>
<tr>
<td>ApptStartDateTimeLong</td>
<td>Appointment long start date</td>
</tr>
<tr>
<td>ApptEndDateTimeLong</td>
<td>Appointment long end date</td>
</tr>
<tr>
<td>ApptStatus</td>
<td>Appointment status</td>
</tr>
<tr>
<td>ApptProcedure</td>
<td>Appointment procedure</td>
</tr>
<tr>
<td>ApptDescription</td>
<td>Appointment description</td>
</tr>
<tr>
<td>ApptProvider</td>
<td>Appointment provider</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Calendar Display Fields</th>
<th>These fields are valid only for the Calendar Options dialog to control what items are displayed in the calendar.</th>
</tr>
</thead>
<tbody>
<tr>
<td>FirstName</td>
<td>First name</td>
</tr>
<tr>
<td>LastName</td>
<td>Last name</td>
</tr>
<tr>
<td>HomePhone</td>
<td>Home phone number</td>
</tr>
<tr>
<td>WorkPhone</td>
<td>Work phone number</td>
</tr>
<tr>
<td>Description</td>
<td>Description</td>
</tr>
<tr>
<td>Procedure</td>
<td>Procedure</td>
</tr>
<tr>
<td>Account</td>
<td>Account number</td>
</tr>
</tbody>
</table>

Note: All fields that are valid for the patient are also valid for the appointments.

P – Patient fields
A – Appointment fields
R – Referral fields
I – Insurance fields
The MedLook System Menu

MedLook can be started from the Start or System menu. Below is the menu that is displayed when using Start->(All) Programs->MedLook:

Moving your mouse cursor over Diagnostics will open a sub-menu. We’ll cover that one later. For now, let’s take a look at the items on the MedLook System Menu.

Database Pack

Select this option to clean up and index your database. If you have more than one database, this will pack the current one. You should make sure MedLook is not running on any computers before selecting this option. Try to perform this function at least once every two weeks.

MedLook

The MedLook option will run MedLook just like the shortcut icon on your Desktop.

Tip: If you ever lose your Desktop shortcut icon, you can replace it with a copy of this MedLook shortcut icon.

MedLook Help

This will open the MedLook Help System just like clicking on the Help menu when MedLook is running.

MedLook Readme

This will open a text file in Notepad that contains information about installing and running MedLook. We recommend that you at least glance through this file.
Remove Fagerman Technologies, Inc. MedLook 3.0

Selecting this option will uninstall MedLook. The uninstall process will remove the program, but not your databases. The uninstall can also be completed by going to Control Panel, Add/Remove Programs and selecting MedLook from the list of programs.

www.remsys.com

This is a link to our web site. Clicking it should open our web site in your default web browser.

MedLook Backup

The MedLook Backup option will perform an automatic backup of your current database.

MedLook Options

This gives you access to the Options dialog as if you were running MedLook and clicked on the Tools->Options menu.

MedLook Restore

The MedLook Restore option will give you the option to restore your backups to the current database directory. Once you click MedLook Restore you will see the following dialog. If you are sure you want to restore, click the Yes button. Note: Restoring from a backup will overwrite all current data. Anything entered after the backup you are restoring will be lost.

```
Database Restore

Restore will overwrite current data! Are you sure?

Yes  No
```

HIPAA Direct Setup

This option is used after installing the SolAce software from Ivertex and before actually running SolAce. This command modifies some of the SolAce parameter files specifically to work with MedLook. It also modifies the current database to work with SolAce. If you have more than one database, this command should be run once for each of them after making them active in MedLook. No users should be connected to the database during this brief command.
Now, let’s go back to the **Diagnostics** menu. Selecting the **Diagnostics** menu gives the following sub-menu:

<p>| | | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Database Analyzer</td>
<td>![Icon]</td>
<td>Kill MedLook</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Kill Named Program</td>
<td>![Icon]</td>
<td>MedLook with Debug Logging</td>
</tr>
<tr>
<td>![Icon]</td>
<td>MedLook with Debug Messages</td>
<td>![Icon]</td>
<td>View Log File</td>
</tr>
</tbody>
</table>

Other than the **View Log File** you should check with a Fagerman Technologies, Inc support representative before running the options on the **Diagnostics** menu.

**Database Analyzer**

This option will check your database and make sure it is the correct version.

**Kill MedLook/Named Program**

This option is equivalent to using Task Manager to kill MedLook or any other program. It is put here simply for convenience to some users.

**MedLook with Debug Logging.**

The **Debug Logging** option will create a detailed log file that you can email to technical support. You can view the log file with the **View Log File** option.

**MedLook with Debug Messages**

Use this option only after checking with technical support. It will cause message boxes to pop up at certain places when you run MedLook.

**View Log File**

This allows you to view the log file created above.
**Keyboard Navigation**

Following is a detailed description from one of MedLook's Weekly Tips of how to use keyboard shortcuts. The weekly tip archive may be viewed at the following address:

http://www.remsys.com/tipofweekarch.shtml

To start the program use the Windows key (holding it for a second to activate it) or Ctrl-Esc. Navigate just as you would with the mouse through the Programs menu (using the arrow keys) to MedLook. Press Enter to initiate the program.

In all cases mentioned below, you can use the Tab key to change the focus to the next field at almost any time. Also, if a grid has the focus, the Esc key will NOT exit this dialog. You must first tab off the grid and then press Esc to dismiss the dialog. Whenever a Windows interface has a menu or command button with an Underline, that means to select that option you use the Alt key and the key letter underlined.

To navigate the folders (patients, insurance, codes, etc.) use Ctrl-T to select the folders. Use the up/down arrows to select the folder you want. Let's work in Patients since that's the most complicated folder.

Of course, to create a new patient you only have press Ctrl-N. This will bring up the new patient dialog which we will discuss in more detail shortly.

Enable the "Look For" fields using Ctrl-F if they're not already shown. To search for a particular patient we can tab to the "Look For" field or use Ctrl-L. Enter the person you wish to search for, e.g. Jones. Press Enter until you find the Jones you want or press Ctrl-G to change the focus to the grid (or you can tab four times to get there too). Once the grid has focus you can use the Enter key to move down or the up/down arrows to move accordingly.

There are several ways to select the patient at this point: Ctrl-O, Ctrl-Enter, or using the Windows Context key (usually to the right of the space bar and right Windows key and just left of the control key) and selecting Edit from the right click menu.

The dialog starts on the Account Summary screen with the grid having the focus (this will be changing soon). Each tab in the patient's account has an F# key assigned to it. F6 selects the Patient Charge. The "Look For" option of the CPT codes by default has the focus. Again, Ctrl-G sets the focus to the grid (or tab a couple of times). Once on the grid just navigate as already defined (up/down arrows). When you have the proper code Ctrl-Enter will select that code and set the focus to the next field.

To select anything from a drop down list just use F4. If the drop down list brings up a dialog with "Look For" then the "Look For" field will immediately have the focus. After you have found the item you require, use Ctrl-Enter to make the selection, or Esc to abort. When you are ready to Apply the charge, press Alt-A. (Sometimes you have to use Shift-F4 or even Ctrl-F4 depending upon what you did last.)
To enter a payment, press F7. The Amount field will immediately have the focus. Enter the payment amount, and use the left/right arrows to move within the grid. If the grid item is a drop-down, you can use either F4 or Ctrl-F4 to activate the drop down for selection. If you know the first letter of the item you want in the grid you can type that. If there are multiple matches keep typing the same letter and the selection will continue to advance. Press Enter when the payment is complete and apply if you wish. If you want to apply the payment to a charge other than the one displayed, Esc to cancel the dialog. Ctrl-G or tab to the lower (charge) grid. Select the charge and press Ctrl-Enter. If no payment is select use Ctrl-G or tab to get the focus on the top grid, make your selection and use Ctrl-Enter to assign the payment.

To print an individual bill, press F8. Tab to each field and your selections, and then press Alt-D to display the bill or Alt-P (or Ctrl-P) to print the bill.

To edit patient notes, press F9. Editing can be performed with the editor of your choice or MedLook. At this point, not all of the options available within the MedLook Notes Editor can be selected without the mouse. This will change over time.

That's about all there is to data entry without a mouse. Once you master the few key sequences it becomes very efficient to navigate and enter data strictly from the keyboard. Whether you prefer to use the mouse versus the keyboard is all a matter of personal preference.

**Keyboard Shortcuts**

Most screens and dialogs in MedLook can be navigated using only the keyboard. This is particularly useful when entering patient data, charges and payments, etc. and the user wants to avoid having to switch from keyboard to mouse to navigate.

*General MedLook Keyboard Shortcuts:*

- **Ctrl-Return/Enter** - selects from the grid.
- **Ctrl-G** - sets focus to the grid displayed or toggles between the grids displayed.
- **Ctrl-L** - always sets focus to the Key-in Look For field.
- **Up/Down arrows** and **Tab/Shift-tab** are used for navigation.
- **Up/Down arrows** move into Check box fields and **Tabs** will skip them in columnar display.
- **Grey shaded topic headings** can be entered by the arrow keys and expanded/collapsed using the **space bar**.
Ctrl-T - Toggles to the Tree view for folder navigation.

Ctrl-B - Toggles to the MedLook Bar for folder navigation.

Ctrl-Shift-T - toggles the display of the tree view.

Ctrl-Shift-B - toggles the display of the MedLook Bar.

F4 - displays the selection grid/combo for any pull-down list.

Esc - dismisses the dialog UNLESS a grid has the focus (then tab off the grid).

The Windows Context key near the right Ctrl key is the same as a right click.

The F3-F10 keys change tabs on the patient account.

To change folders using only the keyboard:

<table>
<thead>
<tr>
<th>Key Sequence</th>
<th>Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alt-Shift-B</td>
<td>Billing</td>
</tr>
<tr>
<td>Alt-Shift-P</td>
<td>Patient</td>
</tr>
<tr>
<td>Alt-Shift-R</td>
<td>Referral Source</td>
</tr>
<tr>
<td>Alt-Shift-D</td>
<td>Doctor</td>
</tr>
<tr>
<td>Alt-Shift-H</td>
<td>Hospital</td>
</tr>
<tr>
<td>Alt-Shift-F</td>
<td>Fee Schedule</td>
</tr>
<tr>
<td>Alt-Shift-C</td>
<td>Procedure Codes</td>
</tr>
<tr>
<td>Alt-Shift-S</td>
<td>Place of Service</td>
</tr>
<tr>
<td>Alt-Shift-I</td>
<td>Insurance Carriers</td>
</tr>
<tr>
<td>Alt-Shift-G</td>
<td>Diagnosis Codes</td>
</tr>
</tbody>
</table>

To create a new record:

<table>
<thead>
<tr>
<th>Key Sequence</th>
<th>Folder</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ctrl-Shift-P</td>
<td>New Patient</td>
</tr>
<tr>
<td>Ctrl-Shift-R</td>
<td>New Referral Source</td>
</tr>
<tr>
<td>Ctrl-Shift-D</td>
<td>New Doctor</td>
</tr>
<tr>
<td>Ctrl-Shift-H</td>
<td>New Hospital</td>
</tr>
<tr>
<td>Ctrl-Shift-F</td>
<td>New Fee Schedule</td>
</tr>
<tr>
<td>Ctrl-Shift-C</td>
<td>New Procedure Code</td>
</tr>
<tr>
<td>Ctrl-Shift-S</td>
<td>New Place of Service</td>
</tr>
<tr>
<td>Ctrl-Shift-I</td>
<td>New Insurance Carrier</td>
</tr>
<tr>
<td>Ctrl-Shift-9</td>
<td>New Diagnosis (ICD9) Code</td>
</tr>
</tbody>
</table>
General Windows Shortcuts:

**Ctrl-A** - Select all items.

**Ctrl-C** - Copy to clipboard.

**Ctrl-X** - Cut to clipboard.

**Ctrl-V** - Paste from clipboard.

**Alt-Spacebar** - Displays a program's or window's system menu.

**Alt-Tab** - Switch between open items.

**Alt-F4** - Close the active item or program.

**Alt-Enter** - View properties for the selected item.

**Windows Key or Ctrl-Esc** - Opens and closes the Start Menu.

**Windows Key-Break** - Displays system properties.

**Windows Key-M** - Minimize or Restore all open windows and programs.

**Windows Key-E** - Opens My Computer (Explore).

**Windows Key-F** - Search for file or folder (directory).

**Windows Key-F1** - Displays Windows Help.

The *Windows* key is outside the *Alt* key on either side of the keyboard.